# Table of contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td>5</td>
</tr>
<tr>
<td>- About this guide</td>
<td>5</td>
</tr>
<tr>
<td>- Find product documentation</td>
<td>6</td>
</tr>
<tr>
<td>Introduction to Stonesoft Next Generation Firewall (Stonesoft NGFW)</td>
<td>7</td>
</tr>
<tr>
<td>1 Introduction to Stonesoft NGFW</td>
<td>8</td>
</tr>
<tr>
<td>- Stonesoft NGFW system components</td>
<td>8</td>
</tr>
<tr>
<td>- Stonesoft Management Center (SMC)</td>
<td>9</td>
</tr>
<tr>
<td>- Stonesoft NGFW engines</td>
<td>9</td>
</tr>
<tr>
<td>2 Preparing for installation</td>
<td>12</td>
</tr>
<tr>
<td>- Supported platforms</td>
<td>12</td>
</tr>
<tr>
<td>- Clustering</td>
<td>14</td>
</tr>
<tr>
<td>- Deployment options for Stonesoft NGFW in the IPS and Layer 2 Firewall roles</td>
<td>15</td>
</tr>
<tr>
<td>- Cable connection guidelines</td>
<td>16</td>
</tr>
<tr>
<td>- Speed and duplex settings for Stonesoft NGFW engines</td>
<td>19</td>
</tr>
<tr>
<td>- Obtain installation files</td>
<td>20</td>
</tr>
<tr>
<td>- Licensing Stonesoft NGFW system components</td>
<td>21</td>
</tr>
<tr>
<td>- Installation overview</td>
<td>22</td>
</tr>
<tr>
<td>Stonesoft Management Center (SMC) deployment</td>
<td>24</td>
</tr>
<tr>
<td>3 Installing the SMC</td>
<td>25</td>
</tr>
<tr>
<td>- SMC installation options</td>
<td>25</td>
</tr>
<tr>
<td>- Install SMC components</td>
<td>28</td>
</tr>
<tr>
<td>- Install the SMC in Demo Mode</td>
<td>32</td>
</tr>
<tr>
<td>- Install the SMC from the command line</td>
<td>33</td>
</tr>
<tr>
<td>- Install the SMC Appliance</td>
<td>36</td>
</tr>
<tr>
<td>- Start the SMC after installation</td>
<td>37</td>
</tr>
<tr>
<td>- Post-installation SMC configurations</td>
<td>41</td>
</tr>
<tr>
<td>4 Configuring the SMC</td>
<td>42</td>
</tr>
<tr>
<td>- Configuring NAT addresses for SMC components</td>
<td>42</td>
</tr>
<tr>
<td>- Add Management Servers for high availability</td>
<td>44</td>
</tr>
<tr>
<td>- Distribute Management Clients through Web Start</td>
<td>46</td>
</tr>
<tr>
<td>Stonesoft NGFW engine deployment</td>
<td>48</td>
</tr>
<tr>
<td>5 Configuring Stonesoft NGFW for the Firewall/VPN role</td>
<td>49</td>
</tr>
<tr>
<td>- Install licenses for Stonesoft NGFW engines</td>
<td>49</td>
</tr>
<tr>
<td>- Configuring Single Firewalls</td>
<td>49</td>
</tr>
<tr>
<td>- Configuring Firewall Clusters</td>
<td>61</td>
</tr>
<tr>
<td>6 Configuring Stonesoft NGFW for the IPS role</td>
<td>70</td>
</tr>
<tr>
<td>- Install licenses for Stonesoft NGFW engines</td>
<td>70</td>
</tr>
<tr>
<td>- Configuring IPS engines</td>
<td>70</td>
</tr>
<tr>
<td>- Bind engine licenses to IPS elements</td>
<td>79</td>
</tr>
<tr>
<td>7 Configuring Stonesoft NGFW for the Layer 2 Firewall role</td>
<td>81</td>
</tr>
<tr>
<td>- Install licenses for Stonesoft NGFW engines</td>
<td>81</td>
</tr>
<tr>
<td>- Configuring Layer 2 Firewalls</td>
<td>81</td>
</tr>
<tr>
<td>- Bind engine licenses to Layer 2 Firewall elements</td>
<td>90</td>
</tr>
</tbody>
</table>
8 Configuring Stonesoft NGFW engines as Master Engines and Virtual Security Engines ................................. 91
   Master Engine and Virtual Security Engine configuration overview .............................................................. 91
   Install licenses for Stonesoft NGFW engines .................................................................................................. 91
   Add Master Engine elements .......................................................................................................................... 92
   Add Virtual Firewall elements ....................................................................................................................... 97
   Add Virtual IPS elements .................................................................................................................................. 100
   Add Virtual Layer 2 Firewall elements ........................................................................................................... 101

9 Configuring Stonesoft NGFW engine software ................................................................................................ 104
   Options for initial configuration ......................................................................................................................... 104
   Using plug-and-play configuration .................................................................................................................... 105
   Using automatic configuration .......................................................................................................................... 107
   Configure Stonesoft NGFW engine software with the NGFW Configuration Wizard ........................................ 108

10 Stonesoft NGFW engine post-installation tasks ............................................................................................. 114
   Configuring routing and basic policies .............................................................................................................. 114
   Monitor and command Stonesoft NGFW engines ............................................................................................ 121

Maintenance .............................................................................................................................................................. 122

11 Maintaining the SMC ........................................................................................................................................ 123
   Upgrading the SMC .......................................................................................................................................... 123
   Uninstall the SMC ........................................................................................................................................... 126

12 Upgrading Stonesoft NGFW engines .................................................................................................................. 128
   How engine upgrades work ............................................................................................................................... 128
   Obtain Stonesoft NGFW engine upgrade files .................................................................................................. 129
   Upgrading or generating licenses for Stonesoft NGFW engines ..................................................................... 130
   Upgrade engines remotely .................................................................................................................................. 132
   Upgrade engines locally .................................................................................................................................... 133

Appendix A: Default communication ports ........................................................................................................... 135
   Security Management Center ports .................................................................................................................... 135
   Stonesoft NGFW engine ports ............................................................................................................................. 138

Appendix B: Command line tools .......................................................................................................................... 143
   Stonesoft Management Center commands .......................................................................................................... 143
   Stonesoft NGFW engine commands .................................................................................................................... 157
   Server Pool Monitoring Agent commands .......................................................................................................... 166

Appendix C: Installing Stonesoft NGFW engines on a virtualization platform .................................................... 168
   Hardware requirements for installing Stonesoft NGFW engines on a virtualization platform ......................... 168
   Install Stonesoft NGFW engine using an .iso file ............................................................................................... 169
   Install Stonesoft NGFW engine using a VMDK image ...................................................................................... 169

Appendix D: Installing Stonesoft NGFW engines on third-party hardware ........................................................ 170
   Hardware requirements for installing Stonesoft NGFW engines on third-party hardware .............................. 170
   Start the Stonesoft NGFW engine installation on third-party hardware ........................................................... 175
   Install Stonesoft NGFW in expert mode ............................................................................................................ 176

Appendix E: Example network (Firewall/VPN) ....................................................................................................... 178
   Example Firewall Cluster ................................................................................................................................... 178
   Example Single Firewall .................................................................................................................................... 180
   Example headquarters management network .................................................................................................. 180

Appendix F: Example network (IPS) ........................................................................................................................ 182
   Example network overview (IPS) ....................................................................................................................... 182
Preface

This guide provides the information you need to work with your Forcepoint product.

About this guide

This information describes the guide's target audience, the typographical conventions and icons used in this guide, and how the guide is organized.

Audience

Forcepoint documentation is carefully researched and written for the target audience.

The information in this guide is intended primarily for:

- **Administrators** — People who implement and enforce the company's security program.
- **Users** — People who use the computer where the software is running and can access some or all of its features.

Conventions

This guide uses these typographical conventions and icons.

<table>
<thead>
<tr>
<th><em>Book title, term, emphasis</em></th>
<th>Title of a book, chapter, or topic; a new term; emphasis.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Text that is strongly emphasized.</td>
</tr>
<tr>
<td>User input, code, message</td>
<td>Commands and other text that the user types; a code sample; a displayed message.</td>
</tr>
<tr>
<td>Interface text</td>
<td>Words from the product interface like options, menus, buttons, and dialog boxes.</td>
</tr>
<tr>
<td>Hypertext</td>
<td>A link to a topic or to an external website.</td>
</tr>
</tbody>
</table>

- **Note:** Additional information, like an alternate method of accessing an option.
- **Tip:** Suggestions and recommendations.
- **Important/Caution:** Valuable advice to protect your computer system, software installation, network, business, or data.
- **Warning:** Critical advice to prevent bodily harm when using a hardware product.
Find product documentation

On the ServicePortal, you can find information about a released product, including product documentation, technical articles, and more.

1. Go to the ServicePortal at https://support.mcafee.com and click the Knowledge Center tab.
2. In the Knowledge Base pane under Content Source, click Product Documentation.
3. Select a product and version, then click Search to display a list of documents.
Before setting up Stonesoft NGFW, it is useful to know what the different components do and what engine roles are available. There are also tasks that you must complete to prepare for installation.
The Stonesoft® Next Generation Firewall by Forcepoint (Stonesoft NGFW) system consists of the Stonesoft NGFW engines and the Stonesoft Management Center (SMC) for managing the engines.

Stonesoft NGFW system components

The Stonesoft NGFW system consists of one or more Stonesoft NGFW engines, and the Stonesoft Management Center (SMC). The SMC is the management component of the Stonesoft NGFW system.

The system includes SMC user interface components, SMC server components, and Stonesoft NGFW engines.

![Figure 1: Stonesoft NGFW system components](image)

<table>
<thead>
<tr>
<th>Number</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Management Client</td>
<td>The Management Client is the user interface for the SMC. You use the Management Client for all configuration and monitoring tasks. You can install the Management Client locally as an application, or you can start the Management Client with a web browser using the Java Web Start feature. You can install an unlimited number of Management Clients.</td>
</tr>
<tr>
<td>2</td>
<td>Web Portal</td>
<td>The Web Portal is the browser-based user interface for the services provided by the Web Portal Server.</td>
</tr>
<tr>
<td>3</td>
<td>Management Server</td>
<td>The Management Server is the central component for system administration. One Management Server can manage many different types of engines.</td>
</tr>
<tr>
<td>4</td>
<td>Log Server</td>
<td>Log Servers store traffic logs that can be managed and compiled into reports. Log Servers also correlate...</td>
</tr>
<tr>
<td>Number</td>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>5</td>
<td>Web Portal Server</td>
<td>The Web Portal Server is a separately licensed optional component that provides restricted access to log data, reports, and policy snapshots.</td>
</tr>
<tr>
<td>6</td>
<td>Stonesoft NGFW engines</td>
<td>Stonesoft NGFW engines inspect traffic. You can use Stonesoft NGFW engines in the following roles:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Firewall/VPN</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• IPS</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Layer 2 Firewall</td>
</tr>
</tbody>
</table>

**Stonesoft Management Center (SMC)**

The basic SMC components are the Management Server, Log Server, and one or more Management Clients. The Management Client is the user interface for the SMC. You can use the same SMC installation to manage multiple Stonesoft NGFW engines in different roles.

The SMC can optionally include multiple Management Servers, multiple Log Servers, and multiple Web Portal Servers. Your licenses specify the type and number of optional components and engines that your environment can include. You can install the SMC components separately on different computers or on the same computer, depending on your performance requirements. The SMC all-in-one appliance is shipped with the Management Server and a Log Server pre-installed on it.

**Stonesoft NGFW engines**

You can use Stonesoft NGFW engines in the Firewall/VPN, IPS, and Layer 2 Firewall roles. You can also use Stonesoft NGFW engines as Master Engines to host Virtual Security Engines in these roles.

Stonesoft NGFW engines are represented by different types of Security Engine elements in the SMC. The following elements represent Stonesoft NGFW engines in the SMC:

<table>
<thead>
<tr>
<th>Engine Role</th>
<th>Elements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firewall/VPN</td>
<td><em>Single Firewall</em> elements represent firewalls that consist of one physical device.</td>
</tr>
<tr>
<td></td>
<td><em>Firewall Cluster</em> elements consist of 2–16 physical firewall devices that work together as a single entity.</td>
</tr>
<tr>
<td>IPS</td>
<td><em>Single IPS</em> elements represent IPS engines that consist of one physical IPS device.</td>
</tr>
<tr>
<td></td>
<td><em>IPS Cluster</em> elements combine 2–16 physical IPS devices into a single entity.</td>
</tr>
<tr>
<td>Layer 2 Firewall</td>
<td><em>Single Layer 2 Firewall</em> elements represent Layer 2 Firewalls that consist of one physical device.</td>
</tr>
<tr>
<td></td>
<td><em>Layer 2 Firewall Cluster</em> elements combine 2–16 physical Layer 2 Firewall devices into a single entity.</td>
</tr>
</tbody>
</table>
These elements are containers for the main configuration information directly related to the Stonesoft NGFW engines.

Stonesoft NGFW in the Firewall/VPN role

In addition to standard firewall features, Stonesoft NGFW in the Firewall/VPN role provides several advanced features.

The main features of Stonesoft NGFW in the Firewall/VPN role include:

- **Advanced traffic inspection** — Multi-Layer packet and connection verification process provides maximum security without compromising system throughput. An anti-malware scanner, and anti-spam and web filtering complement the standard traffic inspection features when the firewall is licensed for the UTM (unified threat management) feature. Anti-malware and anti-spam are not supported on Virtual Firewalls. Master Engines do not directly inspect traffic.
- **Built-in load balancing and high availability** — The clustering of the firewall engines is integrated. The firewall engines dynamically load-balance individual connections between the cluster nodes.
- **Multi-Link technology** — Multi-Link allows configuring redundant network connections without the more complex traditional solutions that require redundant external routers and switches. It provides high availability for inbound, outbound, and VPN connections.
- **QoS and bandwidth management** — You can set up the minimum and maximum bandwidth value and the priority value for different types of traffic.
- **Virtual private networks** — The firewall provides fast, secure, and reliable VPN connections with the added benefits of the clustering and Multi-Link technologies. These features provide load balancing and failover between ISPs and VPN gateways.
- **Unified SMC and integration with other security engines** — You can configure and monitor the Firewall/VPN and the other security engines through the same SMC and the same user interface. The SMC provides extensive reporting tools for generating statistical reports based on logs, alerts, and operating statistics.

Stonesoft NGFW in the IPS and Layer 2 Firewall roles

IPS Engines and Layer 2 Firewalls pick up network traffic, inspect it, and create event data for further processing by the Log Server.

The main features of Stonesoft NGFW in the IPS and Layer 2 Firewall roles include:

- **Multiple detection methods** — Misuse detection uses fingerprints to detect known attacks. Anomaly detection uses traffic statistics to detect unusual network behavior. Protocol validation identifies violations of the defined protocol for a particular type of traffic. Event correlation processes event information to detect a pattern of events that might indicate an intrusion attempt.
- **Response mechanisms** — There are several response mechanisms to anomalous traffic. These include different alerting channels, traffic recording, TCP connection termination, traffic blacklisting, and traffic blocking with Inline Interfaces.
- **Unified SMC and integration with other security engines** — The IPS engines, Layer 2 Firewalls, Master Engines, Virtual IPS Engines, and Virtual Layer 2 Firewalls are managed centrally through the SMC. The SMC provides extensive reporting tools for generating statistical reports based on logs, alerts, and operating statistics.

Master Engines and Virtual Security Engines

Master Engines are physical devices that provide resources for multiple Virtual Security Engines.

Any Stonesoft NGFW engine that has a license that allows the creation of Virtual Resources can be used as a Master Engine. Virtual Security Engines are represented by the following elements in the SMC:
- **Virtual Firewall** is a Virtual Security Engine in the Firewall/VPN role.
- **Virtual IPS Engine** is a Virtual Security Engine in the IPS role.
- **Virtual Layer 2 Firewall** is a Virtual Security Engine in the Layer 2 Firewall role.

Each Master Engine can only host one Virtual Security Engine role. To use more than one Virtual Security Engine role, you must create a separate Master Engine for each Virtual Security Engine role. Each Master Engine must be on a separate physical Master Engine device.
Preparing for installation

Before installing Stonesoft NGFW, identify the components of your installation and how they integrate into your environment.

Supported platforms

Several platforms are supported for deploying Stonesoft NGFW engines and SMC components.

Supported platforms for SMC deployment

SMC server components can be installed on third-party hardware or they are available as a dedicated Stonesoft® Management Center Appliance (SMC Appliance).

Third-party hardware

**CAUTION:** Do not install the SMC components on the Stonesoft NGFW engine hardware.

- You can install the SMC on third-party hardware that meets the hardware requirements. The hardware requirements can be found at https://support.mcafee.com.
- You can install all SMC server components on the same computer, or install separate components on different computers.
- In a large or geographically distributed deployment, we recommend installing the Management Server, Log Server, and optional Web Portal Server on separate computers.

SMC Appliance

The Management Server and a Log Server are integrated with the hardware operating system as a dedicated server appliance.

Management Client

Although the Web Start distribution of the Management Client is certified to run only on the listed official platforms, it can run on other platforms. These platforms include Mac OS X and additional Linux distributions with JRE (Java Runtime Environment) installed.

Supported platforms for Stonesoft NGFW engine deployment

You can run Stonesoft NGFW engines on various platforms.

The following general types of platforms are available for Stonesoft NGFW engines:

- Purpose-built Stonesoft NGFW appliances
  - For information about the supported appliance models, see KB78906.
- Virtualization platforms
  - VMware ESX, KVM, Oracle VM server, and Wind River Titanium Server are officially supported. Other virtualization platforms might also be supported.
Note: Deployment on VMware NSX is supported only with Intel® Security Controller integration.

- Amazon Web Services (AWS) cloud
- Third-party hardware that meets the hardware requirements

The Stonesoft NGFW engine software includes an integrated, hardened Linux operating system. The operating system eliminates the need for separate installation, configuration, and patching.

**Deploying Stonesoft NGFW engines in the Amazon Web Services cloud**

You can deploy Stonesoft NGFW engines in the Amazon Web Services (AWS) cloud to provide VPN connectivity, access control, and inspection for services in the AWS cloud.

When you deploy Stonesoft NGFW engines in the AWS cloud, only the Firewall/VPN role is supported. Firewall Clusters, Master Engines, and Virtual Firewalls are not supported.

For deployment instructions and supported features, see KB85949. After deployment, you can manage Stonesoft NGFW engines in the AWS cloud using the Management Client in the same way as other Stonesoft NGFW engines. However, you cannot remotely upgrade Stonesoft NGFW engines in the AWS cloud using the Management Client. You must upgrade these engines using the AWS cloud management infrastructure. For upgrade instructions, see KB85950.

Two licensing models are available for Stonesoft NGFW in the AWS cloud. Two engine image platforms are available, depending on the licensing model:

- **Bring Your Own License** — Pay only Amazon's standard runtime fee for the engine instance. You must install a license for the engine in the SMC.
- **Hourly (pay as you go license)** — You pay Amazon's standard runtime fee for the engine instance plus an hourly license fee based on the runtime of the engine. No license installation is needed for the engine in the SMC.

The SMC automatically detects which platform the engine image is running on for features that require separate licenses.

**Running Stonesoft NGFW engines as Master Engines**

There are some hardware requirements and configuration limitations when you use a Stonesoft NGFW engine as a Master Engine.

Running the Stonesoft NGFW engine as a Master Engine does not require a third-party virtualization platform. When you run Stonesoft NGFW as a Master Engine, the Stonesoft NGFW hardware provides the virtual environment and resources for the hosted Virtual Security Engines. You must always install the Stonesoft NGFW software on a hardware device to run the Stonesoft NGFW engine as a Master Engine.

You can run Master Engines on the following types of hardware platforms:

- Purpose-built Stonesoft NGFW appliances with 64-bit architecture
- Third-party hardware with 64-bit architecture that meets the hardware requirements

The following requirements and limitations apply when you use a Stonesoft NGFW engine as a Master Engine:

- Each Master Engine must run on a separate 64-bit physical device.
- All Virtual Security Engines hosted by a Master Engine or Master Engine cluster must have the same role and the same Failure Mode (**fail-open** or **fail-close**).
• Master Engines can allocate VLANs or interfaces to Virtual Security Engines. If the Failure Mode of the Virtual IPS engines or Virtual Layer 2 Firewalls is Normal (fail-close) and you want to allocate VLANs to several engines, you must use the Master Engine cluster in standby mode.

**Related concepts**

Hardware requirements for installing Stonesoft NGFW engines on third-party hardware on page 170

There are some basic hardware requirements when you run Stonesoft NGFW engines on third-party hardware.

---

**Clustering**

There are special considerations when you deploy a Stonesoft NGFW engine as a Firewall Cluster, IPS Cluster, or Layer 2 Firewall Cluster.

**Heartbeat connection and state synchronization for clusters**

The nodes in a cluster use a heartbeat connection to monitor the other nodes’ operation and to synchronize their state tables.

The nodes in a cluster exchange status information through a heartbeat network using multicast transmissions. If a node becomes unavailable, the other nodes of the cluster immediately notice the change, and connections are reallocated to the available nodes. A dedicated network is recommended for at least the primary heartbeat communications.

The heartbeat connection is essential for the operation of the cluster. Make sure that these conditions are true:

• The heartbeat network works correctly and reliably.
• You are using the correct type of network cables (after testing that they work).
• The network interface cards’ duplex and speed settings match.
• Any network devices between the nodes are correctly configured.

It is possible to authenticate and encrypt the heartbeat traffic.

Problems in the heartbeat network might seriously degrade the performance and operation of the cluster.

In the Firewall/VPN role, the nodes of a Firewall Cluster periodically exchange synchronization messages to synchronize state data.

**Hardware for Firewall Cluster nodes**

You can run different nodes of the same cluster on different types of hardware.

The hardware the cluster nodes run on does not need to be identical. Different types of equipment can be used as long as all nodes have enough network interfaces for your configuration. Firewall Clusters can run on a Stonesoft NGFW appliance, on a standard server with an Intel-compatible processor, or as a virtual machine on a virtualization platform.

If equipment with different performance characteristics is clustered together, the load-balancing technology automatically distributes the load so that lower performance nodes handle less traffic than the higher performance nodes. However, when a node goes offline, the remaining nodes must be able to handle all traffic on their own to ensure High Availability. For this reason, it is usually best to cluster nodes with similar performance characteristics.
Deployment options for Stonesoft NGFW in the IPS and Layer 2 Firewall roles

There are several ways to deploy Stonesoft NGFW in the IPS and Layer 2 Firewall roles depending on how you want to inspect and respond to traffic.

Table 1: Stonesoft NGFW in the IPS and Layer 2 Firewall roles

<table>
<thead>
<tr>
<th>Stonesoft NGFW role</th>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPS</td>
<td>Inline</td>
<td>In an Inline installation, the traffic flows through the IPS Engine. The IPS Engine has full control over the traffic flow and can automatically block any traffic. An inline IPS Engine can also enforce blacklisting commands from other components. Fail-open network cards can ensure that traffic flow is not disrupted when the IPS Engine is offline. An inline IPS Engine also provides access control and logging for any Ethernet traffic (layer 2).</td>
</tr>
<tr>
<td>Capture</td>
<td></td>
<td>In a Capture installation, external equipment duplicates the traffic flow for inspection, and the IPS Engine passively monitors traffic. The IPS Engine does not have direct control over the traffic flow, but it can respond to selected threats by sending packets that reset the connections. An IDS-only IPS Engine can send blacklisting requests to other IPS Engines, Layer 2 Firewalls, or Firewalls, but it cannot enforce blacklisting requests from other components.</td>
</tr>
<tr>
<td>Layer 2 Firewall</td>
<td>Inline</td>
<td>In an Inline installation, the traffic flows through the Layer 2 Firewall. The Layer 2 Firewall has full control over the traffic flow and can automatically block any traffic. An inline Layer 2 Firewall can also enforce blacklisting commands received from other components. An inline Layer 2 Firewall also provides access control and logging for any Ethernet traffic (layer 2).</td>
</tr>
<tr>
<td>Capture (Passive Firewall)</td>
<td></td>
<td>In a Capture (Passive Firewall) installation, external equipment duplicates the traffic flow for inspection to the Layer 2 Firewall, and the Layer 2 Firewall passively monitors traffic. The Layer 2 Firewall does not have direct control over the traffic flow, but it can respond to selected threats by sending packets that reset the connections. A Layer 2 Firewall in Passive Firewall mode can send blacklisting requests to other Layer 2 Firewalls, IPS engines, or Firewalls. It cannot enforce blacklisting requests from other components.</td>
</tr>
<tr>
<td>Passive Inline</td>
<td></td>
<td>In a Passive Inline installation, the traffic flows through the Layer 2 Firewall, but the Layer 2 Firewall only logs connections. A Layer 2 Firewall in Passive inline mode can send blacklisting requests to other Layer 2 Firewalls, IPS engines, or Firewalls. It cannot enforce blacklisting requests from other components.</td>
</tr>
</tbody>
</table>

You can connect Capture Interfaces on an IPS engine or a Layer 2 Firewall to a Switched Port Analyzer (SPAN) port or a network Test Access Port (TAP) to capture network traffic.

A SPAN port captures network traffic to a defined port on an external switch. This action is also known as port mirroring. The capturing is passive, so it does not interfere with the traffic. All traffic to be monitored must be copied to this SPAN port.
A network TAP is a passive device at the network wire between network devices. The capturing is done passively, so it does not interfere with the traffic. With a network TAP, the two directions of the network traffic are divided to separate wires. For this reason, the IPS Engine or Layer 2 Firewall needs two capture interfaces for a network TAP; one capture interface for each direction of the traffic. The two related capture interfaces must have the same logical interface that combines the traffic of these two interfaces for inspection. You could also use the pair of capture interfaces to monitor traffic in two separate network devices.

Cable connection guidelines

Follow these cable connection guidelines when connecting cables to Stonesoft NGFW hardware and SMC appliances.

Cable connection guidelines for SMC Appliance

For an SMC Appliance, make sure that all copper cables are correctly rated (CAT 5e or CAT 6 in gigabit networks).

Cable connection guidelines for Firewalls

The cabling of Firewalls depends on the engine type and the installation.

Make sure that all copper cables are correctly rated (CAT 5e or CAT 6 in gigabit networks).

If you have a two-node Firewall Cluster, it is recommended to use a crossover cable without any intermediary devices between the nodes. If you use an external switch between the nodes, follow these guidelines:

- Make sure that portfast is enabled on the external switches.
- Make sure that the speed/duplex settings of the external switches and the Firewall devices are set to Auto.
- Configure the external switches to forward multicast traffic.

Cable connection guidelines for IPS and Layer 2 Firewalls

The cabling of IPS engines and Layer 2 Firewalls depends on the engine type and the installation.

Make sure that all copper cables are correctly rated (CAT 5e or CAT 6 in gigabit networks).

Follow standard cable connections with inline IPS Engines and Layer 2 Firewalls:

- Use straight cables to connect the IPS engines and Layer 2 Firewalls to external switches.
- Use crossover cables to connect the IPS engines and Layer 2 Firewalls to hosts (such as routers or Firewalls).

**Note:** Fail-open network interface cards support Auto-MDIX, so both crossover and straight cables might work when the IPS Engine is online. However, only the correct type of cable allows traffic to flow when the IPS Engine is offline and the fail-open network interface card is in bypass state. It is recommended to test the IPS deployment in offline state to make sure that the correct cables are used.

Cable connections for Master Engines that host Virtual IPS Engines or Virtual Layer 2 Firewalls follow the same principles as the connections for inline IPS Engines and Layer 2 Firewalls.
Figure 2: Correct cable types for Single IPS engines and Single Layer 2 Firewalls

Figure 3: Correct cable types for Serial IPS Clusters
Figure 4: Correct cable types for Active/Standby Layer 2 Firewall Clusters

Figure 5: Correct cable types for Serial Virtual IPS Clusters
Mismatched speed and duplex settings are a frequent source of networking problems.

The basic principle for speed and duplex settings is that network cards at both ends of each cable must have identical settings. This principle also applies to the automatic negotiation setting: if one end of the cable is set to auto-negotiate, the other end must also be set to auto-negotiate and not to any fixed setting. Gigabit standards require interfaces to use auto-negotiation. Fixed settings are not allowed at gigabit speeds.

For Inline Interfaces, the settings must be identical on both links within each Inline Interface pair. Use identical settings on all four interfaces, instead of just matching settings at both ends of each cable (two + two interfaces). If one of the links has a lower maximum speed than the other link, the higher-speed link must be set to use the lower speed.
Figure 7: Speed/duplex settings

Obtain installation files

If you did not receive an installation DVD for the Stonesoft NGFW engines or the SMC, download installation files and create a DVD.

You do not have to create a DVD under these circumstances:

- Stonesoft NGFW engines and the SMC Appliance are delivered with the necessary software pre-installed on them. You do not need to download installation files.
- You might have received ready-made installation DVDs of the Stonesoft NGFW software and the SMC software.

Download installation files

Download the files you need to create an installation DVD.

2. Enter your license code or log on using an existing user account.
3. Download the .iso image files or the installation .zip file.

Check file integrity

Before installing the Stonesoft NGFW engine from downloaded files, check that the installation files have not become corrupt or been changed.

Using corrupt files might cause problems at any stage of the installation and use of the system. Check file integrity by generating an MD5, SHA-1, or SHA-512 file checksum of the files. Compare the checksum of the downloaded files with the checksum for the software version in the Release Notes or on the download page at the Forcepoint website.
Note: Windows does not have checksum tools by default, but there are several third-party programs available.

1. Look up the correct checksum at https://support.mcafee.com.
2. Change to the directory that contains the files to be checked.
3. Generate a checksum of the file using one of the following commands, where filename is the name of the installation file:
   - `md5sum filename`
   - `sha1sum filename`
   - `sha512sum filename`
4. Compare the displayed output to the checksum for the software version. They must match.

CAUTION: Do not use files that have invalid checksums. If downloading the files again does not help, contact Forcepoint support to resolve the issue.

If you downloaded the installation files as a .zip file, unzip the contents at the installation location and install the licenses.

Create an installation DVD

To use the installation DVD successfully, it must have the correct structure stored in the .iso images. Otherwise it can't be used for installing the software.

1. Use a DVD-burning application that can correctly read and burn the DVD structure stored in the .iso images. For instructions, see the documentation that came with your application.

Licensing Stonesoft NGFW system components

Generate and download a license for each SMC server and Stonesoft NGFW engine node before you start installing the Stonesoft NGFW.

You install the SMC server license when you start the SMC after installation. You install the Stonesoft NGFW engine licenses when you start configuring the Stonesoft NGFW engines.

Types of licenses for Stonesoft NGFW engines

Each Stonesoft NGFW engine node must have its own license:

- Some engines use a Security Engine Node license. Other engines use role-specific licenses. The correct type of license for each engine is generated based on your Management Server proof-of-license (POL) code or the appliance proof-of-serial (POS) code.
- Virtual Security Engines do not require a separate license. However, the Master Engine license limits the number of Virtual Resources that can be created. The limit for the number of Virtual Resources limits how many Virtual Security Engines can be created.
- The Management Server's license might be limited to managing only a specific number of Stonesoft NGFW engines.
- Stonesoft NGFW engines deployed in the AWS cloud with the Bring Your Own License image must have a license in the SMC. Stonesoft NGFW engines deployed in the AWS cloud with the Hourly (pay as you go) image do not require a separate license in the SMC.
Future engine licenses can be downloaded and installed automatically after the Stonesoft NGFW engines and the SMC are fully installed. For more information about automatic downloading and installation of licenses, see the Stonesoft Next Generation Firewall Product Guide.

If there is no connection between the Management Server and the License Center, the appliance can be used without a license for 30 days. After this time, you must generate the licenses manually at the License Center webpage and install them using the Management Client.

## Obtain license files

Generate the licenses based on your Management Server proof-of-license (POL) code or the appliance proof-of-serial-number (POS) code.

If you are licensing several components of the same type, remember to generate a license for each component.

Evaluation licenses are also available. Evaluation license requests might need manual processing. See the license page for current delivery times and details.

2. In the License Identification field, enter the required code (POL or POS) and click Submit.
   - The proof-of-license (POL) code identifies a license. You can find it in the order delivery message (sent by email). Later on, this information is shown in the Administration > Licenses branch of the Configuration view in the Management Client.
   - Stonesoft NGFW appliances also have a proof-of-serial number (POS) that you can find on a label attached to the appliance hardware.

   The license page opens.
3. Check which components are listed as included in this license. Click Register.

   **Tip:** POS binding is always recommended when the option is available.

   The license generation page opens.
4. Enter the Management Server’s POL code or the appliance POS code for the engines you want to license.

   **Tip:** POS binding is always recommended when the option is available.

5. Click Submit Request.

   The license file is sent to you shortly afterward and then is available for download on the license page.

All licenses include the latest version for which they are valid. Automatic upgrade and installation of licenses is enabled by default. If you have disabled automatic license upgrades, you must upgrade the licenses when you upgrade to a new major release of the software.

**Related tasks**

- Install licenses for SMC servers on page 38
- Install the SMC server licenses that you downloaded while preparing for installation.

- Install licenses for Stonesoft NGFW engines on page 49
- Install the Stonesoft NGFW engine licenses that you downloaded while preparing for installation.

## Installation overview

The process of installing Stonesoft NGFW consists of several high-level steps.

1. Install and configure the Stonesoft Management Center and a Management Client.
2. (Optional) Set up Management Client distribution through Java Web Start for automatic installation and upgrade.
3. If network address translation (NAT) is applied to communications between system components, define contact addresses.

4. Configure and install the Stonesoft NGFW engines.
   1. Download and install licenses for the Stonesoft NGFW engines.
   2. Define the Firewall, IPS, and Layer 2 Firewall elements in the Management Client.
   3. (Optional) Define Master Engine and Virtual Firewall, Virtual IPS, and Virtual Layer 2 Firewall elements in the Management Client.
   4. Generate the initial configuration for the Firewalls, IPS engines, Layer 2 Firewalls, or Master Engines. No initial configuration is needed for Virtual Firewalls, Virtual IPS engines, or Virtual Layer 2 Firewalls.
   5. On virtualization platforms or third-party hardware, install the Stonesoft NGFW engine software.
   6. Configure the Stonesoft NGFW engine software. No software configuration is needed for Virtual Firewalls, Virtual IPS engines, or Virtual Layer 2 Firewalls.
   7. Configure basic routing and install a policy on the engines.

Related tasks
Install licenses for Stonesoft NGFW engines on page 49
Install the Stonesoft NGFW engine licenses that you downloaded while preparing for installation.

Add Management Servers for high availability on page 44
You can optionally install one or more additional Management Servers for high availability.
Stonesoft Management Center (SMC) deployment

SMC is the management component of the Stonesoft NGFW system. SMC must be installed and running before you can deploy the Stonesoft NGFW engines.
Installing the SMC

The SMC is the management component of the Stonesoft NGFW system. The SMC manages and controls the other components in the system. You must install the SMC before you can install Stonesoft NGFW engines.

SMC installation options

You can install SMC server components on your own hardware or use an all-in-one SMC Appliance.

⚠️ CAUTION: Make sure that the operating system version you plan to install on is supported. The supported operating systems for running the SMC are listed in the Stonesoft Management Center Release Notes.

There are several ways to install the SMC server components for production use:

• (Recommended) You can install the SMC server components using the Installation Wizard.

   💡 Tip: To evaluate the Stonesoft Next Generation Firewall system in a simulated network environment, you can install the SMC in demo mode.

• In Linux, you can install the SMC server components from the command line.

   💡 Note: You need a graphical environment to use the Management Client. Only the SMC server components can be run in a command line-only environment.

• The Management Server and a default Log Server are pre-installed on the SMC Appliance. When you start the appliance, the installation wizard includes the configuration of these components.

During the installation, certificates can be generated for the SMC server components. The certificates are needed for authentication in establishing the secure encrypted communication channel between system components.

After the installation, you can install more Management Clients on other computers.

• You can install them locally by running the Stonesoft Management Center installer.

• You can make them available through Java Web Start.

   Making the Management Client available through Java Web Start eliminates the need to update all Management Clients individually at each version upgrade. The Management Client has no configurable parameters. The SMC Appliance has Java Web Start enabled by default.

   💡 Note: For third-party hardware, we recommend installing a Management Client on the same computer as the Management Server.

Related tasks
Install the SMC in Demo Mode on page 32
The Demo Mode installation creates a simulated network environment for evaluation.

Install the SMC from the command line on page 33
In Linux, you can install the Stonesoft Management Center on the command line.

Requirements for running SMC on third-party hardware

There are some minimum requirements and recommendations when you run the SMC on third-party hardware.

The following are the minimum requirements for a basic SMC:
• Intel® Core™ family processor or higher recommended, or equivalent on a non-Intel platform
• A mouse or pointing device (for the Management Client only)
• SVGA (1024x768) monitor or higher (for the Management Client only)
• Disk space for the Management Server: 6 GB
• Disk space for the Log Server: 50 GB
• Memory requirements for 64-bit operating systems:
  • 6 GB RAM for the Management Server, Log Server, or Web Portal Server (8 GB if all servers are installed on the same computer)
  • 2 GB RAM for the Management Client
• Memory requirements for 32-bit Linux operating systems:
  • 2 GB RAM for the Management Server, Log Server, or Web Portal Server (3 GB if all servers are installed on the same computer)
  • 1 GB RAM for the Management Client

Security considerations for SMC deployment

The information stored in the Stonesoft Management Center (SMC) is highly valuable to anyone conducting or planning malicious activities in your network. Someone who gains administrator rights to the Management Server can change the configurations.

An attacker can gain access by exploiting operating system weaknesses or other services running on the same computer to gain administrator rights in the operating system.

⚠️ Important: Secure the Management Server computer. Anyone who has administrator rights to the operating system can potentially view and change any SMC configurations.

Consider at least the following points to secure the Management Server and Log Server:

• Prevent any unauthorized access to the servers. Restrict access to the minimum required both physically and with operating system user accounts.
• We recommend allowing access only to the required ports.
• Never allow Management Client connections from insecure networks.
• Take all necessary steps to keep the operating system secure and up to date.
• We recommend that you do not run any third-party server software on the same computer with the SMC servers.
• We recommend placing the servers in a separate, secure network segment without third-party servers and limited network access.

You can optionally use 256-bit encryption for the connection between Security Engines and the Management Server. 256-bit encryption requires both the engines and the Management Server to be version 5.5 or later. You must also use an Internal ECDSA Certificate Authority to sign certificates for SMC communication.

Related information
Stonesoft NGFW engine ports on page 138
The most important default ports used in communications to and from Security Engines and Master Engines are presented in the following illustrations.

Security Management Center ports on page 135
The most important default ports used in communications to and from SMC components are presented in the following illustrations.

**Basic system settings for the SMC components**

Check these operating system settings on the computers that you use as a platform for the SMC components.

**Date and time settings for SMC components**

Make sure that the date, time, and time zone settings are correct on any computer that you use as a platform for any SMC component, including the Management Client workstations. The time settings of the Stonesoft NGFW engines do not need to be adjusted, as they are automatically synchronized with the Management Server’s time setting. For this operation, the time is converted to UTC time according to the Management Server’s time zone setting. The SMC always uses UTC internally.

**Hosts file for SMC servers**

Due to a restriction of the Java platform, the Management Server and Log Server host names must be resolvable on the computer running the Management Client. This restriction applies even if the Management Client is running on the same computer as the servers.

To guarantee that the host names can be resolved, add the IP address and host name pairs to the local hosts file on the client computer:

- In Windows: `\%SystemRoot\%system32\drivers\etc\hosts`
- In Linux: `/etc/hosts`

**Installing on Linux**

The installation creates sgadmin user and group accounts.

If there is a pre-existing sgadmin account, the installation fails. All shell scripts belong to sgadmin and are executed either by root or the sgadmin user. The shell scripts are executed with sgadmin rights. After the installation, the sgadmin account is disabled. The sgadmin account is deleted at uninstallation.

**SMC installation overview**

The process of installing SMC consists of several high-level steps.

1. Install the SMC components or start the SMC Appliance.
   
   **Note:** If you are installing components on separate computers, install the Management Server first.

2. Start the SMC.
3. Install licenses for SMC servers.
4. (Optional) Install additional Management Servers.
Install SMC components

You can install the SMC in a user interface in Windows and Linux.

Note: For the all-in-one appliance, see Install the SMC Appliance.

Related tasks
Obtain installation files on page 20
If you did not receive an installation DVD for the Stonesoft NGFW engines or the SMC, download installation files and create a DVD.

Install the SMC from the command line on page 33
In Linux, you can install the Stonesoft Management Center on the command line.

Install the SMC Appliance on page 36
The SMC Appliance ships with the Management Server and a Log Server pre-installed on it. Starting the appliance initiates an installation wizard.

Start the SMC installation

Start the Installation Wizard to install the Stonesoft Management Center components.

1. Log on to the system where you are installing the SMC with the correct administrator rights.
   • In Windows, log on with administrator rights.
   • In Linux, log on as root.

2. Start the installation in one of the following ways:
   • From a .zip file — Unzip the file and run setup.exe on Windows or setup.sh on Linux.
   • From a DVD — Insert the installation DVD and run the setup executable from the DVD.

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Path to executable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 64-bit</td>
<td>\Forcepoint_SMC_Installer\Windows-x64\setup.exe</td>
</tr>
<tr>
<td>Linux 32-bit</td>
<td>/Forcepoint_SMC_Installer/Linux/setup.sh</td>
</tr>
<tr>
<td>Linux 64-bit</td>
<td>/Forcepoint_SMC_Installer/Linux-x64/setup.sh</td>
</tr>
</tbody>
</table>

Tip: If the DVD is not automatically mounted in Linux, mount the DVD with `mount /dev/cdrom /mnt/cdrom`.

3. Select the language for the installation and click OK.
The language that you select is also set as the default language of the Management Client.
The Installation Wizard starts in the selected language.

4. When the Installation Wizard shows the Introduction view, click Next to start the installation.
The License Agreement appears.
   • You can click Cancel at any time to exit the wizard.
   • You can click Previous at any time to go back.

5. Indicate that you agree to the license agreement and click Next.

6. (Optional) The default installation directory in Windows is C:\Program Files\Forcepoint\Stonesoft Management Center. Click Choose to browse to a different installation folder. This folder is for the application. Log Servers can have a separate data storage location.

Note: If you install the SMC in C:\Program Files\Stonesoft Management Center, the installation creates an extra C:\ProgramData\Stonesoft Management Center directory.
Center folder, which duplicates some of the folders in the installation directory. Some of
the program data is also stored in the C:\ProgramData\Forcepoint\Stonesoft Management
Center folder.

7. Click Next.

**Important:** When you run setup.sh on Linux, make sure to verify the hosts file in Linux
distributions.

8. Select where to create shortcuts. These shortcuts can be used to manually start components and to run
some maintenance tasks.

9. Click Next.

10. Select the installation type:
    - Typical installs all SMC components except the Web Portal Server.
    - Management Client Only installation is meant for administrators’ workstations.
    - Custom installation allows you to select components one by one. Use this option if you want to install
        SMC components on different computers or if you want to install the Web Portal Server.

11. Click Next.

12. (Custom installation only) Select the components that you want to install and click Next.

    **Important:** Make sure that you have a license for any separately licensed components
    before installing them. The Web Portal Server is not included in standard Stonesoft
    Management Center licenses.

The Installation Wizard continues according to the installation type and the selected components.
Continue the installation in one of the following ways:
- For a Typical installation, install a Management Server.
- For a Custom installation, install the first selected component.

Install a Management Server

In a Typical installation, you must install the Management Server first. In a Custom installation, you usually
install the Management Server first.

1. In the Installation Wizard, select the Management Server’s IP address from the list.
   The Management Server’s license must be generated using this IP address.

2. In the Log Server IP Address field, enter the IP address to which this Management Server sends its log
   data.

3. (Optional) If you want the Management Server to distribute the Management Client through Java Web
   Start, select Enable and Configure Web Start Server.

4. (Optional) To use 256-bit encryption for communication between the Management Server and the engines,
   select 256-bit Security Strength.
   This setting requires all engines to be version 5.5 or higher.

    **CAUTION:** Engines with versions lower than 5.5 and SSL VPN gateways cannot
    communicate with the SMC when 256-bit encryption is used for the communication
    between the Management Server and the engines.

5. (Optional) If you are required to follow the FIPS 140-2 standards, select Enable FIPS 140-2
   Configuration Restrictions.

    **Note:** This option only is for environments that are required to follow the FIPS 140-2
    standards. Do not select this option unless you have a specific reason to do so.

6. Leave Install as a Service selected to make the Management Server start automatically.
7. (256-bit Security Strength only) Click Next.
   A warning about the compatibility of 256-bit security strength is displayed.
   If you did not select Enable and Configure Web Start Server, proceed to step 9.
8. Click Next. You are prompted to configure the Web Start Server.
9. (Web Start Server only) Configure the Web Start Server settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>Enter the TCP port that the service listens to. By default, the standard HTTP port 80 is used on Windows. Port 8080 is used on Linux (which does not allow the use of reserved ports for this type of service).</td>
</tr>
<tr>
<td></td>
<td>Note: Make sure that the listening port is not in use on the server.</td>
</tr>
<tr>
<td>Host Name (Optional)</td>
<td>Enter the Host Name that the Web Start service uses. Leave the field blank to allow requests to any of the server’s host names.</td>
</tr>
</tbody>
</table>

10. Click Next.
    You are prompted to create a superuser account.

   **Important:** This account is the only one that can log on after the installation.

11. In the Enter the User Name field, enter a user name.
12. In the Enter the Password and Confirm the Password fields, enter and confirm the password.
13. Click Next.

The Installation Wizard continues according to the installation type and the selected components.

Continue the installation in one of the following ways:
- For a typical installation, install a Log Server.
- For a custom installation, install the next selected component or finish the SMC installation.

## Install a Log Server

The SMC requires the installation of one or more Log Servers.

1. In the Installation Wizard, select the Log Server’s IP address from the list.
   If IP address binding is used, the Log Server’s license must be generated with this IP address as the binding.
2. Enter the IP addresses of the Management Servers that control this Log Server.
3. If the components are installed on different computers and the Management Server is not reachable at the moment, deselect Certify the Log Server During the Installation to avoid connection attempts after installation.

   **Tip:** Certifying is mandatory for running the Log Server.

4. Leave Install as a Service selected to make the Log Server start automatically.
5. Click Next.
6. (Optional) Click Choose to browse to a different storage folder for log data.

   **Note:** Remote locations are not suitable for active storage, as quick and reliable access is required.
7. Click Next.

The Installation Wizard continues according to the installation type and the selected components.
Continue the installation in one of the following ways:
- For a Typical installation, finish the SMC installation.
- For a Custom installation, install the next selected component or finish the SMC installation.

Install a Web Portal Server

If you want to provide restricted access to log data, reports, and policy snapshots, install a Web Portal Server.

Make sure that you have a license for the Web Portal Server before installing it. The Web Portal Server is an optional component and is not included in standard Stonesoft Management Center licenses. You can use the Previous button to return to component selection.

1. In the Installation Wizard, select the Web Portal Server’s IP address from the list.
   If IP address binding is used, the Web Portal Server’s license must be generated with this IP address as the binding.
2. Enter the IP addresses of the Management Servers that control this Web Portal Server.
3. If the components are installed on different computers and the Web Portal Server is not reachable at the moment, deselect Certify the Web Portal Server During the Installation to avoid connection attempts after installation.
   Certifying is mandatory for running the Web Portal Server.
4. Enter the IP address of the Log Server to which this Web Portal Server sends its log data.
5. Leave Install as a Service selected to make the Web Portal Server start automatically.
6. Click Next.

The Installation Wizard continues to the Pre-Installation Summary.

You are now ready to finish the SMC installation.

Finish the SMC installation

Finish the configuration in the Installation Wizard and install the selected components.

If you are installing any server components as a service on a Windows system, make sure that the Services window is closed before you proceed.

⚠️ Important: This is the last chance to cancel or make changes by clicking Previous.

1. Check that the information in the Pre-Installation Summary is correct and click Install to install the selected components.
   Depending on the options, you selected, you might be prompted to generate certificates during the installation.
2. Click Done to close the installer.

Note: If any Log Server or Web Portal Server certificate was not retrieved during the installation, retrieve a certificate manually before starting the server.

Related tasks
Generate SMC server certificates on page 40
If necessary, you can manually certify an SMC server or generate an SMC server certificate.

## Install the SMC in Demo Mode

The Demo Mode installation creates a simulated network environment for evaluation. Demo Mode installation is for evaluation only. SMC in Demo Mode cannot be used with any traffic inspection engines and cannot be upgraded.

1. Log on to the system where you are installing the SMC with the correct administrator rights.
   - In Windows, log on with administrator rights.
   - In Linux, log on as root.
2. Start the installation in one of the following ways:
   - **From a .zip file** — Unzip the file and run setup.exe on Windows or setup.sh on Linux.
   - **From a DVD** — Insert the installation DVD and run the setup executable from the DVD.

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Path to executable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 64-bit</td>
<td>\Forcepoint_SMC_Installer\Windows-x64\setup.exe</td>
</tr>
<tr>
<td>Linux 32-bit</td>
<td>/Forcepoint_SMC_Installer/Linux/setup.sh</td>
</tr>
<tr>
<td>Linux 64-bit</td>
<td>/Forcepoint_SMC_Installer/Linux-x64/setup.sh</td>
</tr>
</tbody>
</table>

**Tip:** If the DVD is not automatically mounted in Linux, mount the DVD using this command: `mount /dev/cdrom /mnt/cdrom`.

3. Select the language for the installation and click **OK**.
   - The language that you select is also set as the default language of the Management Client.
   - The Installation Wizard starts in the selected language.
4. When the Installation Wizard shows the **Introduction** view, click **Next** to start the installation.
   - The License Agreement appears.
   - You can click **Cancel** at any time to exit the wizard.
   - You can click **Previous** at any time to go back.
5. Indicate that you agree to the license agreement and click **Next**.
6. (Optional) The default installation directory in Windows is C:\Program Files\Forcepoint\Stonesoft Management Center. Click **Choose** to browse to a different installation folder. This folder is for the application. Log Servers can have a separate data storage location.

**Note:** If you install the SMC in C:\Program Files\Forcepoint\Stonesoft Management Center, the installation creates an extra C:\ProgramData\Forcepoint\Stonesoft Management Center folder, which duplicates some of the folders in the installation directory. Some of the program data is also stored in the C:\ProgramData\Forcepoint\Stonesoft Management Center folder.

7. Click **Next**.

**Important:** When you run setup.sh on Linux, make sure to verify the hosts file in Linux distributions.

8. Select where to create shortcuts. These shortcuts can be used to manually start components and to run some maintenance tasks.
9. Click **Next**.
10. Select Demo Mode as the installation type.
11. Click **Next**.
12. Select the type of demo to install.
• Use a standard backup to simulate a standard preconfigured environment.
• Select Demo MSSP/Stonesoft Management Center MSSP Demo to simulate a preconfigured environment with MSSP features.
• Select your own backup file to create the simulation based on your own backup.

13. (Custom backup file only) Click Choose and browse to the location of the backup file.
14. Click Next.
   A description of the Demo Mode installation is displayed.
15. Click Next.
   The Pre-Installation Summary is displayed.
16. Click Install.
   The installation starts.
17. When the installation finishes, click Next.
18. Click Done to close the installer.
   The Stonesoft Management Center starts automatically in the background.

The simulated environment is now ready for testing.

Related tasks
Log on to the SMC on page 38
The Management Client connects to the Management Server and to Log Servers.

Install the SMC from the command line

In Linux, you can install the Stonesoft Management Center on the command line.
Before installing, check the installation package integrity using the MD5 or SHA-1 file checksums.

**Important:** You need a graphical environment to use the Management Client. It cannot be run on the command line. Only the SMC server components can be run in a command line-only environment.

Related tasks
Check file integrity on page 20
Before installing the Stonesoft NGFW engine from downloaded files, check that the installation files have not become corrupt or been changed.

Start the SMC installation on the command line

Start the command line installer to install SMC components from the command line.

1. Start the installation in one of the following ways:
   • From a .zip file: Unzip the file and run setup.sh.
   • From a DVD: Insert the installation DVD and run the setup executable from the DVD:

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Path to executable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linux 32-bit</td>
<td>/Forcepoint_SMC_Installer/Linux/setup.sh</td>
</tr>
<tr>
<td>Linux 64-bit</td>
<td>/Forcepoint_SMC_Installer/Linux-x64/setup.sh</td>
</tr>
</tbody>
</table>

**Tip:** If the DVD is not automatically mounted in Linux, mount the DVD with `mount /dev/cdrom /mnt/cdrom.`
2. Run the command `./setup.sh -nodisplay` (the `-nodisplay` option can be omitted if there is no graphical environment running).

The installer starts. You can use the following general commands at any point where the installer asks for your input:

- Type `back` to return to the previous step.
- Type `quit` to cancel the installation.

3. Press **Enter** to continue.

The license agreement is displayed.

4. Press **Enter** to scroll through the license agreement and accept it by typing `Y`.

You are prompted to select the installation directory.

5. Press **Enter** to install in the default installation directory or specify a different directory and press **Enter** to continue.

   - If you specify a different directory, you are prompted to confirm it.
   - A reminder to verify that the hosts file is displayed.

6. Press **Enter** to continue.

You are prompted to select the link location for shortcuts to the most commonly used command-line tools.

7. Press **Enter** to create links in the default directory or select one of the other options and press **Enter** to continue.

You are prompted to select the type of installation.

8. Select the Install Set:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Press <strong>Enter</strong></td>
<td>Installs all Stonesoft Management Center components except the Web Portal Server.</td>
</tr>
<tr>
<td>Press 2 and press <strong>Enter</strong></td>
<td>Installs only the Management Client.</td>
</tr>
<tr>
<td>Press 3 and press <strong>Enter</strong></td>
<td>Installs a simulated network environment for evaluation in Demo Mode.</td>
</tr>
<tr>
<td>Press 4 and press <strong>Enter</strong></td>
<td>Installs a custom selection of components.</td>
</tr>
</tbody>
</table>

9. (Customized installation only) Type a comma-separated list of numbers for the components you want to select or deselect and press **Enter**.

   - Entering the number of a selected component deselects it.
   - Entering the number of a component that is not selected selects it.
   - By default, the Management Server, Log Server, and Management Client are selected.

   **Example:** To install only the Web Portal Server, type `1, 2, 3, 4` and press **Enter**.

   You are prompted to review and confirm the component selection.

10. Press **Enter** to continue.

---

**Configure the Management Server from the command line**

Configure the Management Server settings in a command line installation.

1. Press **Enter** to use the default IP address for the Management Server or enter a different IP address and press **Enter** to continue.

   You are prompted to enter the IP address of the Log Server to which the Management Server sends its log data.

2. Press **Enter** to use the default IP address for the Log Server or enter a different IP address and press **Enter** to continue.

   You are prompted to select whether to install the Management Server as an extra Management Server for high availability.
3. Type `Y` to install the Management Server as an extra Management Server for high availability, or type `N` to install the Management Server as a standalone Management Server or as the primary Management Server in a high-availability environment.

4. Press **Enter** to continue.

You are prompted to select whether to enable and configure a Web Start Server.

5. Type `Y` to enable and configure Web Start or `N`.

6. Press **Enter** to continue.

You are prompted to select whether to enable 256-bit security strength for communication between the Management Server and the engines. This option requires all engines to be version 5.5 or higher.

   **CAUTION:** Engines with versions lower than 5.5 and SSL VPN gateways cannot communicate with the SMC when 256-bit encryption is used for the communication between the Management Server and the engines.

7. Type `Y` to enable 256-bit security strength or `N` to use the default security strength.

8. Press **Enter** to continue.

You are prompted to select whether to install the Management Server as a service.

9. Type `Y` to install the Management Server as a service or `N` if you always want to start the Management Server manually.

10. Press **Enter** to continue.

    If you enabled 256-bit security strength, a warning about the compatibility of 256-bit security strength is displayed.

11. (256-Bit Security Strength only) Press **Enter** to continue or type `back` and start the Management Server configuration again from Step 1 to disable 256-bit security strength.

12. (Web Start only) Enter the TCP port that the service listens to. By default, the standard HTTP port 80 is used on Windows and 8080 on Linux. Linux does not allow the use of reserved ports for this type of service.

   **Important:** Make sure that the listening port is not in use on the server.

13. (Web Start only) Enter the Host Name that the Web Start service uses. Leave the option blank to allow requests to any of the server’s host names. Press **Enter** to continue.

14. Create a superuser account.

    1. Type a new user name.
    2. Type the password for this account.
    3. Confirm the password.

**Related information**

- **Default communication ports** on page 135
  There are default ports used in connections between SMC components and default ports that SMC components use with external components.

**Configure the Log Server from the command line**

Configure the Log Server settings in a command line installation.

1. Press **Enter** to use the default IP address for the Log Server or enter a different IP address and press **Enter** to continue.

    You are prompted to enter the IP addresses of the Management Servers that control the Log Server.

2. Press **Enter** to use the default IP address for the Management Server or enter different IP addresses and press **Enter** to continue.

    You are prompted to enter the port on which the Log Server receives data.

3. Press **Enter** to use the default port or enter a different port and press **Enter** to continue.

    You are prompted to select whether to install the Log Server as a service.

4. Type `Y` to install the Log Server as a service or `N` if you always want to start the Log Server manually.
5. Press **Enter** to continue.
   You are prompted to select the directory for log files.

6. Press **Enter** to use the default directory or specify a different directory and press **Enter** to continue.

**Configure the Web Portal Server from the command line**

Configure the Web Portal Server settings in a command line installation.

1. Press **Enter** to use the default IP address for the Web Portal Server or enter a different IP address and press **Enter** to continue.
   You are prompted to enter the IP addresses of the Management Servers that control the Web Portal Server.

2. Press **Enter** to use the default IP address for the Management Server or enter different IP addresses and press **Enter** to continue.
   You are prompted to enter the IP address of the Log Server.

3. Press **Enter** to use the default IP address for the Log Server or enter a different IP address and press **Enter** to continue.
   You are prompted to select whether to install the Web Portal Server as a service.

4. Type **Y** to install the Web Portal Server as a service or **N** if you always want to start the Web Portal Server manually.

5. Press **Enter** to continue.

**Install the SMC Appliance**

The SMC Appliance ships with the Management Server and a Log Server pre-installed on it. Starting the appliance initiates an installation wizard.

Prepare the appliance for installation:

- Determine the appliance networking information:
  - IPv4 network address
  - IPv4 network mask
  - (Optional) Default gateway address
  - (Optional) DNS server addresses
- Mount the appliance in a rack.
- Connect the network and console cables.
- Access the appliance through a KVM or the Remote Management Module port.

See the *Stonesoft Management Center Appliance Hardware Guide* for complete details.

1. Turn on the SMC Appliance and accept the EULA.

2. Enter the account name and password.
   The password must be ten characters and contain at least one number. The account name and password become an administrator account with unrestricted permissions (superuser) on the Management Server.
   1. Enter the account name.
      This field is case sensitive and limited to eight characters.
   2. Enter the password.
      The password is case sensitive and must have a minimum of nine characters.
   3. Enter the password again.

3. Make your security selections.
   1. Specify if the appliance runs in FIPS 140-2 mode.
      No is the default.
Note: This option is for environments that are required to follow the FIPS 140-2 standards.

2. Specify if the appliance uses 256-bit security strength.
   Yes is the default.

Note: The security strength is for the connection to the Stonesoft NGFW engines. The engines must also use 256-bit security strength.

4. Complete the network interface and network setup fields.
   1. Select the main network interface for management.
   2. Complete the network setup fields for the interface.

5. Enter a host name for the Management Server.
6. (Optional) Configure NTP settings.

When the installation is complete, the appliance restarts.

Related tasks
Contact the Management Server on page 112
Provide the necessary information to allow the Stonesoft NGFW engine to establish contact with the Management Server.

Start the SMC after installation

Proceed through the listed sections in sequence to start the SMC for the first time.

Start the Management Server

If the Management Server does not start automatically, you must start it.

If the Management Server has been installed as a service, it starts automatically both after the installation and during the operating system boot process. In Windows, the Stonesoft NGFW Management Server service is controlled in the Services window. That window is in the Windows Control Panel under the Administrative Tools category.

1. Start the Management Server manually.
   • In Windows, use the shortcut icon in the location you selected during installation or run the script <installation directory>/bin/sgStartMgtSrv.bat.
   • In Linux, run the script <installation directory>/bin/sgStartMgtSrv.sh.

When the Management Server has successfully started, you are ready to start the Management Client.

Start the Management Client

After you start the Management Server, start the Management Client

1. To start a locally installed Management Client, use the appropriate step.
   • In Windows, use the shortcut icon in the location you selected during installation or run the script <installation directory>/bin/sgClient.bat.
   • In Linux, run the script <installation directory>/bin/sgClient.sh. A graphical environment is needed for the Management Client.

2. To start a Management Client using Web Start, follow these steps.
1. In a web browser, enter `http://<server address>:<port>`.

   **Note:** `<port>` is only needed if the server is configured to run on a different port from the HTTP standard port 80.

2. Click the link for the Web Start Management Client.

Log on to the SMC

The Management Client connects to the Management Server and to Log Servers.

For details about product features, usage, and best practices, click Help or press F1.

1. Select an existing Management Server IP address or DNS name, or click Add Server and enter an IP address or DNS name.
   - In Demo Mode, select 127.0.0.1.

2. Enter the user name and password for the Administrator you defined during the Management Server or SMC Appliance installation.
   - In Demo Mode, use the following credentials:
     • User name — demo
     • Password — demo

3. Click Log in.

Related information

Default communication ports on page 135
There are default ports used in connections between SMC components and default ports that SMC components use with external components.

Accept the Management Server certificate

A certificate dialog box is displayed when the Management Client contacts any Management Server for the first time.

As a precaution, you can make sure that the communication really is with your Management Server by checking the Certificate Authority fingerprint.

1. View the Management Server fingerprint on the Management Server:
   • In Windows, use the shortcut icon in the location you selected during installation (default: Start > All Programs > Forcepoint > Stonesoft Management Center > Tools > Show Fingerprint) or run the script `<installation directory>/bin/sgShowFingerPrint.bat`.
   • In Linux, run the script `<installation directory>/bin/sgShowFingerPrint.sh`.

2. If the fingerprint matches, click Accept.
   The Management Client opens.

Install licenses for SMC servers

Install the SMC server licenses that you downloaded while preparing for installation.

The SMC servers require licenses to become operational. If you do not have a valid Management Server license, a message appears when you log on. If the message appears after licensing, make sure that the licensed IP addresses are correct and active on the server when the Management Server service starts.

For details about product features, usage, and best practices, click Help or press F1.

1. In the Management Client, install licenses through the License Information message.
1. Click Continue.
2. Select the license files in the dialog box. If the message is not shown, install the licenses as explained in the next step. Otherwise, check that the licenses were installed correctly.

2. If you are not prompted to install a Management Server license, install the license files for the other SMC servers.
   1. Select \(\equiv\) Menu > File > System Tools > Install Licenses.
   2. Select the license files and click Install.
3. Check that the licenses were installed correctly.
   1. Select \(\equiv\) Menu > Configuration > Administration.
   2. Expand the Licenses branch and select All Licenses.
   3. Check that all licenses you installed are listed here.

**Related tasks**

- **Obtain license files** on page 22
- Generate the licenses based on your Management Server proof-of-license (POL) code or the appliance proof-of-serial-number (POS) code.

### Bind Management Server POL-bound licenses to servers

You must bind Management Server POL-bound licenses for Log Servers and Web Portal Servers to specific Server elements.

1. Select \(\equiv\) Menu > Configuration > Administration.
4. Select the correct server from the list.
5. Click Select.

   **Tip:** If you bound the license to an incorrect element, right-click the license and select Unbind.

The license is now bound to the selected Log Server or Web Portal Server element.

**Note:** The license is permanently bound to the Log Server or Web Portal Server element when the server is started for the first time. A permanently bound license cannot be rebound to a different Log Server or Web Portal Server element without relicensing or deleting the element that the license is bound to. Until you do that, the unbound license is shown as Retained.

### Start SMC servers

If the Log Server and optional Web Portal Server do not start automatically, you must start them.

If the Log Server and Web Portal Server have been installed as a service, the servers are started automatically during the operating system boot process. If the operating system is restarted and the servers do not yet have a license, you might need to start them manually.

   - If you installed the Log Server or Web Portal Server as a service, start or stop the server manually in Windows through the Services window.
• Start the Log Server or Web Portal Server manually by running scripts in a console window.

Read the console messages for information about the progress. Closing the console stops the service.

<table>
<thead>
<tr>
<th>Server type</th>
<th>Windows script</th>
<th>Linux script</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log Server</td>
<td><code>&lt;installation directory&gt;/bin/sgStartLogSrv.bat</code></td>
<td><code>&lt;installation directory&gt;/bin/sgStartLogSrv.sh</code></td>
</tr>
<tr>
<td>Web Portal Server</td>
<td><code>&lt;installation directory&gt;/bin/sgStartWebPortalServer.bat</code></td>
<td><code>&lt;installation directory&gt;/bin/sgStartWebPortalServer.sh</code></td>
</tr>
</tbody>
</table>

2. If the Log Server or Web Portal Server does not start, troubleshoot and resolve issues that cause starting to fail.
   • Try starting the server by running scripts in a console window to see if an error is displayed on the console.
   • Check that licenses are correctly bound to components.
   • Make sure that the server has a valid certificate for secure system communications. If there are certificate-related problems or problems you are not able to identify, try regenerating the certificate.

Generate SMC server certificates

If necessary, you can manually certify an SMC server or generate an SMC server certificate.

To manually certify an SMC server, run one of the following scripts in Windows or in Linux depending on the server type:

<table>
<thead>
<tr>
<th>Server type</th>
<th>Windows script</th>
<th>Linux script</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log Server</td>
<td><code>&lt;installation directory&gt;/bin/sgCertifyLogSrv.bat</code></td>
<td><code>&lt;installation directory&gt;/bin/sgCertifyLogSrv.sh</code></td>
</tr>
<tr>
<td>Web Portal Server</td>
<td><code>&lt;installation directory&gt;/bin/sgCertifyWebPortalServer.bat</code></td>
<td><code>&lt;installation directory&gt;/bin/sgCertifyWebPortalServer.sh</code></td>
</tr>
</tbody>
</table>

To generate a server certificate, follow these steps:

1. Enter the user name and password for the account you created during the Management Server installation (other accounts with unrestricted permissions can also be used).
2. Click Accept to accept the certificate fingerprint of the Management Server’s Certificate Authority. As a precaution, you can make sure that the communication really is with your Management Server. The Server Selection dialog box opens.
3. Identify the component that you want to certify:
   • If the server element that represents the component is listed, select it.
   • If recommended follows the name of a server element, the component ID of the server element matches the ID of the component that you are certifying. It is suggested that you select the recommended server element.

   **CAUTION:** Selecting a server element that is not the recommended server element might cause serious problems. For example, the server’s log data or the monitoring status of the server might be displayed incorrectly.

   • If the correct server element is not listed, select Create a New Log Server or Create a New Web Portal Server and enter a name in the Name field.
4. Click OK.
Post-installation SMC configurations

After installation, you can configure settings for system communication and add more functions to the SMC.

- If NAT is applied to communications between any SMC components, configure NAT addresses for SMC components.
- If you want to install high availability Management Servers, configure and install more Management Servers.
- If you want to enable Web Start or you want to change the Web Start Server settings, distribute Management Clients through Web Start.

When you are finished configuring the SMC, you are ready to use the Management Client to configure Firewall, IPS, and Layer 2 Firewall elements. The elements must be configured before installing the physical engines.

Related concepts
Configuring NAT addresses for SMC components on page 42
You must configure Locations and contact addresses when network address translation (NAT) is applied to the communications between any of the SMC components.

Related tasks
Add Management Servers for high availability on page 44
You can optionally install one or more additional Management Servers for high availability.

Distribute Management Clients through Web Start on page 46
In addition to installing Management Clients on a local workstation, you can also distribute them through Java Web Start.
After initial installation is complete, configure the SMC to allow adding the other components for your system.

Configuring NAT addresses for SMC components

You must configure Locations and contact addresses when network address translation (NAT) is applied to the communications between any of the SMC components.

If there is NAT between communicating SMC components, the translated IP address might have to be defined for system communications.

You use Location elements to configure SMC components for NAT. There is a Default Location to which all elements belong if you do not assign them to a specific Location. If NAT is applied between two SMC components, you must separate them into different Locations and then add a contact address for the component to be contacted.

You can define a Default contact address for contacting an SMC component (defined in the Properties dialog box of the corresponding element). The component's Default contact address is used in communications when SMC components that belong to another Location contact the component and the component has no contact address defined for its Location.

Figure 8: Example scenario—using locations

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Headquarters Location</strong></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Management/Log server</td>
</tr>
<tr>
<td>2</td>
<td>Internet</td>
</tr>
<tr>
<td>3</td>
<td>IPS</td>
</tr>
<tr>
<td>4</td>
<td>Firewall</td>
</tr>
<tr>
<td><strong>Between locations</strong></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Internet</td>
</tr>
<tr>
<td><strong>Branch Office Location</strong></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Firewall</td>
</tr>
<tr>
<td>7</td>
<td>IPS</td>
</tr>
</tbody>
</table>
In the example scenario above, the same Management Server and Log Server manage SMC components both at a company’s headquarters and at the branch office.

NAT could typically be applied at the following points:

- The firewall at the headquarters or an external router can provide the SMC servers external IP addresses on the Internet. The external addresses must be defined as contact addresses so that the SMC components at the branch offices can contact the servers across the Internet.
- The branch office firewall or an external router can provide external addresses for the SMC components at the branch office. In this case, the external IP addresses must also be defined as contact addresses so that the Management Server can contact the components.

When contact addresses are needed, it might be enough to define a single new Location element, for example, for the branch office, and to group the SMC components at the branch office into the “Branch Office” Location. The same Location element could also be used to group SMC components at any other branch office when they connect to the SMC servers at the headquarters.

To be able to view logs, the administrators at the branch office must select the “Branch Office” Location in the Management Client.

### Configuration overview

1. Define Location elements.
2. Define contact addresses for the Management Servers and Log Servers.
3. Select the Location for your Management Client.
4. Select the Locations for Stonesoft NGFW engines when you create the engine elements.

### Related information

**Default communication ports** on page 135

There are default ports used in connections between SMC components and default ports that SMC components use with external components.

### Add Location elements

Group the SMC components into Location elements based on which components are on the same side of a NAT device.

The elements that belong to the same Location element always use the primary IP address when contacting each other.

1. Select ☰ Menu > Configuration > Administration.
2. Expand the Other Elements branch.
3. Right-click Locations and select New Location.
4. In the Name field, enter a name.
5. Select elements from the Resources pane and click Add.
6. Click OK.

If your Management Server or Log Server needs a contact address, add SMC server contact addresses.

Otherwise, you are ready to configure the Firewall, IPS, and Layer 2 Firewall elements in the Management Client. You must configure the elements before configuring the Stonesoft NGFW engine software.
Add SMC Server contact addresses

The Management Server and Log Server can have more than one contact address for each Location.

- If you have additional Management Servers or Log Servers, define two or more contact addresses for each Location. Multiple contact addresses are required so that remote components can connect to a Management Server or a Log Server even if one of the Management Servers or Log Servers fails.
- If you have configured Multi-Link, define two or more contact addresses per Location so that remote components can connect to the servers even if a NetLink goes down.

1. Right-click a server and select Properties.
2. From the Location drop-down menu, select the location to which the server belongs.
3. If necessary, edit the contact addresses.
   - A Default contact address is automatically entered based on the element properties.
   - If the server has multiple Default contact addresses, separate the addresses with commas.
   - If necessary, click Exceptions to define other contact addresses for specific Locations

   **Note:** Elements that belong to the same Location element always use the primary IP address when contacting each other instead of any contact addresses. Elements that do not belong to a specific Location are considered to belong to the Default Location.

4. Click OK.

Set the Management Client location

When there is a NAT device between the Management Client and a Log Server, select the correct Location for your Management Client. Make the selection in the status bar at the bottom of the Management Client window to be able to view logs.

   **Note:** You must select the Management Client Location separately in each administrative Domain if there are multiple Domains in your environment.

For details about product features, usage, and best practices, click Help or press F1.

1. In the Management Client, click the Default Location name in the status bar at the bottom of the window.
2. Select the Location that includes the IP address or network of the computer where you use the Management Client.

Add Management Servers for high availability

You can optionally install one or more additional Management Servers for high availability.

Additional Management Servers control the system if the active Management Server is damaged, loses power, or becomes otherwise unusable. Configuration data is automatically replicated between the Management Servers. Only one Management Server at a time can be used as an active Management Server to configure and manage the system.

To use additional Management Servers, you must have a special Management Server license that lists the IP addresses of all Management Servers within the same SMC.

   **Note:** You must install the license in the Management Client before installing the additional Management Servers. If you do not yet have the license, generate the license at the Forcepoint website after receiving the Proof-of-License, then install the license.
Perform this task for each Management Server that you want to add.

1. Start the installation in one of the following ways:
   - **From a .zip file**: Unzip the file and run setup.exe on Windows or setup.sh on Linux.
   - **From a DVD**: Insert the installation DVD and run the setup executable from the DVD:

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Path to executable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 64-bit</td>
<td>\Forcepoint_SMC_Installer\Windows-x64\setup.exe</td>
</tr>
<tr>
<td>Linux 32-bit</td>
<td>/Forcepoint_SMC_Installer/Linux/setup.sh</td>
</tr>
<tr>
<td>Linux 64-bit</td>
<td>/Forcepoint_SMC_Installer/Linux-x64/setup.sh</td>
</tr>
</tbody>
</table>

   **Note**: If the DVD is not automatically mounted in Linux, mount the DVD with `mount /dev/cdrom /mnt/cdrom`.

2. Proceed according to the instructions in the Installation Wizard until you are prompted to select which components you want to install.

   **Note**: If you install the SMC in C:\Program Files\Forcepoint\Stonesoft Management Center, the installation creates an extra C:\ProgramData\Forcepoint\Stonesoft Management Center folder, which duplicates some of the folders in the installation directory. Some of the program data is also stored in the C:\ProgramData\Forcepoint\Stonesoft Management Center folder.

3. Select the installation type.
   - If you want to install a Log Server and a local Management Client on this computer, leave Typical selected and click Next.
   - If you only want to install a Management Server on this computer, select Custom, select the components you want to install and click Next.

4. Select the IP address of the Management Server from the list or type it in.
   - This address must be the IP address defined for the corresponding Management Server element.
   - The Management Server’s license must be generated using this IP address.

5. Enter the IP address of the Log Server to which the Management Server sends its log data.

6. Select **Install as an Additional Management Server for High Availability**.

7. To make the Management Server start automatically, leave **Install as a Service** selected.

8. Click **Next** and follow the instructions to start the installation.

   A logon prompt for Replication opens.

9. Log on using an unrestricted administrator account.


11. Select the correct Management Server from the list or select **Create a new Management Server** and enter the name of the Management Server element you are creating.

12. Click **OK**.

   The databases are synchronized.

   **Note**: If the synchronization fails, run the `sgOnlineReplication` script on the additional Management Server when connectivity is restored.

You can now use the Management Client to configure the Firewall, IPS, and Layer 2 Firewall elements in the Management Client. The elements must be configured before installing the physical engines.

If NAT is applied to communications between any SMC components, configure NAT addresses for SMC components.
If there is a Firewall or Layer 2 Firewall between the first Management Server you installed and the additional Management Servers, add rules that allow the communications between the servers when you define your Firewall or Layer 2 Firewall Policy.

**Related tasks**
- Install licenses for SMC servers on page 38
  Install the SMC server licenses that you downloaded while preparing for installation.
- Install SMC components on page 28
  You can install the SMC in a user interface in Windows and Linux.

## Distribute Management Clients through Web Start

In addition to installing Management Clients on a local workstation, you can also distribute them through Java Web Start.

Management Clients distributed with Web Start have the same set of features as clients installed on a local workstation. However, when you upgrade, Web Start automatically downloads the new version when the user logs on to the Management Client through a web browser.

There are two ways to configure Web Start access:

- You can activate an internal web server on the Management Server (the server distributes only Web Start Management Clients). There is no need for manual installation or upgrade.
- You can use a separate web server or network drive for distributing the clients. You must install Web Start files manually and reinstall them at each SMC version upgrade.

## Distribute Management Clients from SMC servers

You can configure a Web Start Server to distribute Management Clients from the Management Server. If you have already configured the Web Start Server, you can configure additional settings.

For details about product features, usage, and best practices, click Help or press F1.

1. In the Management Client, select Home.
2. Expand the Servers branch.
4. Click the Web Start tab.
5. Select Enable. The Web Start Server options are enabled.
6. (Optional) Enter the Host Name that the Web Start service uses.
7. (Optional) Enter the TCP port that the service listens to.

   **Tip:** By default, the standard HTTP port 80 is used on Windows and 8080 on Linux. Linux does not allow the use of reserved ports for this type of service.

   **Important:** Make sure that the listening port is not in use on the server.

8. (Optional) If the Management Server has several addresses and you want to restrict access to one address, specify the IP address in the Listen Only on Address field.
9. (Optional) Select Generate Server Logs if you want to log all file load events for further analysis with external web statistics software.
1. Click OK.

Related information
Default communication ports on page 135
There are default ports used in connections between SMC components and default ports that SMC components use with external components.

Distribute Management Clients from a separate server

If you want to use a Web Start Server to distribute Management Clients, but you don't want to use the Management Server as a Web Start Server, you can install the Web Start Server on a separate server.

The Web Start package can also be put on a shared network drive. The path to the Web Start files, including the drive letter, must be the same for all administrators who use that particular version of the installation package. If the network drive paths vary, consider putting the package on a web server instead.

**Important:** You must delete the existing Web Start files and install a new Web Start package according to these instructions each time you upgrade the SMC. Otherwise, any administrators who use Management Clients that are installed through Web Start are not able to log on.

1. On the installation DVD, browse to **Forcepoint_SMC_Installer > Webstart**.

   **CAUTION:** The Web Start installation creates an index.html file in the installation directory. Any existing index.html file is overwritten. We strongly recommend creating a directory for the Web Start files.

2. Copy all files and all directories from the Web Start directory on the installation DVD to the directory where you want the Web Start files to be served.

3. On the command line, change to the directory where the Web Start files are on your server.

4. Run the Web Start setup script and give the URL or the path of the directory where the Web Start files are stored on your server:
   - **Windows:** `cscript webstart_setup.vbs <web start directory>`
   - **Linux:** Run `webstart_setup.sh <web start directory>`

<table>
<thead>
<tr>
<th>Installation on</th>
<th>Example Web Start directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web server</td>
<td><a href="http://www.example.com/webstart/">http://www.example.com/webstart/</a></td>
</tr>
<tr>
<td>Network drive</td>
<td>file://localhost/c:/webstart/</td>
</tr>
</tbody>
</table>

5. If necessary, change the configuration of the web server to return the appropriate MIME type for .jnlp files (application/x-java-jnlp-file).
   See the manual of your web server for instructions on how to configure the MIME type.

6. Delete the webstart_setup.vbs and webstart_setup.sh files from the directory.
Stonesoft NGFW engine deployment

Stonesoft NGFW engine deployment consists of adding and configuring engine elements in the SMC, and configuring the Stonesoft NGFW software on the engine.
Configuring Stonesoft NGFW for the Firewall/VPN role

Configuring engine elements in the SMC prepares the SMC to manage Stonesoft NGFW engines in the Firewall/VPN role.

Install licenses for Stonesoft NGFW engines

Install the Stonesoft NGFW engine licenses that you downloaded while preparing for installation. The license files must be available to the computer that you use to run the Management Client. You can install all licenses at the same time even though you have not yet created all elements that the licenses are bound to.

For details about product features, usage, and best practices, click Help or press F1.

1. In the Management Client, select Menu > File > System Tools > Install Licenses.
2. Select one or more license files to install in the dialog box that opens and click Install.
3. Check that licenses were installed correctly.
   1. Select Menu > Configuration > Administration.
   2. Expand the Licenses branch of the tree.
   3. Select All Licenses in the list.

One license shows for each Stonesoft NGFW engine node. You must bind POL-bound engine licenses manually to the correct engines after you have configured the engine elements. POS-bound engine licenses are automatically attached to the correct engines after the engine is fully installed.

You are ready to define the engine elements.

Related concepts

Types of licenses for Stonesoft NGFW engines on page 21
Each Stonesoft NGFW engine node must have its own license.

Configuring Single Firewalls on page 49
After you have the SMC installed and running, you can configure the Single Firewall elements.

Configuring Firewall Clusters on page 61
After you have the SMC installed and running, you can configure the Firewall Cluster elements.

Configuring Single Firewalls

After you have the SMC installed and running, you can configure the Single Firewall elements.

Little configuration is done directly on the engines. Most of the configuration is done using the Management Client. The engines cannot be successfully installed before defining them in the Management Client.

The tasks you must complete are as follows:

1. Add Single Firewall elements.
2. Add interfaces and define their properties.
3. (Optional) Select system communication roles for the interfaces.
4. Bind Management Server POL-bound licenses to specific Single Firewall elements.
## Types of interfaces for Single Firewalls

Interface numbers identify the interfaces for a Single Firewall element.

You can configure the following types of interfaces on Single Firewalls:

### Table 2: Interface types for Single Firewalls

<table>
<thead>
<tr>
<th>Interface type</th>
<th>Description</th>
<th>SMC numbering</th>
</tr>
</thead>
<tbody>
<tr>
<td>Physical interface</td>
<td>Represents an Ethernet port of a network interface card on the engine.</td>
<td>Each physical interface has a unique interface ID number in the SMC.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip:</strong> You can add VLAN interfaces to physical interfaces to divide a single physical network link into several virtual links.</td>
<td></td>
</tr>
<tr>
<td>ADSL interface</td>
<td>Represents the ADSL port of a purpose-built Stonesoft NGFW appliance.</td>
<td>Each ADSL interface has a unique interface ID number in the SMC.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Only certain Stonesoft NGFW appliances have an integrated ADSL network interface card with an ADSL port.</td>
<td></td>
</tr>
<tr>
<td>Wireless interface</td>
<td>Represents a wireless network interface card of a purpose-built Stonesoft NGFW appliance.</td>
<td>The wireless interface has a unique interface ID number in the SMC.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Only certain Stonesoft NGFW appliances have an integrated wireless network interface card.</td>
<td></td>
</tr>
<tr>
<td>Modem interface</td>
<td>Represents a 3G modem connected to a USB port on a purpose-built Stonesoft NGFW appliance.</td>
<td>Modem Interfaces are identified with modem numbers in the SMC.</td>
</tr>
<tr>
<td></td>
<td>The modem number is mapped to the modem's IMEI (international mobile equipment identity) number.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Each modem is assigned a unique ID when you connect the modem to the Single Firewall engine.</td>
<td></td>
</tr>
<tr>
<td>Tunnel interface</td>
<td>A logical interface that is used as an endpoint for tunnels in the Route-Based VPN.</td>
<td>Tunnel interfaces are numbered with tunnel interface ID numbers. The tunnel interface IDs are automatically mapped to the</td>
</tr>
</tbody>
</table>
### Add Single Firewall elements

To add a single-node firewall to the SMC, add a Single Firewall element that stores the configuration information related to the firewall.

**Note:** You can also define several Single Firewall elements at the same time by using the Create Multiple Single Firewalls wizard. For more information about creating several Single Firewall elements at the same time, see the Stonesoft Next Generation Firewall Product Guide.

For details about product features, usage, and best practices, click Help or press F1.

1. Select ➤ Configuration.
2. Right-click Security Engines and select New > Firewall > Single Firewall.
   - The Engine Editor opens.
3. In the Name field, enter a unique name.
4. From the Log Server drop-down list, select the Log Server for storing this firewall’s logs.
5. (Optional) In the DNS IP Addresses list, add one or more DNS IP addresses.

   These addresses are the IP addresses of the DNS servers that the Single Firewall uses to resolve malware signature mirrors, domain names, and web filtering categorization services. There are two ways to define IP addresses:

<table>
<thead>
<tr>
<th>Interface type</th>
<th>Description</th>
<th>SMC numbering</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integrated switch</td>
<td>Represents the switch functionality on a purpose-built Stonesoft NGFW appliance.</td>
<td>Integrated switches are identified with IDs in the SMC. You can add port group interfaces to switches. Port group interfaces are identified by port group IDs.</td>
</tr>
</tbody>
</table>

The modem numbers, switch IDs, and interface IDs are mapped to the corresponding network interfaces on the engine when you configure the Stonesoft NGFW engine software. Check the correct interface numbers in the Hardware Guide for your appliance model.

**Note:** If you configure the engine automatically with a USB drive, the interface IDs in the SMC are mapped to match the interface numbering in the operating system. For example, eth0 is mapped to Interface ID 0.

If necessary, you can change the interface ID, switch ID, and modem number mapping after the initial configuration using the command-line tools on the engine.
To enter a single IP address manually, click Add and select IP Address. Enter the IP address in the dialog that opens.

To define an IP address by using a network element, click Add and select Network Element. Select a Host or External DNS Server element from the dialog box that opens. Alternatively, click the New icon and select Host or External DNS Server to define a new element.

6. From the Location drop-down list, select the Location to which the firewall belongs.

7. (Optional) If you have a Stonesoft NGFW appliance, copy and paste the proof-of-serial (POS) code delivered with the appliance to the Proof of Serial field.

Using the POS code allows you to configure the Single Firewall engine using plug and play configuration.

8. Click Save.

Do not close the Engine Editor.

Related tasks
Prepare for plug-and-play configuration on page 105
To use plug-and-play-configuration, save the initial configuration and upload it to the Installation Server.

Add physical interfaces to Single Firewalls

To route traffic through the firewall, you must define at least two physical interfaces.

Note: Only the interface that is used for communications between the Management Server and the Firewall/VPN engine is required when you install the Single Firewall. Although you can configure more interfaces at any time, it is recommended to add more interfaces right away.

There are three types of physical interfaces:

- An interface that corresponds to a single network interface on the firewall engine. In the Management Client, the interface type is None.
- An aggregated link in high availability mode represents two interfaces on the firewall engine. Only the first interface in the aggregated link is actively used. The second interface becomes active only if the first interface fails.
  
  Connect the first interface in the link to one external switch and the second interface to another external switch.
- An aggregated link in load balancing mode represents two or more interfaces (up to eight interfaces) on the firewall engine. All interfaces in the aggregated link are actively used and connections are automatically balanced between the interfaces.

Link aggregation in load-balancing mode is implemented based on the IEEE 802.3ad Link Aggregation standard. Connect all interfaces to a single external switch. Make sure that the switch supports the Link Aggregation Control Protocol (LACP) and that LACP is configured on the switch.

1. In the navigation pane on the left, select Interfaces.
2. Right-click the empty space and select New > Physical Interface.
3. From the Interface ID drop-down list, select an ID number.
   
   This ID maps to a network interface during the initial configuration of the engine.
4. From the Type drop-down list, select the interface type.
5. If the type is aggregated link, select one or more other interfaces that belong to the aggregated link.
   
   - For an aggregated link in high availability mode, select an interface ID from the Second Interface ID drop-down list.
   - For an aggregated link in load balancing mode, click Add to add one or more interface IDs to the Additional Interface(s) list.
6. Click OK.
7. Click Save.

Do not close the Engine Editor.
The physical interface is added to the interface list.

**Add VLAN interfaces to Single Firewalls**

VLANs divide a single physical network link into several virtual links.

You can add up to 4094 VLANS to each physical interface.

1. In the navigation pane on the left, select Interfaces.
2. Right-click a physical interface and select New > VLAN Interface.
3. In the VLAN ID field, enter a VLAN ID number (1-4094).

   **Note:** The VLAN ID must be the same VLAN ID used in the external switch at the other end of the VLAN trunk.

4. Click OK.
   The specified VLAN ID is added to the physical interface.
5. Click Save.
   Do not close the Engine Editor.

The VLAN interface is now ready to be used as a network interface. The VLAN interface is identified as Interface-ID.VLAN-ID, for example 2.100 for interface ID 2 and VLAN ID 100.

**Add ADSL Interfaces to Single Firewalls**

You can add one ADSL interface to a Single Firewall.

ADSL is only supported on specific Stonesoft NGFW appliances that have an ADSL network interface card. The supported ADSL standards are ANSI T1.413 issue 2n, G.dmt, G.lite, ADSL2 DMT, ADSL2 G.lite, Annex A, and Annex B.

For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, select Interfaces.
2. Right-click the empty space and select New > ADSL Interface.
3. From the Interface ID drop-down list, select the number of the ADSL port on the appliance as the Interface ID.
   The Interface ID is automatically mapped to the ADSL port on the engine’s ADSL card during the initial configuration of the engine.
4. In the VCI field, enter the VCI (Virtual Channel Identifier) value according to the configuration information provided by your ISP.
5. In the VPI field, enter the VPI (Virtual Path Identifier) value according to the configuration information provided by your ISP.
6. From the Multiplexing Mode drop-down list, select LLC (Logical Link Control) or VC (Virtual Circuit) according to the configuration information provided by your ISP.
7. Define the ADSL Interface properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface ID</td>
<td>Select the number of the ADSL port on the appliance as the Interface ID. The Interface ID is automatically mapped to the ADSL port on the engine’s ADSL card during the initial configuration of the engine.</td>
</tr>
<tr>
<td>VCI</td>
<td>Enter the VCI (Virtual Channel Identifier) value according to the configuration information provided by your ISP.</td>
</tr>
</tbody>
</table>
### Add wireless interfaces to Single Firewalls

You can add one wireless interface to a Single Firewall.

Wireless interfaces are only supported on specific Stonesoft NGFW appliances that have an integrated wireless network interface card.

For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, select Interfaces.
2. Right-click the empty space and select New > Wireless Interface.
3. From the Interface ID drop-down list, select the interface ID number.
   
   This ID number maps to the wireless port during the initial configuration of the engine.
4. In the Country field, enter or select the country where the firewall is used as a wireless access point.
5. From the Band drop-down list, select the band for the wireless interface access point.
6. From the Wireless Mode drop-down list, select the mode for transmitting the wireless traffic according to the capabilities of the connecting clients.
   
   The wireless mode options that you can select depend on the band.

<table>
<thead>
<tr>
<th>Band</th>
<th>Wireless mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.4 GHz</td>
<td>802.11b</td>
</tr>
<tr>
<td></td>
<td>802.11bg</td>
</tr>
<tr>
<td></td>
<td>802.11g</td>
</tr>
<tr>
<td></td>
<td>802.11n</td>
</tr>
<tr>
<td></td>
<td>802.11bgn</td>
</tr>
<tr>
<td>5 GHz</td>
<td>802.11a</td>
</tr>
<tr>
<td></td>
<td>802.11an</td>
</tr>
<tr>
<td></td>
<td>802.11n</td>
</tr>
<tr>
<td></td>
<td>802.11ac</td>
</tr>
<tr>
<td></td>
<td>802.11acn</td>
</tr>
</tbody>
</table>

**Note:** Some wireless clients do not support the 802.11n, 802.11ac, and 802.11acn wireless modes with the WEP security mode.

7. From the Channel drop-down list, select the channel for transmitting the wireless traffic.
If there are other wireless access points nearby, use channels that are as far apart as possible to avoid interference. Stonesoft Management Center might sometimes select another channel to use the best frequency available. If you select Automatic, the best channel is automatically selected.

8. (Optional) From the Width drop-down list, select the width of the channel. This option is only available if the Wireless Mode is one of the following: 802.11n, 802.11bgn, 802.11an, 802.11n, 802.11ac, or 802.11acn.

9. (Optional) From the Transmit Power drop-down list, select the maximum power of the signal for transmitting the wireless traffic.
   - The power options are shown as milliwatts (mW) and as the power ratio in decibels of the measured power referenced to 1 milliwatt (dBm).
   - The values available depend on the regulatory limits for the selected country and the channel for the wireless interface.
   - If you are not sure what value to use, leave the default value selected.

10. Click OK.
    The wireless interface is added to the interface list.

11. Click Save.
    Do not close the Engine Editor.

Add SSID Interfaces to Single Firewalls

A service set identifier (SSID) interface represents an 802.11 wireless LAN.

You can add several SSID Interfaces to the Wireless Interface.

1. In the navigation pane on the left, select Interfaces.
2. Right-click the wireless interface and select New SSID Interface.
3. In the Wireless Network Name (SSID) field, enter the wireless network name. It identifies the network to the end users.
4. From the Wireless SSID Broadcast drop-down list, select one of the following options:
   - Enabled — The wireless network name is broadcast to anyone in range.
   - Disabled — Users must type the name to connect.
5. From the MAC Address Type drop-down list, select one of the following options:
   - Hardware — The first SSID Interface that you define is automatically assigned the MAC address of the wireless card.
   - Custom — A custom MAC address.
6. (Custom MAC address only) In the MAC Address field, enter a MAC address.
7. Click the Security tab.
8. From the Security Mode drop-down list, select the security mode.
9. Fill in the options for the selected security mode:

   **Table 3:**

<table>
<thead>
<tr>
<th>Mode</th>
<th>Steps</th>
</tr>
</thead>
</table>
   | WEP Open System or WEP Shared Key | 1. From the Key Length drop-down list, select the key length.  
   2. From the Default Key drop-down list, select which key is used by default.  
   3. Enter 1–4 encryption keys. |
   | WPA Personal                  | 1. From the WPA Mode drop-down list, select the WPA mode.            |

Tip: When you select the security mode, the options particular for that mode are enabled. We recommend using one of the WPA security modes.
### Add Switches to Single Firewalls

You can add one integrated switch to a Single Firewall.

An integrated switch eliminates the need for an external switch device and simplifies port and network segment configuration.

The switch functionality is only supported on Single Firewall engines that run on specific Stonesoft NGFW appliances that have an integrated switch.

For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, select Interfaces.
2. Right-click the empty space and select New > Switch.
3. From the Switch ID drop-down list, select the ID according to your switch type. For example, the switch ID of the Stonesoft NGFW 110 appliance is 0. See the Hardware Guide for your appliance for more information.
4. From the Switch Type drop-down list, select the type of your Stonesoft NGFW switch.
5. Click OK.
6. Click Save.

Do not close the Engine Editor.

You are now ready to add port group interfaces to the switch.

### Add Port Group Interfaces to Single Firewalls

You can define one or more port groups interfaces for an integrated switch. Port groups provide a flexible way to group and configure ports and network segments.

For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, select Interfaces.
2. Right-click the switch and select New Port Group Interface.
3. Define the port group interface properties.
4. Click OK.

The port group interface is added to the interface list. The defined switches and port group interfaces are displayed, for example, as “0.1” for switch ID 0 with port group 1.

5. Click Save.

Do not close the Engine Editor.
Add IP addresses for Single Firewall interfaces

You can add one or more IP addresses to each interface on a Single Firewall. The number and types of IP addresses that you can add depend on the interface type.

Table 4: IP addresses for each interface type

<table>
<thead>
<tr>
<th>Interface type</th>
<th>Static IPv4 addresses</th>
<th>Dynamic IPv4 Addresses</th>
<th>Static IPv6 Addresses</th>
<th>Dynamic IPv6 Addresses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Physical interface</td>
<td>One or more</td>
<td>One</td>
<td>One or more</td>
<td>One</td>
</tr>
<tr>
<td>VLAN interface</td>
<td>One or more</td>
<td>One</td>
<td>One or more</td>
<td>One</td>
</tr>
<tr>
<td>ADSL interface</td>
<td>One or more</td>
<td>One</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Port group interface</td>
<td>One or more</td>
<td>One</td>
<td>One or more</td>
<td>One</td>
</tr>
<tr>
<td>SSID interface</td>
<td>One</td>
<td>None</td>
<td>One</td>
<td>None</td>
</tr>
</tbody>
</table>

Add static IPv4 addresses to Single Firewall interfaces

Depending on the type of interface, you can add one or more static IPv4 addresses to Single Firewall interfaces. For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, select Interfaces.
2. Add an IPv4 address in one of the following ways:
   - Right-click a physical interface, VLAN interface, SSID interface, or port group interface and select New IPv4 Address.
   - Right-click an ADSL interface and select New IPv4 Address.
3. In the IPv4 Address field, enter the IPv4 address.
4. In the Netmask field, adjust the automatically added netmask if necessary. The Network Address and Broadcast IP address are updated accordingly.
5. If the interface is used for system communications and NAT is applied, add contact addresses.
   1. Enter the default contact address in one of the following ways:
      - In the Default field, enter the contact address.
      - Select Dynamic and define the translated IP address of this component.
   2. If components from some locations must use a different IP address for contact, click Exceptions and define the location-specific addresses.
6. If you want to use Virtual Router Redundancy Protocol (VRRP), add a virtual router.

   **Note:** One virtual router can be configured for each physical interface, VLAN interface, or port group interface. Although VRRP support is also available, for port group interfaces, it is not normally used.

   1. Click VRRP Settings.
   2. Select Enable VRRP.
   3. Fill in the ID, Priority, and IPv4 Address fields according to the configuration of the virtual router.
   4. Click OK.
7. Click OK.
The IPv4 address is added to the interface.

8. Click Save

If you plan to add more IP addresses or modem interfaces, do not close the Engine Editor.

Add static IPv6 addresses to Single Firewall interfaces

Depending on the type of interface, you can add one or more static IPv6 addresses to Single Firewall interfaces.

For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, select Interfaces.
2. Right-click a physical, VLAN, SSID, or port group interface and select New > IPv6 Address.
3. In the IPv6 Address field, enter the IPv6 address.
4. Enter the Prefix Length (0–128).
5. Click OK.
6. Click Save.

If you plan to add more IP addresses or modem interfaces, do not close the Engine Editor.

Add dynamic IPv4 addresses to Single Firewall interfaces

You can configure dynamic IPv4 addresses for physical, VLAN, ADSL, and port group interfaces on Single Firewalls.

You can identify interfaces that have a dynamic IPv4 address using a DHCP Index. A modem interface always has a dynamic IP address.

For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, select Interfaces.
2. Add an IPv4 address in one of the following ways:
   • Right-click a physical interface, VLAN, or port group interface and select New > IPv4 Address.
   • Right-click an ADSL interface and select New IPv4 Address.
3. In the IP Address Properties dialog box, select Dynamic.
4. From the Dynamic Index drop-down list, select a DHCP index.
   The index is used for identification in other parts of the configuration (such as Firewall Policies) to represent the possibly changing IP address.
5. If the interface is used for system communications and NAT is applied, add contact addresses.
   1. If the default contact address is not dynamic, deselect Dynamic and enter the static contact address.
   2. If components from some locations must use a different IP address for contact, click Exceptions and define the location-specific addresses.
6. If the interface’s dynamic IP address is assigned through PPPoA or PPPoE, set up PPP.
   1. Click PPP Settings.
   2. From the Mode drop-down list, select the mode that the ADSL modem connected to the interface supports.
      PPPoE can be used with physical interfaces, ADSL interfaces, or port group interfaces. PPPoA can be used with ADSL interfaces only.
   3. Fill in the User Name, Password, and (optional) Service Name fields according to the information provided by your service provider.
      If you do not have this information, contact your service provider.

   Tip: Select Hide to hide the input password characters.
4. Click OK.
7. Click OK.
   The dynamic IPv4 address is added to the interface.
8. Click Save.
Add dynamic IPv6 addresses to Single Firewall interfaces

You can add dynamic IPv6 addresses to physical interfaces, VLAN interfaces, and port group interfaces on Single Firewalls.

You can identify interfaces that have a dynamic IPv6 address using a DHCP Index.

For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, select Interfaces.
2. Right-click a physical interface and select New > IPv6 Address.
3. In the IP Address Properties dialog box, select Dynamic.
4. From the Dynamic Index drop-down list, select a DHCP index.
   The index is used for identification in other parts of the configuration (such as IPS Policies) to represent the possibly changing IP address.
5. If the interface is used for system communications and NAT is applied, add contact addresses.
   1. Enter the default contact address in one of the following ways:
      • In the Default field, enter the contact address.
      • Select Dynamic and define the translated IP address of this component.
   2. If components from some locations must use a different IP address for contact, click Exceptions and define the location-specific addresses.
6. (Optional) If you do not want a default route to be automatically created through the interface, deselect Automatic Default Route.
7. (Optional) If you want to use DHCPv6 to get the IPv6 address, select Use DHCPv6 to get IPv6 Address.
8. Click OK.
   The IP address is added to the interface.
9. Click Save.
   If you plan to add more IP addresses or modem interfaces, do not close the Engine Editor.

Add Modem Interfaces to Single Firewalls

You can use 3G modems with Single Firewalls to provide wireless links for outbound connections.

Two active 3G modems are supported on Stonesoft NGFW appliances.

For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, select Interfaces.
2. Right-click the empty space and select New > Modem Interface.
3. In the Modem Number field, select the modem number that is mapped to the modem's IMEI (international mobile equipment identity) number.
4. In the DHCP index field, select the DHCP index number.
   It is used to distinguish different DHCP interfaces from one another.
5. In the PIN field, enter the PIN code if it is needed for the modem's SIM card.
6. In the Phone Number field, enter the modem's phone number if it differs from the default phone number.
7. Fill in the Access Point Name, Username, Password, Service Name, and Zone fields according to the instructions that you have received from your service provider.
8. Click OK.
   The Modem Interface is added to the interface list.
9. Click Save.
   If you plan to add more interfaces or change the roles that interfaces have in system communications, do not close the Engine Editor.
Select system communication roles for Single Firewall interfaces

Select which IP addresses are used for particular roles in system communications.

For example, you can select which IP addresses are used in communications between the Firewall and the Management Server.

The interfaces you have defined are shown as a tree-table on the Interfaces tab. Global interface options have codes in the tree-table.

Table 5: Interface option codes

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>The interface that has the IP address used as the identity for authentication requests.</td>
</tr>
<tr>
<td>C</td>
<td>The interfaces that have the primary and backup control IP addresses.</td>
</tr>
<tr>
<td>O</td>
<td>The default IP address for outgoing connections.</td>
</tr>
</tbody>
</table>

For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, select Interfaces > Interface Options.
2. Select the interface options.
   1. From the Primary drop-down list, select the primary control IP address for Management Server contact.
   2. (Optional, recommended) From the Backup drop-down list, select a backup control IP address for Management Server contact (used if the primary fails).
   3. If the control IP address for Management Server contact is a dynamic IP address, select Node-initiated contact to Management Server.
      When this option is selected, the engine opens a connection to the Management Server and maintains connectivity.
   4. From the Identity for Authentication Requests drop-down list, select the IP address that identifies the firewall to external authentication servers.

   Note: This selection has no effect on routing.

5. (Optional) From the Source for Authentication Requests drop-down list, select the IP address that identifies the firewall when it sends an authentication request to an external authentication server over a VPN.

   Note: This selection has no effect on routing.

6. From the Default IP Address for Outgoing Traffic drop-down list, select the IP address that nodes use if they have to initiate connections through an interface that has no Node Dedicated IP address.

3. Click Save, then close the Engine Editor.

You are now ready to bind engine licenses to the Single Firewall elements.

Related concepts
Options for initial configuration on page 104
You can configure the Stonesoft NGFW engine software using plug-and-play configuration, automatic configuration, or the NGFW Configuration Wizard.

**Bind engine licenses to Single Firewall elements**

After you have configured the Single Firewall elements, you must manually bind Management Server POL-bound licenses to specific Single Firewall elements.

Licenses are created based on the Management Server’s proof-of-license (POL) code or based on the appliance’s proof-of-serial (POS) code. POS-bound appliance licenses are automatically bound to the correct Firewall element when the engine is fully installed.

For details about product features, usage, and best practices, click Help or press F1.

1. Select Menu > Configuration > Administration.
2. Browse to Licenses > Engine or Licenses > Firewall depending on the type of licenses you have. All installed licenses appear in the right pane.
3. Right-click a Management Server POL-bound license and select Bind.
4. Select the Firewall element and click Select. The license is now bound to the selected Firewall element.

**Tip:** If you bound the license to an incorrect element, right-click the license and select Unbind.

**CAUTION:** When you install or refresh the policy on the engine, the license is permanently bound to that engine. Permanently bound licenses can't be rebound to another engine without relicensing or deleting the engine element the license is bound to. Until you do that, the unbound license is shown as Retained.

You are now ready to transfer the configuration to the Firewall engines.

**Related concepts**

Options for initial configuration on page 104

You can configure the Stonesoft NGFW engine software using plug-and-play configuration, automatic configuration, or the NGFW Configuration Wizard.

**Configuring Firewall Clusters**

After you have the SMC installed and running, you can configure the Firewall Cluster elements.

Little configuration is done directly on the engines. Most of the configuration is done using the Management Client. The engines cannot be successfully installed before defining them in the Management Client.

The tasks you must complete are as follows:

1. Add Firewall Cluster elements.
2. Add the necessary number of nodes to the Firewall Cluster.
3. Add interfaces and define their properties.
4. (Optional) Select system communication roles for the interfaces.
5. Bind Management Server POL-bound licenses to specific nodes in the Firewall Cluster.
Types of interfaces for Firewall Clusters

Interface numbers identify the interfaces for a Firewall Cluster element.

There are two types of interfaces on Firewall Clusters:

- **A physical interface** represents an Ethernet port of a network interface card on the engine.
  - Each physical interface has a unique *interface ID* number in the SMC.
  - You can add *VLAN interfaces* to physical interfaces to divide a single physical network link into several virtual links.
- **A tunnel interface** is a logical interface that is used as an endpoint for tunnels in the Route-Based VPN.
  - Tunnel interfaces are numbered with *tunnel interface ID* numbers. The tunnel interface IDs are automatically mapped to the network interfaces on the engine according to the routing configuration.
  - For detailed information about configuring tunnel interfaces and the Route-Based VPN, see the *Stonesoft Next Generation Firewall Product Guide*.

The interface IDs are mapped to the corresponding network interfaces on the engine when you configure the Stonesoft NGFW engine software. Check the correct interface numbers in the *Hardware Guide* for your appliance model.

**Note:** If you configure the engine automatically with a USB drive, the interface IDs in the SMC are mapped to match the interface numbering in the operating system. For example, eth0 is mapped to Interface ID 0.

If necessary, you can change the interface ID and modem number mapping after the initial configuration using the command-line tools on the engine.

Operating modes for Firewall Cluster interfaces

There are several operating modes for the physical interfaces of a Firewall Cluster. Packet dispatch mode is recommended for new installations.

The other modes are provided for backward compatibility. See the *Stonesoft Next Generation Firewall Product Guide* for more information about the other operating modes.

In packet dispatch mode:

- There is only one contact MAC address for each physical interface. The dispatcher node controls this MAC address.
- The dispatcher node forwards the packets to the other nodes for processing. Any node in the cluster can process the traffic.
- The dispatcher node is chosen separately for each physical interface.

**Note:** Different nodes might be selected as dispatcher nodes for different physical interfaces.

The packet dispatcher for the physical interface changes automatically if the dispatcher goes offline. When the dispatcher changes:

- The packet dispatcher MAC address is moved to another firewall node.
- The firewall sends an ARP message to the external switch or router.
- The switch or router updates its address table.

**Note:** This process is a standard network addressing operation where the switch or router learns that the MAC address is located behind a different port.

- The switch or router forwards traffic destined to the physical interface to this new packet dispatcher.
Add Firewall Cluster elements

To introduce a new Firewall Cluster to the SMC, you must define a Firewall Cluster element that stores the configuration information related to the Firewalls.

For details about product features, usage, and best practices, click Help or press F1.

1. Select Configuration.
2. Right-click Security Engines and select New > Firewall > Firewall Cluster.
   The Engine Editor opens.
3. In the Name field, enter a unique name.
4. From the Log Server drop-down list, select the Log Server for storing this Firewall Cluster’s logs.
5. (Optional) In the DNS IP Addresses list, add one or more DNS IP addresses.
   These addresses are the IP addresses of the DNS servers that the Firewall Cluster uses to resolve malware signature mirrors, domain names, and web filtering categorization services. There are two ways to define IP addresses:
   • To enter a single IP address manually, click Add and select Add IP Address. Enter the IP address in the dialog that opens.
   • To define an IP address by using a network element, click Add and select Add Network Element.
6. From the Location drop-down list, select the Location to which the firewall belongs.
7. Click Save.
   Do not close the Engine Editor.

Add nodes to Firewall Clusters

The Firewall Cluster element has two nodes when the element is created.

Firewall Clusters can have up to 16 nodes. Add all nodes you plan to install before you begin configuring the interfaces.

For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, select General > Clustering.
2. (Optional) In the Name field, change the name.
3. Click OK.
   The node is added to the Firewall Cluster.
4. Click Save.
   Do not close the Engine Editor.

Add physical interfaces to Firewall Clusters

To route traffic through the Firewall Cluster, you must define at least two physical interfaces.

We recommend defining at least two interfaces for the Firewall Cluster:

• An interface used for communications between the Management Server and the Firewall/VPN engine.
• An interface for the heartbeat communications between the cluster nodes. The heartbeat traffic is critical to the functioning of the cluster, so it is highly recommended to have a dedicated heartbeat interface.

Although you can configure more interfaces at any later time, it is simplest to add more interfaces right away. This action allows traffic to be routed through the Firewall. You can use the Cluster installation worksheet to document the interfaces.

There are three types of physical interfaces on Firewall Clusters:
• An interface that corresponds to a single network interface on each node in the Firewall Cluster. In the Management Client, the interface type is None.

• An aggregated link in high availability mode represents two interfaces on each node. Only the first interface in the aggregated link is actively used. The second interface becomes active only if the first interface fails. Connect the first interface in the link to one external switch and the second interface to another external switch.

• An aggregated link in load balancing mode represents two or more interfaces (up to eight interfaces) on each node. All interfaces in the aggregated link are actively used and connections are automatically balanced between the interfaces.

Link aggregation in load-balancing mode is implemented based on the IEEE 802.3ad Link Aggregation standard. Connect all interfaces to a single external switch. Make sure that the switch supports the Link Aggregation Control Protocol (LACP) and that LACP is configured on the switch.

For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, select Interfaces.

2. Right-click the empty space and select New Physical Interface.

3. From the Interface ID drop-down list, select an interface ID number. This ID maps to a network interface during the initial configuration of the engine.

4. From the Type drop-down list, select the interface type.

5. If the type is Aggregated Link, select one or more other interfaces that belong to the aggregated link.

   • For an aggregated link in high availability mode, select an interface ID from the Second Interface ID drop-down list.

   • For an aggregated link in load balancing mode, click Add to add one or more interface IDs to the Additional Interface(s) list.

6. Leave Packet Dispatch selected as the CVI Mode and add a MAC Address with an even number as the first octet.

   **Important:** This MAC address must not belong to any actual network card on any of the nodes.

• Packet Dispatch is the primary clustering mode in new installations.

• Different CVI modes can be used for different interfaces of a Firewall Cluster without limitations.

   **Note:** All CVI addresses that are defined for the same physical interface must use the same unicast MAC address. The dispatcher nodes use the MAC address you define here. Other nodes use their network card’s MAC address.

7. (Optional) In the MTU field, enter the MTU value if this link requires a lower MTU than the Ethernet-default 1500.

8. Click OK.

9. Click Save.

   Do not close the Engine Editor.

---

**Add VLAN Interfaces to Firewall Clusters**

VLANs divide a single physical network link into several virtual links.

You can add up to 4094 VLANs to each physical interface.

For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, select Interfaces.

2. Right-click a physical interface and select New > VLAN Interface.

3. In the VLAN ID field, enter a VLAN ID number (1-4094).
4. Click OK.
The specified VLAN ID is added to the physical interface.

5. Click Save.
Do not close the Engine Editor.

The VLAN interface is now ready to be used as a network interface. The VLAN interface is identified as Interface-ID.VLAN-ID, for example 2.100 for interface ID 2 and VLAN ID 100.

Add IP addresses for Firewall Cluster interfaces

To route traffic through the firewall, each Firewall Cluster interface must have at least two IP addresses. Firewall Clusters can have two types of IP addresses.

Table 6: Types of IP addresses for Firewall Clusters

<table>
<thead>
<tr>
<th>Interface type</th>
<th>Description</th>
<th>When to use it</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster Virtual IP address (CVI)</td>
<td>An IP address that is used to handle traffic routed through the cluster for inspection. All nodes in a cluster share this IP address. Allows other devices to communicate with the Firewall Cluster as a single entity.</td>
<td>Define a CVI for the interface if traffic that the firewall inspects is routed to or from the interface.</td>
</tr>
<tr>
<td>Node Dedicated IP address (NDI)</td>
<td>An IP address that is used for traffic to or from an individual node in a cluster. Each node in the cluster has a specific IP address that is used as the NDI. Used for the heartbeat connections between the engines in a cluster, for control connections from the Management Server, and other traffic to or from individual nodes.</td>
<td>Define at least two NDIs: one for management connections and one for the heartbeat traffic between the nodes. We recommend that you define an NDI for each interface that has a CVI, if practical. Some features might not work reliably without an NDI.</td>
</tr>
</tbody>
</table>

You can define several CVIs and NDIs on the same physical interface or VLAN interface. A physical interface or a VLAN interface can have only a CVI or only an NDI.

IPv6 addresses are supported on Firewall Clusters with dispatch clustering mode. IPv6 and IPv4 addresses can be used together on the same Firewall Cluster.

Add IPv4 addresses to Firewall Cluster interfaces

Add an IPv4 address to a Firewall Cluster interface.

For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, select Interfaces.
2. Right-click a physical interface or VLAN interface and select New > IPv4 Address.
3. Select the types of IP addresses that you want to add using the Cluster Virtual IP Address and Node Dedicated IP Address options.
By default, both are selected. If the interface does not receive or send traffic that the Firewall examines, there is no need to define a Cluster Virtual IP address (CVI). We recommend adding a Node Dedicated IP address (NDI) for each network or subnetwork that is located behind the physical interface.

4. To add a CVI, enter the IP address in the IPv4 Address field in the Cluster Virtual IP Address section.

5. If the CVI is used for system communications and NAT is applied, define a contact address for the CVI.
   1. Enter the default contact address in one of the following ways:
      • In the Default field, enter the contact address.
      • Select Dynamic and define the translated IP address of this component.
   2. If components from some locations must use a different IP address for contact, click Exceptions and define the location-specific addresses.

6. To add NDIs for the nodes, enter the IP address in the IPv4 Address field for each node in the Node Dedicated IP Address table.

7. If the NDIs are used for system communications and NAT is applied, define a contact address for the NDIs.
   1. Double-click the node’s Contact Address cell.
   2. In the Default field, enter the contact address.
   3. (Optional) If components from some locations must use a different IP address for contact, click Add and define the location-specific addresses.
   4. Click OK.

8. (Optional) In the Netmask field, change the automatically added netmask if necessary.

9. Click OK.
   The IPv4 addresses are added to the interface.

10. Click Save.
    If you plan to add more IP addresses, or change the roles that interfaces have in system communications, do not close the Engine Editor.

**Add IPv6 addresses to Firewall Cluster interfaces**

Add an IPv6 address for a Firewall Cluster interface.

For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, select Interfaces.
2. Right-click a physical interface or a VLAN interface and select New > IPv6 Address.
3. Select the types of IP addresses that you want to add using the Cluster Virtual IP Address and Node Dedicated IP Address options.
   By default, both are selected.
   • If the interface does not receive or send traffic that the firewall examines, there is no need to define a Cluster Virtual IP address.
   • We recommend that you add a Node Dedicated IP address for each (sub)network that is located behind the Physical Interface.
4. If you are adding a Cluster Virtual IP address, in the IPv6 Address field, enter the IP address that is used as the Cluster Virtual IP address.
5. If you are adding a Node Dedicated IP address for the nodes, double-click the IPv6 Address cell for each node and enter the IP address.
6. (Optional) In the Prefix Length field, change the automatically filled in prefix length (0-128).
7. Click OK.
8. Click Save.
   If you plan to add more IP addresses, or change the roles that interfaces have in system communications, do not close the Engine Editor.
Select system communication roles for Firewall Cluster interfaces

Select which IP addresses are used for particular roles in system communications.

For example, you can select which IP addresses are used in communications between the Firewall Cluster and the Management Server.

The interfaces you have defined are shown as a tree-table on the Interfaces tab. Global interface options have codes in the tree-table.

### Table 7: Interface option codes

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>The interface that has the IP address used as the identity for authentication requests.</td>
</tr>
<tr>
<td>C</td>
<td>The interfaces that have the primary and backup control IP addresses.</td>
</tr>
<tr>
<td>H</td>
<td>The primary and backup heartbeat Interfaces.</td>
</tr>
<tr>
<td>O</td>
<td>The default IP address for outgoing connections.</td>
</tr>
</tbody>
</table>

For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, select Interfaces > Interface Options.
2. Select the interface options.
   1. From the Primary control IP address drop-down list, select the primary control IP address for communications with the Management Server.
   2. (Optional, recommended) In the Backup control IP address drop-down list, select a backup control IP address for Management Server contact (used if the primary fails).
   3. From the Primary heartbeat drop-down list, select the primary interface for communications between the nodes.
      We recommend using a physical interface, not a VLAN interface. We strongly recommend that you do not direct any other traffic through this interface. A dedicated network helps guarantee reliable and secure operation.
      
      **CAUTION:** Primary and backup heartbeat networks exchange confidential information. If dedicated networks are not possible, configure the cluster to encrypt the exchanged information.

   4. From the Backup heartbeat drop-down list, select the backup heartbeat interface that is used if the primary heartbeat interface is unavailable.
      It is not mandatory to configure a backup heartbeat interface, but we strongly recommend it. If heartbeat traffic is not delivered, the cluster cannot operate and traffic is disturbed. We strongly recommend that you use a dedicated interface for the backup heartbeat as well.

   5. From the Identity for Authentication Requests drop-down list, select the IP address that identifies the firewall to external authentication servers.
      
      **Note:** This selection has no effect on routing.

   6. (Optional) From the Source for Authentication Requests drop-down list, select the IP address that identifies the firewall when it sends an authentication request to an external authentication server over a VPN.
      
      **Note:** This selection has no effect on routing.
7. From the Default IP Address for Outgoing Traffic field, select the IP address that the nodes use if they have to initiate connections through an interface that has no Node Dedicated IP address.

3. Click Save.

If an interface used for external connections has only a Cluster Virtual IP address, add manual ARP entries for the nodes.

Otherwise, you are now ready to bind the engine licenses to the nodes in the Firewall Cluster.

**Related concepts**

Options for initial configuration on page 104

You can configure the Stonesoft NGFW engine software using plug-and-play configuration, automatic configuration, or the NGFW Configuration Wizard.

---

**Add manual ARP entries for Firewall Clusters**

ARP entries are normally managed automatically based on the Firewall's routing configuration. However, you can also add manual ARP entries for the nodes.

If an interface used for external connections has only a cluster virtual IP address (CVI), you must add a static ARP entry. This entry gives the node a permanent reference to an IP address and MAC address.

For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, select Interfaces > ARP Entries.
2. Click Add ARP Entry.
   A new entry is added to the table.
3. Click Type and select Static.
4. Click Interface ID and select the interface on which the ARP entry is applied.
5. Double-click IP Address and enter the IP address information.
6. Double-click MAC Address and enter the MAC address information.
7. Click OK.
8. Click Save, then close the Engine Editor.

You are now ready to bind the engine licenses to the nodes of the Firewall Cluster.

**Related concepts**

Options for initial configuration on page 104

You can configure the Stonesoft NGFW engine software using plug-and-play configuration, automatic configuration, or the NGFW Configuration Wizard.

---

**Bind engine licenses to Firewall Cluster elements**

After you have configured the Firewall Cluster elements, you must manually bind Management Server POL-bound licenses to specific nodes in Firewall Cluster elements.

Licenses are created based on the Management Server’s proof-of-license (POL) code or based on the appliance's proof-of-serial (POS) code. POS-bound appliance licenses are automatically bound to the correct Firewall element when the engine is fully installed. Each engine is licensed separately even when the engines are clustered.

1. Select Menu > Configuration > Administration.
2. Browse to Licenses > Security Engine or Licenses > Firewall depending on the type of licenses you have.
   All installed licenses appear in the right pane.
3. Right-click a Management Server POL-bound license and select Bind.
4. Select the node and click Select.
   The license is now bound to the selected Firewall element.
Tip: If you bound the license to an incorrect element, right-click the license and select Unbind.

CAUTION: When you install or refresh the policy on the engine, the license is permanently bound to that engine. Permanently bound licenses cannot be rebound to another engine without re-licensing or deleting the engine element the license is bound to. Until you do that, the unbound license is shown as Retained.

You are now ready to transfer the configuration to the Firewall engines.

Related concepts
Options for initial configuration on page 104
You can configure the Stonesoft NGFW engine software using plug-and-play configuration, automatic configuration, or the NGFW Configuration Wizard.
Configuring Stonesoft NGFW for the IPS role

Configuring engine elements in the SMC prepares the SMC to manage Stonesoft NGFW engines in the IPS role.

Install licenses for Stonesoft NGFW engines

Install the Stonesoft NGFW engine licenses that you downloaded while preparing for installation. The license files must be available to the computer that you use to run the Management Client.

You can install all licenses at the same time even though you have not yet created all elements that the licenses are bound to.

For details about product features, usage, and best practices, click Help or press F1.

1. In the Management Client, select Menu > File > System Tools > Install Licenses.
2. Select one or more license files to install in the dialog box that opens and click Install.
3. Check that licenses were installed correctly.
   1. Select Menu > Configuration > Administration.
   2. Expand the Licenses branch of the tree.
   3. Select All Licenses in the list.

One license shows for each Stonesoft NGFW engine node. You must bind POL-bound engine licenses manually to the correct engines after you have configured the engine elements. POS-bound engine licenses are automatically attached to the correct engines after the engine is fully installed.

You are ready to define the engine elements.

Configuring IPS engines

IPS elements are a tool for configuring nearly all aspects of your physical IPS components.

Little configuration is done directly on the engines. Most of the configuration is done using the Management Client, so the engines can't be successfully installed before defining them in the SMC as outlined.

An important part of the IPS engine elements is the interface definitions. There are two main categories of IPS engine interfaces:

Table 8: IPS engine interfaces

<table>
<thead>
<tr>
<th>Purpose of interface</th>
<th>Interface type</th>
<th>When to use it</th>
</tr>
</thead>
<tbody>
<tr>
<td>System communications</td>
<td>Normal</td>
<td>These interfaces are used when the IPS engine is the source or the final destination of the communications. An example is control communications between the IPS engine and the Management Server. Define at least one interface that is dedicated to system communications.</td>
</tr>
</tbody>
</table>
### Purpose of interface

<table>
<thead>
<tr>
<th>Purpose of interface</th>
<th>Interface type</th>
<th>When to use it</th>
</tr>
</thead>
<tbody>
<tr>
<td>Traffic inspection</td>
<td>Capture, Inline</td>
<td>Define one or more traffic inspection interfaces for each IPS engine element.</td>
</tr>
</tbody>
</table>

The interfaces have their own numbering in the SMC called *interface ID*. The interface IDs are mapped to the corresponding network interfaces on the engine when you configure the Stonesoft NGFW engine software.

**Note:** If you configure the engine automatically with a USB drive, the interface IDs in the SMC are mapped to match the interface numbering in the operating system. For example, eth0 is mapped to Interface ID 0.

If necessary, you can change the interface ID mapping after the initial configuration using the command-line tools on the engine.

After you have the SMC installed and running, you can configure the IPS engines. The tasks you must complete are as follows:

1. Add Single IPS or IPS Cluster elements.
2. Add system communication interfaces.
3. Add traffic inspection interfaces.
4. Bind licenses to specific IPS elements.

## Add IPS elements

To add IPS engines to the SMC, add a Single IPS element or an IPS Cluster element that stores the configuration information related to the IPS engine.

This procedure covers the basic configuration of IPS engine elements. For complete instructions about configuring IPS engines, see the *Stonesoft Next Generation Firewall Product Guide*.

For details about product features, usage, and best practices, click Help or press F1.

1. Select ‹ Configuration. 
2. Right-click Security Engines and select one of the following:
   - New > IPS > IPS Cluster
   - New > IPS > Single IPS

   The Engine Editor opens.
3. In the Name field, enter a unique name.
4. From the Log Server drop-down list, select the Log Server for storing this IPS engine’s logs.

   If no Log Server is selected, the engine does not make any traffic recordings.
5. (Optional) In the DNS IP Addresses list, add one or more DNS IP addresses.

   These addresses are the IP addresses of the DNS servers that the IPS engine uses to resolve domain names and web filtering categorization services (which are defined as URLs).
   - To enter a single IP address manually, click Add and select IP Address. Enter the IP address in the dialog that opens.
   - To define an IP address by using a network element, click Add and select Network Element. Select a Host or External DNS Server element from the dialog box that opens. Alternatively, click the New icon and select Host or External DNS Server to define a new element.
6. From the Location drop-down list, select the Location to which the IPS belongs.
7. Click Save.
   Do not close the Engine Editor.

Add system communication interfaces to IPS engines

Each IPS engine needs at least one interface for communicating with the SMC.
You can add more than one system communication interface to provide a primary and a backup interface for Management Server communications.

Add physical interfaces to IPS elements

Add a physical interface for system communications.
For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, select Interfaces.
2. Right-click the empty space and select New Physical Interface.
3. From the Interface ID drop-down list, select an ID number.
   This ID maps to a network interface during the initial configuration of the engine.
4. From the Type drop-down list, select Normal Interface.
5. Click OK.
   The physical interface is added to the interface list
6. Click Save.
   Do not close the Engine Editor.

If you do not want to add VLANs to the physical interface, add IP addresses to the physical interface.

Related tasks
Add static IPv4 addresses to Single IPS interfaces on page 73
You can add one or more static IPv4 addresses to each physical or VLAN interface on a Single IPS engine.
Add IP addresses to IPS Cluster interfaces on page 74
You can add IP addresses to each node of an IPS Cluster.

Add VLAN interfaces to IPS elements

VLANs divide a single physical network link into several virtual links.
You can add up to 4094 VLANs to each physical interface.

⚠️ CAUTION: Do not add any manual VLAN definitions to an interface you want to use for sending resets. Adding VLANs prevents selecting the interface as a reset interface and also removes the reset interface from any existing selections.

For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, select Interfaces.
2. Right-click a physical interface and select New > VLAN Interface.
3. In the VLAN ID field, enter a VLAN ID number (1-4094).
   Note: The VLAN ID must be the same VLAN ID used in the external switch at the other end of the VLAN trunk.
4. Click OK.
   The specified VLAN ID is added to the physical interface.
5. Click Save.
   Do not close the Engine Editor.
The VLAN interface is now ready to be used as a network interface. The VLAN interface is identified as Interface-ID.VLAN-ID, for example 2.100 for interface ID 2 and VLAN ID 100.

Add static IPv4 addresses to Single IPS interfaces

You can add one or more static IPv4 addresses to each physical or VLAN interface on a Single IPS engine.

1. In the navigation pane on the left, select Interfaces.
2. Right-click a Physical Interface or a VLAN Interface and select New > IPv4 Address.
3. In the IPv4 Address field, enter the IPv4 address.
4. Click Netmask and adjust the automatically added netmask if necessary. The Network Address and Broadcast IP Address are updated accordingly.
5. If the interface is used for system communications and NAT is applied, add contact addresses.
   1. Enter the default contact address in one of the following ways:
      • In the Default field, enter the contact address.
      • Select Dynamic and define the translated IP address of this component.
   2. If components from some locations must use a different IP address for contact, click Exceptions and define the location-specific addresses.
6. Click OK.
   The IP address is added to the interface.
7. Click Save.
   If you plan to add more IP addresses or change the roles that interfaces have in system communications, do not close the Engine Editor.

   Tip: Write down the networks to which each Interface ID is connected.

Add dynamic IPv4 addresses to Single IPS interfaces

You can add one dynamic IPv4 address to each physical or VLAN interface on a Single IPS engine.

1. In the navigation pane on the left, select Interfaces.
2. Right-click a Physical Interface or a VLAN Interface and select New > IPv4 Address.
4. From the Dynamic Index drop-down list, select a DHCP index.
   The index is used for identification in other parts of the configuration (such as IPS Policies) to represent the possibly changing IP address.
5. If the interface is used for system communications and NAT is applied, add contact addresses.
   1. Enter the default contact address in one of the following ways:
      • In the Default field, enter the contact address.
      • Select Dynamic and define the translated IP address of this component.
   2. If components from some locations must use a different IP address for contact, click Exceptions and define the location-specific addresses.
6. Click OK.
   The IP address is added to the interface.
7. Click Save.
   If you plan to add more IP addresses or change the roles that interfaces have in system communications, do not close the Engine Editor.

   Tip: Write down the networks to which each Interface ID is connected.
Add static IPv6 addresses to Single IPS interfaces

You can add one or more static IPv6 addresses to each physical or VLAN interface on a Single IPS engine.

For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, select Interfaces.
2. Right-click a Physical Interface or a VLAN Interface and select New > IPv6 Address.
3. In the IPv6 Address field, enter the IPv6 address.
4. Click Prefix Length and adjust the automatically added prefix length if necessary.
5. Click OK.
   The IP address is added to the interface.
6. Click Save.
   If you plan to add more IP addresses or change the roles that interfaces have in system communications, do not close the Engine Editor.

Tip: Write down the networks to which each Interface ID is connected.

Add dynamic IPv6 addresses to Single IPS interfaces

You can add one dynamic IPv6 address to each physical or VLAN interface on a Single IPS engine.

For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, browse to Interfaces.
2. Right-click a Physical Interface or a VLAN Interface and select New > IPv6 Address.
4. From the Dynamic Index drop-down list, select a DHCP index.
   The index is used for identification in other parts of the configuration (such as IPS Policies) to represent the possibly changing IP address.
5. If the interface is used for system communications and NAT is applied, add contact addresses.
   1. Enter the default contact address in one of the following ways:
      • In the Default field, enter the contact address.
      • Select Dynamic and define the translated IP address of this component.
   2. If components from some locations must use a different IP address for contact, click Exceptions and define the location-specific addresses.
6. (Optional) If you do not want a default route to be automatically created through the interface, deselect Automatic Default Route.
7. (Optional) If you want to use DHCPv6 to get the IPv6 address, select Use DHCPv6 to get IPv6 Address.
8. Click OK.
   The IP address is added to the interface.
9. Click Save.
   If you plan to add more IP addresses or change the roles that interfaces have in system communications, do not close the Engine Editor.

Tip: Write down the networks to which each Interface ID is connected.

Add IP addresses to IPS Cluster interfaces

You can add IP addresses to each node of an IPS Cluster.

You can add both IPv4 and IPv6 addresses to the same interface.

For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, browse to Interfaces.
2. Right-click a physical interface or a VLAN interface and add the IP address in one of the following ways:
To add an IPv4 address, select New > IPv4 Address
To add an IPv6 address, select New > IPv6 Address
3. Click the IPv4 Address or IPv6 Address cell in the table and enter the IP address for each node.
4. (IPv4 addresses only) If necessary, double-click the Contact Address cell in the table and define the contact address for each node.
   • In the Default field at the top of the dialog box, enter the default contact address. The default contact address is used by default whenever a component that belongs to another Location connects to this interface.
   • If components from some Locations cannot use the default contact address, click Add to define Location-specific contact addresses.
5. (IPv4 addresses only) Check the automatically filled-in Netmask and adjust it as necessary.
6. (IPv6 addresses only) Check the automatically filled-in Prefix Length and adjust it as necessary.
7. Click OK.
8. Click Save.

If you do not want to select system communication roles for the interfaces, you are now ready to add traffic inspection interfaces.

Select system communication roles for IPS interfaces
Select which interfaces are used for which types of system communications.
1. In the navigation pane on the left, browse to Interfaces > Interface Options.
2. Select the interface options.
   1. From the Primary control IP address drop-down list, select the primary control IP address for communications with the Management Server.
   2. (Optional, recommended) In the Backup control IP address drop-down list, select a backup control IP address for Management Server contact (used if the primary fails).
   3. (IPS Cluster only) From the Primary heartbeat drop-down list, select the primary interface for communications between the nodes.

   ! Important: This interface must not be a VLAN Interface.

   ! CAUTION: Heartbeat traffic is time-critical. A dedicated network (without other traffic) is recommended for security and reliability of heartbeat communication.

4. (IPS Cluster only) From the Backup heartbeat drop-down list, select the backup heartbeat interface that is used if the primary heartbeat interface is unavailable.
   It is not mandatory to configure a backup heartbeat interface, but we strongly recommend it. If heartbeat traffic is not delivered, the cluster cannot operate and traffic is disturbed. We strongly recommend that you use a dedicated interface for the backup heartbeat as well.
5. (Single IPS only) If the control IP address for Management Server contact is a dynamic IP address, select Node-initiated contact to Management Server.
   When this option is selected, the engine opens a connection to the Management Server and maintains connectivity.
6. From the Default IP Address for Outgoing Traffic drop-down list, select the IP address that nodes use if they have to initiate connections through an interface that has no Node Dedicated IP address.
3. Click Save.
Add traffic inspection interfaces to IPS engines

IPS engines pick up passing network traffic for inspection in real time.

You can define both capture interfaces and inline interfaces for the same IPS engine.

Table 9: Types of traffic inspection interfaces for IPS engines

<table>
<thead>
<tr>
<th>Interface type</th>
<th>Inspection</th>
<th>Response</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Capture interface</td>
<td>The traffic is passively captured for inspection.</td>
<td>The engine can reset traffic picked up through capture interfaces if you set up specific reset interfaces. The reset interfaces can send TCP resets and ICMP “destination unreachable” messages when the communications trigger a response. You can use a system communications interface for sending resets if the resets are routed correctly through that interface and there are no VLANs on the interface.</td>
<td></td>
</tr>
<tr>
<td>Inline interface</td>
<td>Traffic is actively inspected as it flows through the inline interfaces.</td>
<td>The engine actively filters the traffic that attempts to pass through its inline interfaces.</td>
<td></td>
</tr>
</tbody>
</table>

When traffic is inspected, it might be important to know the interface through which it arrives to the IPS engine. It is also important to be able to distinguish an IPS engine’s capture interfaces from its inline interfaces. Logical interface elements are used for both these purposes. They allow you to group interfaces that belong to the same network segment and to identify the type of the traffic inspection interface.

Define a logical interface in the following cases:

- You want to create both capture interfaces and inline interfaces on the same IPS engine.
- You want to distinguish interfaces from each other.

If you do not want to use an existing system communication interface as the reset interface, define reset interfaces.

Otherwise, define capture interfaces or inline interfaces.

Add logical interfaces to IPS engines

Logical Interface elements are used in the IPS Policy and the traffic inspection process to represent a network segment.

The SMC contains one default Logical Interface element. A logical interface can represent any number or combination of physical interfaces and VLAN interfaces. However, the same logical interface cannot be used to represent both capture interfaces and inline interfaces on the same IPS engine. The rules in the ready-made IPS Template policy match all logical interfaces.

For details about product features, usage, and best practices, click Help or press F1.

1. Select Configuration.
2. Expand the Other Elements branch.
3. Right-click Logical Interfaces and select New Logical Interface.
4. In the Name field, enter a unique name.
5. (Optional) If you use VLAN tagging, select View interface as one LAN.
By default, the IPS engine treats a single connection as multiple connections when an external switch passes traffic between different VLANs and all traffic is mirrored to the IPS engine through a SPAN port.

6. Click OK.

You are now ready to add capture Interfaces and inline interfaces.

- If you want to use reset interfaces with capture interfaces, add the reset interfaces first.
- Otherwise, add capture interfaces or inline interfaces.

**Related tasks**

- [Add capture interfaces to IPS engines](#) on page 77
- Capture interfaces listen to traffic that is not routed through the IPS engine.
- [Add inline interfaces to IPS engines](#) on page 78
- Inline interfaces allow traffic to flow through an engine.

### Add reset interfaces to IPS engines

Reset interfaces can deliver TCP resets and ICMP destination unreachable messages to interrupt communications picked up from capture interfaces when the communications trigger a response.

VLANs are supported for sending resets, but the correct VLAN is selected automatically. An interface you want to use as the reset interface must not have any manually added VLAN configuration.

The reset interface must be in the same broadcast domain as the capture interface that uses the reset interface. The resets are sent using the IP addresses and MAC addresses of the communicating hosts.

---

**Important:** An interface that is used only as a reset interface must not have an IP address.

For details about product features, usage, and best practices, click **Help** or press **F1**.

1. Right-click the IPS engine and select **Edit <element type>**.
   - The Engine Editor opens.
2. In the navigation pane on the left, browse to **Interfaces**.
3. Right-click the empty space and select **New Physical Interface**.
4. From the **Interface ID** drop-down list, select an ID number.
5. From the **Type** drop-down list, select **Normal Interface**.
6. Click **OK**.
7. Click **Save**.

This interface can now be used as a reset interface. When you set up the physical network, make sure that the reset interface connects to the same network as the capture interfaces.

### Add capture interfaces to IPS engines

Capture interfaces listen to traffic that is not routed through the IPS engine.

You can have as many capture interfaces as there are available physical ports on the IPS engine (there are no license restrictions regarding this interface type).

External equipment must be set up to mirror traffic to the capture interface. You can connect a capture interface to an external switch SPAN port or a network TAP to capture traffic.

For details about product features, usage, and best practices, click **Help** or press **F1**.

1. Right-click the IPS engine and select **Edit <element type>**.
   - The Engine Editor opens.
2. In the navigation pane on the left, browse to **Interfaces**.
3. Right-click the empty space and select **New Physical Interface**.
4. From the **Interface ID** drop-down list, select an ID number.
5. From the **Type** drop-down list, select **Capture Interface**.
6. (Optional) From the Reset Interface drop-down list, select a TCP reset interface for traffic picked up through this capture interface.

7. If your configuration requires you to change the logical interface from Default_Eth, select the logical interface in one of the following ways:
   - Select an existing Logical Interface element from the list.
   - Select Other and browse to another Logical Interface element.
   - Select New to create a Logical Interface element.

8. Click OK.

9. Click Save.

Continue the configuration in one of the following ways:
   - Define Inline Interfaces.
   - Define how an inline IPS engine handles traffic when the traffic load is too high using the Bypass Traffic on Overload setting.
   - Bind engine licenses to IPS elements.

Related tasks

Beside your configuration, you can configure the IPS engine to bypass traffic when the traffic load becomes too high.

Bind engine licenses to IPS elements on page 79

After you have configured the IPS elements, you must manually bind Management Server POL-bound licenses to specific IPS elements.

Add inline interfaces to IPS engines

Inline interfaces allow traffic to flow through an engine.

One inline interface always comprises two physical interfaces. The traffic is forwarded from one interface to the other. The allowed traffic passes through as the inline interface if it was going through a network cable. The IPS engine drops the traffic you want to stop.

Inline interfaces are associated with a Logical interface element. The Logical interface is used in the IPS policies and the traffic inspection process to represent one or more IPS engine interfaces.

Fail-open network cards have fixed pairs of ports. Make sure to map these ports correctly during the initial configuration of the engine. Otherwise, the network cards do not correctly fail open when the IPS engine is offline. If you use the automatic USB memory stick configuration method for the engine's initial configuration, the ports are configured automatically.

For details about product features, usage, and best practices, click Help or press F1.

1. Right-click the IPS engine and select Edit <element type>. The Engine Editor opens.

2. In the navigation pane on the left, browse to Interfaces.

3. Right-click the empty space and select New Physical Interface.

4. From the Interface ID drop-down list, select an ID number.

5. From the Type drop-down list, select Inline Interface.

6. (Optional) From the Second Interface ID drop-down list, change the automatically selected interface ID.

7. If you want the IPS engine to inspect traffic from VLANs that are not included in the IPS engine's interface configuration, leave Inspect Unspecified VLANs selected.

8. If your configuration requires you to change the logical interface from Default_Eth, select the logical interface in one of the following ways:
   - Select an existing Logical Interface element from the list.
   - Select Other and browse to another Logical Interface element.
   - Select New to create a Logical Interface element.

9. Click OK.

10. Click Save.
Continue the configuration in one of the following ways:

- Define how an inline IPS engine handles traffic when the traffic load is too high using the Bypass Traffic on Overload setting.
- Bind engine licenses to IPS elements.

**Related tasks**

- **Bind engine licenses to IPS elements** on page 79
  After you have configured the IPS elements, you must manually bind Management Server POL-bound licenses to specific IPS elements.

- **Configure Stonesoft NGFW engine software using automatic configuration** on page 108
  Automatic configuration is primarily intended to be used with Stonesoft NGFW appliances, and might not work in all environments when you use your own hardware.

### Bypass traffic on overload

You configure the IPS engine to bypass traffic when the traffic load becomes too high.

By default, inline IPS engines inspect all connections. If the traffic load is too high for the inline IPS engine to inspect all connections, some traffic might be dropped. Alternatively, inline IPS engines can dynamically reduce the number of inspected connections if the load is too high. This reduction can improve performance in evaluation environments, but some traffic might pass through without any access control or inspection.

**CAUTION:** Using bypass mode requires a fail-open network interface card. If the ports that represent the pair of Inline Interfaces cannot fail open, policy installation fails on the engine. Bypass mode is not compatible with VLAN retagging. In network environments where VLAN retagging is used, normal mode is automatically enforced.

1. Right-click the IPS engine and select Edit <element type>. The Engine Editor opens.
2. In the navigation pane on the left, select Advanced Settings.
3. Select Bypass Traffic on Overload.
4. Click Save.

You are now ready to bind engine licenses to IPS elements.

### Bind engine licenses to IPS elements

After you have configured the IPS elements, you must manually bind Management Server POL-bound licenses to specific IPS elements.

Licenses are created based on the Management Server’s proof-of-license (POL) code or based on the appliance’s proof-of-serial (POS) code. POS-bound appliance licenses are automatically bound to the correct IPS element when the engine is fully installed.

For details about product features, usage, and best practices, click Help or press F1.

1. Select Menu > Configuration > Administration.
2. Browse to Licenses > Engine or Licenses > IPS depending on the type of licenses you have.
   All installed licenses appear in the right pane.
3. Right-click a Management Server POL-bound license and select Bind.
4. Select the IPS element and click Select.
   The license is now bound to the selected IPS element.

**Tip:** If you bound the license to an incorrect element, right-click the license and select Unbind.
You are now ready to transfer the configuration to the IPS engines.
Configuring Stonesoft NGFW for the Layer 2 Firewall role

Configuring engine elements in the SMC prepares the SMC to manage Stonesoft NGFW engines in the Layer 2 Firewall role.

Install licenses for Stonesoft NGFW engines

Install the Stonesoft NGFW engine licenses that you downloaded while preparing for installation.

The license files must be available to the computer that you use to run the Management Client.

You can install all licenses at the same time even though you have not yet created all elements that the licenses are bound to.

For details about product features, usage, and best practices, click Help or press F1.

1. In the Management Client, select Menu > File > System Tools > Install Licenses.
2. Select one or more license files to install in the dialog box that opens and click Install.
3. Check that licenses were installed correctly.
   1. Select Menu > Configuration > Administration.
   2. Expand the Licenses branch of the tree.
   3. Select All Licenses in the list.

One license shows for each Stonesoft NGFW engine node. You must bind POL-bound engine licenses manually to the correct engines after you have configured the engine elements. POS-bound engine licenses are automatically attached to the correct engines after the engine is fully installed.

You are ready to define the engine elements.

Configuring Layer 2 Firewalls

Layer 2 Firewall elements are a tool for configuring nearly all aspects of your Layer 2 Firewalls.

Little configuration is done directly on the engines. Most of the configuration is done using the Management Client. The engines cannot be successfully installed before defining them in the SMC as outlined.

An important part of the Layer 2 Firewall engine elements is the interface definitions. There are two main categories of IPS engine interfaces:

Table 10: Layer 2 Firewall interfaces

<table>
<thead>
<tr>
<th>Purpose of interface</th>
<th>Interface type</th>
<th>When to use it</th>
</tr>
</thead>
<tbody>
<tr>
<td>System communications</td>
<td>Normal</td>
<td>These interfaces are used when the Layer 2 Firewall engine is the source or the final destination of the communications. An example is control communications between the Layer 2 Firewall and the Management Server.</td>
</tr>
</tbody>
</table>
### Purpose of interface

<table>
<thead>
<tr>
<th>Purpose of interface</th>
<th>Interface type</th>
<th>When to use it</th>
</tr>
</thead>
<tbody>
<tr>
<td>Traffic inspection</td>
<td>Capture, Inline</td>
<td>Define one or more traffic inspection interfaces for each Layer 2 Firewall element.</td>
</tr>
</tbody>
</table>

The interfaces have their own numbering in the SMC called *interface ID*. The interface IDs are mapped to the corresponding network interfaces on the engine when you configure the Stonesoft NGFW engine software.

**Note:** If you configure the engine automatically with a USB drive, the interface IDs in the SMC are mapped to match the interface numbering in the operating system. For example, eth0 is mapped to Interface ID 0.

If necessary, you can change the interface ID mapping after the initial configuration using the command-line tools on the engine.

After you have the SMC installed and running, you can configure the Layer 2 Firewalls.

The tasks you must complete are as follows:

1. Add Single Layer 2 Firewall or Layer 2 Firewall Cluster elements.
2. Add system communication interfaces.
3. Add traffic inspection interfaces.
4. Bind licenses to specific Layer 2 Firewall elements.

## Add Layer 2 Firewall elements

The basic configuration of Layer 2 Firewall engine elements begins with creating an engine element.

For details about product features, usage, and best practices, click Help or press F1.

1. In the Management Client, select Menu > Configuration > Security Engine.
2. Right-click Security Engines and select one of the following:
   - New > Layer 2 Firewall > Layer 2 Firewall Cluster
   - New > Layer 2 Firewall > Single Layer 2 Firewall
   The Engine Editor opens.
3. In the Name field, enter a unique name.
4. From the Log Server drop-down list, select the Log Server that stores the log events that the Layer 2 Firewall engine creates.
5. (Optional) In the DNS IP Addresses field, add one or more DNS IP addresses for the Layer 2 Firewall engine.
   These addresses are the IP addresses of the DNS servers that the Layer 2 Firewall engine uses to resolve domain names and web filtering categorization services (which are defined as URLs).
   - To enter a single IP address manually, click Add and select IP Address. Enter the IP address in the dialog box that opens.
   - To define an IP address by using a Network element, click Add and select Network Element. Select a predefined Alias element that represents the IP address of the DNS of a dynamic network interface, a Host element, or an External DNS Server element from the dialog box that opens. Or click the New icon and select Host or External DNS Server to create an element.
6. From the Location drop-down list, select the location for this engine if there is a NAT device between SMC components affecting this engine’s communications.
7. Click Save.
   Do not close the Engine Editor.

Add system communications interfaces to Layer 2 Firewalls

Each Layer 2 Firewall needs at least one interface for communicating with the SMC.
You can add more than one system communication interface to provide a primary and a backup interface for Management Server communications.

Add physical interfaces to Layer 2 Firewalls

Add a physical interface for system communications.
For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, browse to Interfaces.
2. Right-click the empty space and select New Physical Interface.
3. From the Interface ID drop-down list, select an ID number.
   This ID maps to a network interface during the initial configuration of the engine.
4. From the Type drop-down list, select Normal Interface.
5. Click OK.
   The physical interface is added to the interface list.
6. Click Save.
   Do not close the Engine Editor.

If you do not want to add VLANs to the physical interface, add an IP address to the physical interface.

Related tasks
Add static IPv4 addresses to Single Layer 2 Firewall interfaces on page 84
You can add one or more static IPv4 addresses to each physical or VLAN interface on a Single Layer 2 Firewall.
Add IP addresses to Layer 2 Firewall Cluster interfaces on page 85
Add IP addresses to Layer 2 Firewall Cluster interfaces.

Add VLAN Interfaces to Layer 2 Firewalls

VLANs divide a single physical network link into several virtual links.
You can add up to 4094 VLANs to each physical interface.

CAUTION: Do not add any manual VLAN definitions to an interface you want to use for sending resets. Adding VLANs prevents selecting the interface as a reset interface and also removes the reset interface from any existing selections.

For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, select Interfaces.
2. Right-click a physical interface and select New > VLAN Interface.
3. In the VLAN ID field, enter a VLAN ID number (1-4094).

   Note: The VLAN ID must be the same VLAN ID used in the external switch at the other end of the VLAN trunk.

4. Click OK.
   The specified VLAN ID is added to the physical interface.
5. Click ![Save](image.png).  
   Do not close the Engine Editor. 

The VLAN interface is now ready to be used as a network interface. The VLAN interface is identified as Interface-ID.VLAN-ID, for example 2.100 for interface ID 2 and VLAN ID 100.

### Add static IPv4 addresses to Single Layer 2 Firewall interfaces

You can add one or more static IPv4 addresses to each physical or VLAN interface on a Single Layer 2 Firewall.

For details about product features, usage, and best practices, click ![Help](image.png) or press F1.

1. In the navigation pane on the left, select Interfaces.
2. Right-click a Physical Interface or a VLAN Interface and select New > IPv4 Address.
3. In the IPv4 Address field, enter the IPv4 address.
4. Click Netmask and adjust the automatically added netmask if necessary. 
   The Network Address and Broadcast IP Address are updated accordingly.
5. If the interface is used for system communications and NAT is applied, add contact addresses.
   1. Enter the default contact address in one of the following ways:
      - In the Default field, enter the contact address.
      - Select Dynamic and define the translated IP address of this component.
   2. If components from some locations must use a different IP address for contact, click Exceptions and define the location-specific addresses.
6. Click ![OK](image.png). 
   The IP address is added to the interface.
7. Click ![Save](image.png). 
   If you plan to add more IP addresses or change the roles that interfaces have in system communications, do not close the Engine Editor.

   **Tip:** Write down the networks to which each Interface ID is connected.

### Add dynamic IPv4 addresses to Single Layer 2 Firewall interfaces

You can add one dynamic IPv4 address to each physical or VLAN interface on a Single Layer 2 Firewall.

For details about product features, usage, and best practices, click ![Help](image.png) or press F1.

1. In the navigation pane on the left, select Interfaces.
2. Right-click a Physical Interface or a VLAN Interface and select New > IPv4 Address.
4. From the Dynamic Index drop-down list, select a DHCP index. 
   The index is used for identification in other parts of the configuration (such as IPS Policies) to represent the possibly changing IP address.
5. If the interface is used for system communications and NAT is applied, add contact addresses.
   1. Enter the default contact address in one of the following ways:
      - In the Default field, enter the contact address.
      - Select Dynamic and define the translated IP address of this component.
   2. If components from some locations must use a different IP address for contact, click Exceptions and define the location-specific addresses.
6. Click ![OK](image.png). 
   The physical interface is added to the interface list.
7. Click ![Save](image.png). 
   If you plan to add more IP addresses or change the roles that interfaces have in system communications, do not close the Engine Editor.
Tip: Write down the networks to which each Interface ID is connected.

Add static IPv6 addresses to Single Layer 2 Firewall interfaces

You can add one or more static IPv6 addresses to each physical or VLAN interface on a Single Layer 2 Firewall.

For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, select Interfaces.
2. Right-click a Physical Interface or a VLAN Interface and select New > IPv6 Address.
3. In the IPv6 Address field, enter the IPv6 address.
4. Click Prefix Length and adjust the automatically added prefix length if necessary.
5. Click OK.
   The IP address is added to the interface.
6. Click Save.
   If you plan to add more IP addresses or change the roles that interfaces have in system communications, do not close the Engine Editor.

Tip: Write down the networks to which each Interface ID is connected.

Add dynamic IPv6 addresses to Single Layer 2 Firewall interfaces

You can add one dynamic IPv6 address to each physical or VLAN interface on a Single Layer 2 Firewall.

For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, select Interfaces.
2. Right-click a physical interface or a VLAN interface and select New > IPv6 Address.
4. From the Dynamic Index drop-down list, select a DHCP index.
   The index is used for identification in other parts of the configuration (such as IPS Policies) to represent the possibly changing IP address.
5. If the interface is used for system communications and NAT is applied, add contact addresses.
   1. Enter the default contact address in one of the following ways:
      • In the Default field, enter the contact address.
      • Select Dynamic and define the translated IP address of this component.
   2. If components from some locations must use a different IP address for contact, click Exceptions and define the location-specific addresses.
6. (Optional) If you do not want a default route to be automatically created through the interface, deselect Automatic Default Route.
7. (Optional) If you want to use DHCPv6 to get the IPv6 address, select Use DHCPv6 to get IPv6 Address.
8. Click OK.
   The IP address is added to the interface.
9. Click Save.
   If you plan to add more IP addresses or change the roles that interfaces have in system communications, do not close the Engine Editor.

Tip: Write down the networks to which each Interface ID is connected.

Add IP addresses to Layer 2 Firewall Cluster interfaces

Add IP addresses to Layer 2 Firewall Cluster interfaces.

You can add both IPv4 and IPv6 addresses to the same interface.
For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, select Interfaces.
2. Right-click a physical interface or a VLAN interface and add the IP address in one of the following ways:
   - To add an IPv4 address, select New > IPv4 Address
   - To add an IPv6 address, select New > IPv6 Address
3. Click the IPv4 Address or IPv6 Address cell in the table and enter the IP address for each node.
4. (IPv4 addresses only) If necessary, double-click the Contact Address cell in the table and define the contact address for each node.
   - In the Default field at the top of the dialog box, enter the default contact address. The default contact address is used by default whenever a component that belongs to another Location connects to this interface.
   - If components from some Locations cannot use the default contact address, click Add to define Location-specific contact addresses.
5. (IPv4 addresses only) Check the automatically filled-in Netmask and adjust it as necessary.
6. (IPv6 addresses only) Check the automatically filled-in Prefix Length and adjust it as necessary.
7. Click OK.
8. Click Save.
   Do not close the Engine Editor.

If you do not want to select system communication roles for the interfaces, you are now ready to add traffic inspection interfaces.

Select system communication roles for Layer 2 Firewall interfaces

Select which interfaces are used for particular roles in system communications.

For details about product features, usage, and best practices, click Help or press F1.

1. In the navigation pane on the left, browse to Interfaces > Interface Options Options.
2. Select the interface options.
   1. From the Primary control IP address drop-down list, select the primary control IP address for communications with the Management Server.
   2. (Optional, recommended) In the Backup control IP address drop-down list, select a backup control IP address for Management Server contact (used if the primary fails).
   3. (Layer 2 Firewall Cluster only) From the Primary heartbeat drop-down list, select the primary interface for communications between the nodes.

   **Important:** This interface must not be a VLAN Interface.

   **CAUTION:** Heartbeat traffic is time-critical. A dedicated network (without other traffic) is recommended for security and reliability of heartbeat communication.

4. (Layer 2 Firewall Cluster only) From the Backup heartbeat drop-down list, select the backup heartbeat interface that is used if the primary heartbeat interface is unavailable.
   It is not mandatory to configure a backup heartbeat interface, but we strongly recommend it. If heartbeat traffic is not delivered, the cluster cannot operate and traffic is disturbed. We strongly recommend that you use a dedicated interface for the backup heartbeat as well.
5. (Single Layer 2 Firewall only) If the control IP address for Management Server contact is a dynamic IP address, select Node-initiated contact to Management Server.
   When this option is selected, the engine opens a connection to the Management Server and maintains connectivity.
6. From the Default IP Address for Outgoing Traffic drop-down list, select the IP address that nodes use if they have to initiate connections through an interface that has no Node Dedicated IP address.
3. Click Save.
Add traffic inspection interfaces to Layer 2 Firewalls

Layer 2 Firewalls pick up passing network traffic for inspection in real time.

You can define both capture interfaces and inline interfaces for the same Layer 2 Firewall.

Table 11: Types of traffic inspection interfaces for Layer 2 Firewalls

<table>
<thead>
<tr>
<th>Interface type</th>
<th>Inspection</th>
<th>Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capture interface</td>
<td>The traffic is passively captured for inspection.</td>
<td>The engine can reset traffic picked up through capture interfaces if you set up specific reset interfaces. The reset interfaces can send TCP resets and ICMP “destination unreachable” messages when the communications trigger a response. You can use a system communications interface for sending resets if the resets are routed correctly through that interface and there are no VLANs on the interface.</td>
</tr>
<tr>
<td>Inline interface</td>
<td>Traffic is actively inspected as it flows through the inline interfaces.</td>
<td>The engine actively filters the traffic that attempts to pass through its inline interfaces.</td>
</tr>
</tbody>
</table>

When traffic is inspected, it might be important to know the interface through which it arrives to the Layer 2 Firewall. It is also important to be able to distinguish a Layer 2 Firewall's capture interfaces from its inline interfaces. Logical Interface elements are used for both these purposes. They allow you to group interfaces that belong to the same network segment and to identify the type of the traffic inspection interface.

Define a logical interface in the following cases:
- You want to create both capture interfaces and inline interfaces on the same Layer 2 Firewall.
- You want to create Logical Interfaces to distinguish interfaces from each other.

If you do not want to use an existing system communication interface as the reset interface, define reset interfaces.

Otherwise, define capture interfaces or inline interfaces.

Add logical interfaces to Layer 2 Firewalls

A logical interface is used in the Layer 2 Firewall Policy and the traffic inspection process to represent a network segment.

The SMC contains one default Logical Interface element. A logical interface can represent any number or combination of physical interfaces and VLAN interfaces. However, the same logical interface cannot be used to represent both capture interfaces and inline interfaces on the same Layer 2 Firewall. The rules in the ready-made Layer 2 Firewall Template match all logical interfaces.

For details about product features, usage, and best practices, click Help or press F1.

1. Select Configuration.
2. Expand the Other Elements branch.
3. Right-click Logical Interfaces and select New Logical Interface.
4. In the Name field, enter a unique name.
5. (Optional) If you use VLAN tagging, select View interface as one LAN.
By default, the IPS engine treats a single connection as multiple connections when a switch passes traffic between different VLANs and all traffic is mirrored to the IPS engine through a SPAN port.

6. Click OK.

If you do not want to use reset interfaces with capture interfaces, add capture interfaces or inline interfaces.

**Related tasks**

- **Add capture interfaces to Layer 2 Firewalls** on page 88
  
  Capture interfaces listen to traffic that is not routed through the Layer 2 Firewall.

- **Add inline interfaces to Layer 2 Firewalls** on page 89
  
  Inline interfaces allow traffic to flow through an engine.

**Add reset interfaces to Layer 2 Firewalls**

Reset interfaces can deliver TCP resets and ICMP destination unreachable messages to interrupt communications picked up from capture interfaces when the communications trigger a response.

VLANs are supported for sending resets, but the correct VLAN is selected automatically. An interface you want to use as the reset interface must not have any manually added VLAN configuration.

The reset interface must be in the same broadcast domain as the capture interface that uses the reset interface. The resets are sent using the IP addresses and MAC addresses of the communicating hosts.

⚠️ **Important:** An interface that is used only as a reset interface must not have an IP address.

For details about product features, usage, and best practices, click Help or press F1.

1. Right-click the Layer 2 Firewall element and select Edit <element type>.
   The Engine Editor opens.
2. In the navigation pane on the left, browse to Interfaces.
3. Right-click the empty space and select New Physical Interface.
4. From the Interface ID drop-down list, select an ID number.
5. From the Type drop-down list, select Normal Interface.
6. Click OK.
7. Click 🍀 Save.
   
   Do not close the Engine Editor.

This interface can now be used as a reset interface. When you set up the physical network, make sure that the reset interface connects to the same network as the capture interfaces.

You are now ready to add capture interfaces and inline interfaces.

**Add capture interfaces to Layer 2 Firewalls**

Capture interfaces listen to traffic that is not routed through the Layer 2 Firewall.

You can have as many capture interfaces as there are available network ports on the Layer 2 Firewall (there are no license restrictions regarding this interface type).

External equipment must be set up to mirror traffic to the capture interface. You can connect a capture interface to an external switch SPAN port or a network TAP to capture traffic.

For details about product features, usage, and best practices, click Help or press F1.

1. On the Interfaces pane, right-click and select New Physical Interface.
2. From the Interface ID drop-down list, select an ID number.
3. From the Type drop-down list, select Capture Interface.
4. (Optional) From the Reset Interface drop-down list, select a TCP reset interface for traffic picked up through this capture interface.
5. If your configuration requires you to change the logical interface from Default_Eth, select the logical interface in one of the following ways:
   - Select an existing Logical Interface element from the list.
   - Select Other and browse to another Logical Interface element.
   - Select New to create a Logical Interface element.

6. Leave Inspect Unspecified VLANs selected if you want the Layer 2 Firewall engine to inspect traffic from VLANs not included in the engine’s interface configuration.

7. Click OK.

8. Click Save.
   
   If you plan to add inline interfaces, do not close the Engine Editor.

   If you do not want to add inline interfaces, bind engine licenses to Layer 2 Firewall elements.

Related tasks

Bind engine licenses to Layer 2 Firewall elements on page 90

After you have configured the Layer 2 Firewall elements, you must manually bind Management Server POL-bound licenses to specific Layer 2 Firewall elements.

Add inline interfaces to Layer 2 Firewalls

Inline interfaces allow traffic to flow through an engine.

One inline interface always comprises two physical interfaces. The traffic is forwarded from one interface to the other. The allowed traffic passes through as the inline interface if it was going through a network cable. The Layer 2 Firewall drops the traffic you want to stop.

Inline interfaces are associated with a Logical Interface element. The Logical Interface is used in the Layer 2 Firewall Policy and the traffic inspection process to represent one or more Layer 2 Firewall interfaces.

For details about product features, usage, and best practices, click Help or press F1.

1. Right-click the IPS engine and select Edit <element type>. The Engine Editor opens.
2. In the navigation pane on the left, browse to Interfaces.
3. Right-click the empty space and select New Physical Interface.
4. From the Interface ID drop-down list, select an ID number.
5. From the Type drop-down list, select Inline Interface.
6. (Optional) From the Second Interface ID drop-down list, change the automatically selected interface ID.
7. If you want the Layer 2 firewall engine to inspect traffic also from VLANs that are not included in the engine’s interface configuration, leave Inspect Unspecified VLANs selected.
8. If your configuration requires you to change the logical interface from Default_Eth, select the logical interface in one of the following ways:
   - Select an existing Logical Interface element from the list.
   - Select Other and browse to another Logical Interface element.
   - Select New to create a Logical Interface element.
9. Click OK.
10. Click Save, then close the Engine Editor.

You are now ready to bind engine licenses to Layer 2 Firewall elements.

Related tasks

Bind engine licenses to Layer 2 Firewall elements on page 90
After you have configured the Layer 2 Firewall elements, you must manually bind Management Server POL-bound licenses to specific Layer 2 Firewall elements.

### Bind engine licenses to Layer 2 Firewall elements

After you have configured the Layer 2 Firewall elements, you must manually bind Management Server POL-bound licenses to specific Layer 2 Firewall elements.

Licenses are created based on the Management Server's proof-of-license (POL) code or based on the appliance's proof-of-serial (POS) code. POS-bound appliance licenses are automatically bound to the correct Layer 2 Firewall element when the engine is fully installed.

For details about product features, usage, and best practices, click Help or press F1.

1. Select Menu > Configuration > Administration.
2. Browse to Licenses > Engine.
   All installed licenses appear in the right pane.
3. Right-click a Management Server POL-bound license and select Bind.
4. Select the Layer 2 Firewall element and click Select.
   The license is now bound to the selected Layer 2 Firewall element.

**Tip:** If you bound the license to an incorrect element, right-click the license and select Unbind.

You are now ready to transfer the configuration to the Layer 2 Firewall engines.
Configuring Stonesoft NGFW engines as Master Engines and Virtual Security Engines

Configuring engine elements in the SMC prepares the SMC to manage Master Engines and Virtual Security Engines.

Master Engine and Virtual Security Engine configuration overview

Virtual Security Engines are logically separate virtual engine instances on a physical engine device. A Master Engine is a physical engine device that provides resources for Virtual Security Engines. One physical Master Engine can support multiple Virtual Security Engines.

Little configuration is done directly on the Master Engine. No installation or configuration is done on the Virtual Security Engines. Most of the configuration is done using the Management Client. The engines cannot be successfully installed before defining them in the Management Client as outlined in this section.

The tasks you must complete are as follows:

1. Add Master Engine elements.
   1. Add Virtual Resource elements.
   2. Add physical interfaces and optionally VLAN interfaces to the Master Engine.
   3. Assign Virtual Resources to the interfaces that are used by the Virtual Security Engines hosted on the Master Engine.
2. Add Virtual Firewall, Virtual IPS, or Virtual Layer 2 Firewall elements.
   1. Configure the automatically created physical interfaces.
   2. (Optional) Add VLAN interfaces for the Virtual Security Engines.
   3. Bind licenses to specific nodes of the Master Engine.

Install licenses for Stonesoft NGFW engines

Install the Stonesoft NGFW engine licenses that you downloaded while preparing for installation.

The license files must be available to the computer that you use to run the Management Client.

You can install all licenses at the same time even though you have not yet created all elements that the licenses are bound to.

For details about product features, usage, and best practices, click Help or press F1.

1. In the Management Client, select ★ Menu > File > System Tools > Install Licenses.
2. Select one or more license files to install in the dialog box that opens and click Install.
3. Check that licenses were installed correctly.
   1. Select ★ Menu > Configuration > Administration.
   2. Expand the Licenses branch of the tree.
   3. Select All Licenses in the list.
One license shows for each Stonesoft NGFW engine node. You must bind POL-bound engine licenses manually to the correct engines after you have configured the engine elements. POS-bound engine licenses are automatically attached to the correct engines after the engine is fully installed.

You are ready to define the engine elements.

**Add Master Engine elements**

To introduce a new Master Engine to the SMC, add a Master Engine element that stores the configuration information for the Master Engine and Virtual Security Engines.

For details about product features, usage, and best practices, click Help or press F1.

1. In the Management Client, select Menu > Configuration > Security Engine.
2. Right-click Security Engines and select New > Master Engine.
3. Select the role for the Virtual Security Engines the Master Engine hosts, then click OK. The Engine Editor opens.
4. In the Name field, enter a unique name.
5. Select the Log Server to which the Master Engine sends its log data.
6. (Optional) Define one or more DNS IP Addresses.
   These addresses are the IP addresses of the DNS servers that the Master Engine uses to resolve domain names. There are two ways to define IP addresses.
   • To enter a single IP address manually, click Add and select IP Address. Enter the IP address in the dialog box that opens.
   • To define an IP address using a network element, click Add and select Network Element. Select an existing element, or click the New icon and define a new element.
7. Select the Location for this Master Engine if there is a NAT device between this Master Engine and other SMC components.
8. (Optional) If you do not need to use clustering on the Master Engine:
   1. In the navigation pane on the left, browse to General > ARP Entries.
   2. Select one of the nodes, then click Remove Node.
   3. When prompted to confirm that you want to delete the selected node, click Yes.
9. Click Save.
   Do not close the Engine Editor.

If you do not want to add more nodes to the Master Engine, you are now ready to add Virtual Resource elements.

**Add nodes to Master Engines**

Add all nodes you plan to install before you begin configuring the interfaces.

The Master Engine has placeholders for two nodes when the element is created. A Master Engine can have up to 16 nodes.

For details about product features, usage, and best practices, click Help or press F1.

1. Right-click the Master Engine element and select Edit Master Engine. The Engine Editor opens.
2. In the navigation pane on the left, select General > Clustering.
3. Click Add Node.
4. (Optional) Change the Name.
5. Click OK. The node is added to the Master Engine.
6. Click Save.
Create Virtual Resource elements

Virtual Resources associate Virtual Security Engines with Physical Interfaces or VLAN Interfaces on the Master Engine.

When you select the same Virtual Resource for a Physical Interface or VLAN Interface on the Master Engine and for a Virtual Security Engine, the Virtual Security Engine is automatically associated with the Master Engine. Create one Virtual Resource for each Virtual Security Engine that you plan to add.

For details about product features, usage, and best practices, click Help or press F1.

1. Select Configuration.
2. Right-click the Master Engine element and select Edit Master Engine.
   The Engine Editor opens.
3. In the navigation pane on the left, browse to Interfaces > Virtual Resources in the navigation pane on the left.
4. Click Add.
   The Virtual Resource Properties dialog box opens.
5. Enter a unique Name for the Virtual Resource.
6. Select the Domain to which the Virtual Resource belongs.
7. (Optional) Enter the Concurrent Connection Limit to set a limit for the total number of connections that are allowed for the Virtual Security Engine associated with the Virtual Resource.
   When the set number of connections is reached, the engine blocks the next connection attempts until a previously open connection is closed.
8. (Optional) Select Show Master Interface IDs in Virtual Engine if you want the Physical Interface IDs of the Master Engine to be shown in the Interface properties of the Virtual Security Engine.
9. Click OK.
10. Click Save.

If you are creating a Master Engine, you are now ready to configure Master Engine interfaces. Otherwise, you are now ready to associate the Virtual Resource with a Master Engine interface and with a Virtual Security Engine.

Add physical interfaces to Master Engines

Master Engines can have two types of physical interfaces: interfaces for the Master Engine’s own communications, and interfaces that are used by the Virtual Security Engines hosted on the Master Engine.

You must add at least one physical interface for the Master Engine’s own communications.

For Master Engine clusters, it is recommended to add at least two physical interfaces:

• An interface used for communications between the Management Server and the Master Engine.
• An interface for the heartbeat communications between the cluster nodes. The heartbeat traffic is critical to the functioning of the cluster, so it is highly recommended to have a dedicated heartbeat interface.

For details about product features, usage, and best practices, click Help or press F1.

1. Right-click the Master Engine element and select Edit Master Engine.
   The Engine Editor opens.
2. In the navigation pane on the left, select Interfaces.
3. Right-click the empty space and select New Physical Interface.
4. (Interface for Master Engine communications only) Define the physical interface properties.
   1. From the Type drop-down list, select the interface type according to the engine role.
   2. Do not select a Virtual Resource for an interface that is used for the Master Engine’s own communications.
   3. In the Cluster MAC Address field, enter the MAC address for the Master Engine.
Note: Do not use the MAC address of any actual network card on any of the Master Engine nodes.

Note: Make sure that you set the interface speed correctly. When the bandwidth is set, the Master Engine always scales the total amount of traffic on this interface to the bandwidth you defined. The bandwidth is scaled even if there are no bandwidth limits or guarantees defined for any traffic.

5. (Interface for hosted Virtual Security Engine communications only) Define the physical interface properties.
   1. From the Type drop-down list, select the interface type according to the engine role.
   2. (Virtual IPS only) From the Failure Mode drop-down list, select how traffic to the inline interface is handled if the Virtual IPS engine goes offline.

   Note: If there are VLAN interfaces under the inline interface, select Bypass.

   CAUTION: Using Bypass mode requires the Master Engine appliance to have a fail-open network interface card. If the ports that represent the pair of inline interfaces on the appliance cannot fail open, the policy installation fails on the Virtual IPS engine. Bypass mode is not compatible with VLAN retagging. In network environments where VLAN retagging is used, normal mode is automatically enforced.

   3. From the Virtual Resource drop-down list, select the Virtual Resource element associated with the interface.
      Select the same Virtual Resource in the properties of the Virtual Security Engine to add the Virtual IPS engine to the Master Engine.

      Note: Only one Virtual Resource can be selected for each physical interface. If you want to add multiple Virtual Resources, add VLAN interfaces to the physical interface and select the Virtual Resource in the VLAN interface properties.

6. Click OK.
   The physical interface is added to the interface list.

7. Click Save.
   If you do not want to add VLANs to physical interfaces, add IP addresses directly to the physical interfaces used for Master Engine communications.

Add VLAN interfaces to Master Engines

Master Engines can have two types of VLAN interfaces: VLAN interfaces for the Master Engine’s own traffic, and VLAN interfaces that are used by the Virtual Security Engines hosted on the Master Engine.

The maximum number of VLANs for a single physical interface is 4094. The VLANs must also be defined in the configuration of the external switch or router to which the interface is connected.

On Master Engines that host Virtual IPS engines or Virtual Layer 2 Firewalls, the Virtual Security Engines can inspect traffic from VLAN interfaces without configuring VLAN tagging.

For details about product features, usage, and best practices, click Help or press F1.

1. Right-click a Master Engine and select Edit Master Engine.
   The Engine Editor opens.

2. In the navigation pane on the left, select Interfaces.

3. Right-click a physical interface and select New > VLAN Interface.

4. To associate the VLAN interface with a Virtual Security engine, select a Virtual Resource from the Virtual Resource drop-down list.
5. Define the VLAN interface properties.

**CAUTION:** The throughput for each VLAN interface must not be higher than the throughput for the physical interface to which the VLAN interface belongs.

**CAUTION:** Make sure that you set the interface speed correctly. When the bandwidth is set, the Master Engine always scales the total amount of traffic on this interface to the bandwidth you defined. The bandwidth is scaled even if there are no bandwidth limits or guarantees defined for any traffic.

**CAUTION:** The MTU for each VLAN interface must not be higher than the MTU for the physical interface to which the VLAN interface belongs.

6. Click OK.
   The specified VLAN ID is added to the physical interface.

7. Click Save.
   Do not close the Engine Editor.

You are now ready to add IP addresses to the physical interfaces or VLAN interfaces for Master Engine system communications.

### Add IPv4 and IPv6 addresses to Master Engine interfaces

You can add several IPv4 addresses to each Physical Interface or VLAN Interface that does not have a Virtual Resource associated with it.

For details about product features, usage, and best practices, click Help or press F1.

1. Right-click a Master Engine and select Edit Master Engine.
   The Engine Editor opens.
2. In the navigation pane on the left, select Interfaces.
3. Right-click a physical interface or a VLAN interface and add the IP address in one of the following ways:
   • To add an IPv4 address, select New > IPv4 Address
   • To add an IPv6 address, select New > IPv6 Address
4. Click the IPv4 Address or IPv6 Address cell in the table and enter the IP address for each node.
5. (IPv4 addresses only) If necessary, double-click the Contact Address cell in the table and define the contact address for each node.
   • In the Default field at the top of the dialog box, enter the default contact address. The default contact address is used by default whenever a component that belongs to another Location connects to this interface.
   • If components from some Locations cannot use the default contact address, click Add to define Location-specific contact addresses.
6. (IPv4 addresses only) Check the automatically filled-in Netmask and adjust it as necessary.
7. (IPv6 addresses only) Check the automatically filled-in Prefix Length and adjust it as necessary.
8. Click OK.
9. Click Save.
10. Continue the configuration in one of the following ways:
    • If you are configuring a new Master Engine, or if you want to change the roles the different interfaces have in the configuration, select system communication roles for Master Engine interfaces.
    • Otherwise, refresh the policy to transfer the configuration changes.
Select system communication roles for Master Engine interfaces

Select which Master Engine interfaces are used for particular roles in system communications.

For details about product features, usage, and best practices, click Help or press F1.

1. Right-click a Master Engine and select Edit Master Engine.
   The Engine Editor opens.
2. In the navigation pane on the left, select Interfaces > Interface Options.
3. In the Interface Options pane that opens on the right:
   1. From the Primary control IP address drop-down list, select the primary control IP address for communications with the Management Server.
   2. (Optional, recommended) From the Backup control IP address drop-down list, select a backup control IP address for Management Server contact (used if the primary fails).
   3. (Master Engine Cluster Only) From the Primary heartbeat drop-down list, select the primary interface for communications between the nodes.
      
      We recommend using a physical interface, not a VLAN interface. We strongly recommend that you do not direct any other traffic through this interface. A dedicated network helps guarantee reliable and secure operation.

      **CAUTION:** Primary and backup heartbeat networks exchange confidential information. If dedicated networks are not possible, configure the cluster to encrypt the exchanged information.

4. (Master Engine Cluster Only) From the Backup heartbeat drop-down list, select the backup heartbeat interface that is used if the primary heartbeat interface is unavailable.
   It is not mandatory to configure a backup heartbeat interface, but we strongly recommend it. If heartbeat traffic is not delivered, the cluster cannot operate and traffic is disturbed. We strongly recommend that you use a dedicated interface for the backup heartbeat as well.
5. In the Default IP Address for Outgoing Traffic field, select the IP address that the nodes use if they have to initiate connections through an interface that has no Node Dedicated IP address.

4. Click OK.
5. Click the Save and Refresh icon in the toolbar, then close the Engine Editor.

You are now ready to bind licenses to Master Engine elements.

Bind Master Engine licenses to Master Engine elements

You must manually bind Management Server POL-bound licenses to a specific Master Engine element.

Licenses are created based on the Management Server’s proof-of-license (POL) code or based on the appliance’s proof-of-serial (POS) code. POS-bound appliance licenses are automatically bound to the correct Master Engine element when the engine is fully installed. Virtual security engines do not require a separate license.

For details about product features, usage, and best practices, click Help or press F1.

1. Select \_\_\_ Menu > Configuration > Administration.
   All installed licenses appear in the right pane.
3. Right-click a Management Server POL-bound license and select Bind.
   The Select License Binding dialog box opens.
4. Select the node and click Select.
   If you made a mistake, right-click the license and select Unbind.
You are now ready to add Virtual Security Engine elements.

Add Virtual Firewall elements

Virtual Firewall elements store the configuration information related to the Virtual Firewalls.

Selecting a Virtual Resource for the Virtual Firewall automatically adds the Virtual Firewall to the Master Engine where the Virtual Resource is used.

For details about product features, usage, and best practices, click Help or press F1.

1. Select **Configuration**.
2. Right-click **Security Engines** and select **New > Firewall > Virtual Firewall**. The Engine Editor opens.
3. In the **Name** field, enter a unique name.
4. Next to the **Virtual Resource** field, click **Select** and select a Virtual Resource on the Master Engine to which you want to add the Virtual Firewall.
5. (Optional) In the **DNS IP Addresses** field, add one or more IP addresses of DNS servers that the Virtual Firewall uses to resolve domain names. There are two ways to define IP addresses.
   - To enter a single IP address manually, click **Add** and select **IP Address**. Enter the IP address in the dialog box that opens.
   - To define an IP address using a network element, click **Add** and select **Network Element**. Select an existing element, or click the **New** icon and create an element.
6. (Optional) Next to the **Category** field, click **Select** and select one or more categories.
7. Click **Save**. Do not close the Engine Editor.

You are now ready to configure interfaces for the Virtual Firewall.

Configuring physical interfaces for Virtual Firewalls


When you select the Virtual Resource for the Virtual Security Engine, physical interfaces are automatically created based on the interface configuration in the Master Engine properties. The number of physical interfaces depends on the number of interfaces allocated to the Virtual Security Engine in the Master Engine. You cannot create new physical interfaces for Virtual Firewalls. You can optionally change the automatically created physical interfaces. For detailed instructions, see the *Stonesoft Next Generation Firewall Product Guide*.

You can optionally change the automatically created physical interfaces in the Virtual IPS engine properties. For detailed instructions, see the *Stonesoft Next Generation Firewall Product Guide*.

If the configuration of the Master Engine allows it, you can add VLANs to physical interfaces on the Virtual Firewall. If you do not want to add VLANs, add IP addresses to the physical interfaces.
Add VLAN interfaces to Virtual Security Engine interfaces

VLANs divide a single physical network link into several virtual links.

VLAN interfaces can only be added for Virtual Security Engines if the creation of VLAN interfaces for Virtual Firewalls is enabled in the Master Engine Properties. The maximum number of VLANs for a single physical interface is 4094. The VLANs must also be defined in the configuration of the external switch or router to which the interface is connected.

Note: You cannot add VLAN interfaces on top of other VLAN interfaces. Depending on the configuration of the Master Engine, you might not be able to create valid VLAN interfaces for the Virtual Security Engine. Contact the administrator who configured the Master Engine.

For details about product features, usage, and best practices, click Help or press F1.

1. Right-click a Virtual Firewall, Virtual IPS engine, or Virtual Layer 2 Firewall and select Edit <element type>. The Engine Editor opens.
2. In the navigation pane on the left, select Interfaces. The Interfaces pane opens on the right.
3. Right-click a physical interface and select New > VLAN Interface.
4. Define the VLAN interface properties.

CAUTION: The throughput for the Virtual Firewall physical interface must not be higher than the throughput for the Master Engine interface that hosts the Virtual Firewall. Contact the administrator of the Master Engine before changing this setting.

CAUTION: Make sure that you set the interface speed correctly. When the bandwidth is set, the Virtual Security Engine always scales the total amount of traffic on this interface to the bandwidth you defined. The bandwidth is scaled even if there are no bandwidth limits or guarantees defined for any traffic.

5. Click OK. The specified VLAN ID is added to the physical interface.
6. Continue the configuration in one of the following ways:
   • (Virtual Firewall only) If you do not want to add tunnel interfaces for the route-based VPN, add IP addresses directly to the physical interfaces.
   • Otherwise, click the Save and Refresh icon in the toolbar to transfer the configuration changes.

Add IP addresses for Virtual Firewalls

You can add one or more IPv4 and IPv6 addresses to a Physical Interface or VLAN Interface on a Virtual Firewall.

You can add both IPv4 and IPv6 addresses to the same interface.

Add IPv4 addresses to Virtual Firewall interfaces

You can add one or more static IPv4 addresses for Virtual Firewall interfaces.

For details about product features, usage, and best practices, click Help or press F1.

1. Right-click a Virtual Firewall and select Edit Virtual Firewall. The Engine Editor opens.
2. In the navigation pane on the left, select Interfaces. The Interfaces pane opens on the right.
3. Right-click a Physical Interface, VLAN Interface, or Tunnel Interface and select New > IPv4 Address.
The IP Address Properties dialog box opens.

Note: If you have added VLAN Interfaces to Physical Interfaces, add the IPv4 Addresses to the VLAN Interfaces.

4. Enter the IPv4 Address.
5. If necessary, define the contact address information.
   • Enter the Default contact address. The default contact address is used by default whenever a component that belongs to another Location connects to this interface.
   • If components from some Locations cannot use the Default contact address, click Exceptions to define Location-specific contact addresses.
6. Check the automatically filled-in Netmask and adjust it as necessary.
7. Click OK.
8. Continue the configuration in one of the following ways:
   • Add IPv6 addresses.
   • If you are creating a new Virtual Firewall, or if you want to change the roles the different interfaces have in the configuration, select interface options for Virtual Firewall interfaces.
   • Otherwise, click the Save and Refresh icon in the toolbar to transfer the configuration changes.

Add IPv6 addresses to Virtual Firewall interfaces

You can add one or more static IPv6 addresses for Virtual Firewall interfaces.

For details about product features, usage, and best practices, click Help or press F1.

1. Right-click a Virtual Firewall and select Edit Virtual Firewall.
   The Engine Editor opens.
2. In the navigation pane on the left, select Interfaces.
   The Interfaces pane opens on the right.
3. Right-click a Physical interface and select New > IPv6 Address or right-click a VLAN Interface and select New IPv6 Address.
   The IP Address Properties dialog box opens.

Note: If you have added VLAN Interfaces to Physical Interfaces, add the IPv6 Addresses to the VLAN Interfaces.

4. Enter the IPv6 Address.
5. Check the automatically filled-in Prefix Length and adjust it if necessary by entering a value between 0-128.
   The Network Address is automatically generated.
6. Click OK.
7. Continue the configuration in one of the following ways:
   • If you are creating a new Virtual Firewall, or if you want to change the roles the different interfaces have in the configuration, select interface options for Virtual Firewall interfaces.
   • Otherwise, click the Save and Refresh icon in the toolbar to transfer the configuration changes.

Select additional options for Virtual Firewall interfaces

In the Virtual Firewall's interface options, you can select which IP addresses are used in particular roles.

Interface Options can only be configured for Virtual Firewalls.

All communication between Virtual Firewalls and the SMC is proxied by the Master Engine. Virtual Firewalls do not have any interfaces for system communication.

For details about product features, usage, and best practices, click Help or press F1.

1. Right-click a Virtual Firewall and select Edit Virtual Firewall.
2. In the navigation pane on the left, browse to Interfaces > Interface Options. The Interface Options pane opens on the right.
3. Select the interface options.
4. Click OK.
5. Continue the configuration in one of the following ways:
   • Add loopback IP addresses for the Virtual Firewall.
   • If you are configuring a new Virtual Security Engine, click the Save icon in the toolbar, close the Engine Editor, and add routes for the Master Engine.
   • Otherwise, click the Save and Refresh icon in the toolbar to transfer the configuration changes.

Add Virtual IPS elements

Virtual IPS elements store the configuration information related to the Virtual IPS engines.

Selecting a Virtual Resource for the Virtual IPS element automatically adds the Virtual IPS element to the Master Engine where the Virtual Resource is used.

For details about product features, usage, and best practices, click Help or press F1.

1. Select Configuration.
2. Right-click Security Engines and select New > IPS > Virtual IPS. The Engine Editor opens.
3. In the Name field, enter a unique name.
4. Next to the Virtual Resource field, click Select and select a Virtual Resource on the Master Engine to which you want to add the Virtual IPS.
5. (Optional) In the DNS IP Addresses field, add one or more IP addresses of DNS servers that the Virtual Firewall uses to resolve domain names. There are two ways to define IP addresses.
   • To enter a single IP address manually, click Add and select IP Address. Enter the IP address in the dialog box that opens.
   • To define an IP address using a network element, click Add and select Network Element. Select an existing element, or click the New icon and create an element.
6. (Optional) Next to the Category field, click Select and select one or more categories.
7. Click Save.

Do not close the Engine Editor.

You are now ready to configure interfaces for the Virtual IPS engine.

Configuring physical interfaces for Virtual IPS engines

Physical interfaces for Virtual IPS engines represent interfaces allocated to the Virtual IPS engine in the Master Engine.

When you select the Virtual Resource for the Virtual IPS engine, physical interfaces are automatically created based on the interface configuration of the Master Engine. The number of physical interfaces depends on the number of interfaces allocated to the Virtual IPS engine in the Master Engine. It is not recommended to create new physical interfaces in the Virtual IPS engine properties, as they might not be valid.

You can optionally change the automatically created physical interfaces in the Virtual IPS engine properties. For detailed instructions, see the Stonesoft Next Generation Firewall Product Guide.

If the configuration of the Master Engine allows it, you can add VLANs to physical interfaces on the Virtual IPS engine. If you do not want to add VLANs, add IP addresses to the physical interfaces.
Add VLAN interfaces to Virtual Security Engine interfaces

VLANs divide a single physical network link into several virtual links.

VLAN interfaces can only be added for Virtual Security Engines if the creation of VLAN interfaces for Virtual Firewalls is enabled in the Master Engine Properties. The maximum number of VLANs for a single physical interface is 4094. The VLANs must also be defined in the configuration of the external switch or router to which the interface is connected.

**Note:** You cannot add VLAN interfaces on top of other VLAN interfaces. Depending on the configuration of the Master Engine, you might not be able to create valid VLAN interfaces for the Virtual Security Engine. Contact the administrator who configured the Master Engine.

For details about product features, usage, and best practices, click Help or press F1.

1. Right-click a Virtual Firewall, Virtual IPS engine, or Virtual Layer 2 Firewall and select Edit <element type>. The Engine Editor opens.
2. In the navigation pane on the left, select Interfaces. The Interfaces pane opens on the right.
3. Right-click a physical interface and select New > VLAN Interface.
4. Define the VLAN interface properties.

**CAUTION:** The throughput for the Virtual Firewall physical interface must not be higher than the throughput for the Master Engine interface that hosts the Virtual Firewall. Contact the administrator of the Master Engine before changing this setting.

**CAUTION:** Make sure that you set the interface speed correctly. When the bandwidth is set, the Virtual Security Engine always scales the total amount of traffic on this interface to the bandwidth you defined. The bandwidth is scaled even if there are no bandwidth limits or guarantees defined for any traffic.

5. Click OK. The specified VLAN ID is added to the physical interface.
6. Continue the configuration in one of the following ways:
   - (Virtual Firewall only) If you do not want to add tunnel interfaces for the route-based VPN, add IP addresses directly to the physical interfaces.
   - Otherwise, click the Save and Refresh icon in the toolbar to transfer the configuration changes.

Add Virtual Layer 2 Firewall elements

Virtual Layer 2 Firewall elements store the configuration information related to the Virtual Layer 2 Firewalls.

Selecting a Virtual Resource for the Virtual Layer 2 Firewall automatically adds the Virtual Layer 2 Firewall to the Master Engine where the Virtual Resource is used.

For details about product features, usage, and best practices, click Help or press F1.

1. Select Configuration.
2. Right-click Security Engines and select New > Layer 2 Firewall > Virtual Layer 2 Firewall. The Engine Editor opens.
3. In the Name field, enter a unique name.
4. Next to the Virtual Resource field, click Select and select a Virtual Resource on the Master Engine to which you want to add the Virtual Firewall.
5. (Optional) In the DNS IP Addresses field, add one or more IP addresses of DNS servers that the Virtual Firewall uses to resolve domain names. There are two ways to define IP addresses.
• To enter a single IP address manually, click Add and select IP Address. Enter the IP address in the dialog box that opens.
• To define an IP address using a network element, click Add and select Network Element. Select an existing element, or click the New icon and create an element.

6. (Optional) Next to the Category field, click Select and select one or more categories.
7. Click Save.

Do not close the Engine Editor.

You are now ready to configure interfaces for the Virtual Layer 2 Firewall.

Configuring Physical Interfaces for Virtual Layer 2 Firewalls

Physical interfaces for Virtual Layer 2 Firewalls represent interfaces allocated to the Virtual Layer 2 Firewall in the master engine.

When you select the Virtual Resource for the Virtual Layer 2 Firewall, physical interfaces are automatically created based on the interface configuration of the Master Engine. The number of physical interfaces depends on the number of interfaces allocated to the Virtual Layer 2 Firewall in the Master Engine. It is not recommended to create new physical interfaces in the Virtual Layer 2 Firewall properties, as they might not be valid.

You can optionally change the automatically created physical interfaces in the Virtual Layer 2 Firewall properties. For detailed instructions, see the Stonesoft Next Generation Firewall Product Guide.

Add VLAN interfaces to Virtual Security Engine interfaces

VLANs divide a single physical network link into several virtual links.

VLAN interfaces can only be added for Virtual Security Engines if the creation of VLAN interfaces for Virtual Firewalls is enabled in the Master Engine Properties. The maximum number of VLANs for a single physical interface is 4094. The VLANs must also be defined in the configuration of the external switch or router to which the interface is connected.

Note: You cannot add VLAN interfaces on top of other VLAN interfaces. Depending on the configuration of the Master Engine, you might not be able to create valid VLAN interfaces for the Virtual Security Engine. Contact the administrator who configured the Master Engine.

For details about product features, usage, and best practices, click Help or press F1.

1. Right-click a Virtual Firewall, Virtual IPS engine, or Virtual Layer 2 Firewall and select Edit <element type>. The Engine Editor opens.
2. In the navigation pane on the left, select Interfaces. The Interfaces pane opens on the right.
3. Right-click a physical interface and select New > VLAN Interface.
4. Define the VLAN interface properties.

CAUTION: The throughput for the Virtual Firewall physical interface must not be higher than the throughput for the Master Engine interface that hosts the Virtual Firewall. Contact the administrator of the Master Engine before changing this setting.

CAUTION: Make sure that you set the interface speed correctly. When the bandwidth is set, the Virtual Security Engine always scales the total amount of traffic on this interface to
the bandwidth you defined. The bandwidth is scaled even if there are no bandwidth limits or guarantees defined for any traffic.

5. Click OK. The specified VLAN ID is added to the physical interface.

6. Continue the configuration in one of the following ways:
   - (Virtual Firewall only) If you do not want to add tunnel interfaces for the route-based VPN, add IP addresses directly to the physical interfaces.
   - Otherwise, click the Save and Refresh icon in the toolbar to transfer the configuration changes.
Configuring Stonesoft NGFW engine software

After configuring the engine elements in the SMC, configure settings for the Stonesoft NGFW engine, and contact the Management Server.

Options for initial configuration

You can configure the Stonesoft NGFW engine software using plug-and-play configuration, automatic configuration, or the NGFW Configuration Wizard.

Your appliance comes pre-loaded with Stonesoft NGFW engine software. If you have a Security Engine license, you can configure the engine in any of the three Security Engine roles. If you have a license for a specific type of engine (Firewall/VPN or IPS), you can only use the engine in that specific role.

There are three ways to configure the Stonesoft NGFW engine software.

- **Plug-and-play configuration** — Connect the antennas (some models only) and the network cables to the appliance. The appliance automatically connects to the Installation Server, downloads the initial configuration, and connects to the Management Server.

  **Note:** Uploading the initial configuration to the Installation Server can only be used with Stonesoft NGFW appliances and proof-of-serial codes. It is only supported for Single Firewalls that have a dynamic control IP address.

  **Note:** If the appliance does not have a DSL port and no 3G modem is connected to the appliance, Ethernet port 0 is the only port that can be used.

- **Automatic configuration** — You can configure the engine automatically with a USB drive that contains the initial configuration.

  **Note:** Automatic configuration using a USB drive is primarily intended to be used with Stonesoft NGFW appliances, and might not work in all other environments.

- **NGFW Configuration Wizard** — If you do not want to use plug-and-play configuration or automatic configuration, or they are not possible to use, you can use the NGFW Configuration Wizard.

Before a policy can be installed on the appliance, you must configure some permanent and some temporary network settings for the engine.

To successfully complete the initial configuration:

1. The SMC must be installed.
2. The Security Engine elements (Firewall, IPS, or Layer 2 Firewall elements) must be defined in the Management Client.
3. Engine-specific configuration information must be available from the Management Server. The required information depends on the configuration method.
   - For plug-and-play configuration, the engine’s initial configuration must be uploaded to the Installation Server.
   - For automatic configuration, you must have the initial configuration file on a USB drive.
   - For the NGFW Configuration Wizard, you must have a one-time password for the engine.

The appliance must contact the Management Server before it can be operational.
Using plug-and-play configuration

In plug-and-play configuration, the Stonesoft NGFW appliance automatically connects to the Installation Server, downloads the initial configuration, and connects to the Management Server.

Prepare for plug-and-play configuration

To use plug-and-play-configuration, save the initial configuration and upload it to the Installation Server.

For details about product features, usage, and best practices, click Help or press F1.

1. In the Management Client, select Menu > Configuration > Security Engine.
2. Select Security Engines.
   A list of security engines opens.
3. Right-click the engine for which you want to save the initial configuration and select Configuration > Save Initial Configuration.
   The Save or Upload Initial Configuration dialog box opens.
4. (Optional) If you already have a policy you want to use for the engine, click Select and select a policy as the initial security policy.
   The selected policy is automatically installed on the engine after the engine has contacted the Management Server.
5. (Optional) Select Enable SSH Daemon to allow remote access to the engine command line.
   • Enabling SSH in the initial configuration gives you remote command-line access in case the configuration is imported correctly, but the engine fails to establish contact with the Management Server.
   • After the engine is fully configured, SSH access can be set on or off using the Management Client. We recommend that you enable the SSH access in the Management Client when needed and disable the access again when you are finished. Make sure that your Access rules allow SSH access to the engines from the administrators’ IP addresses only.

   CAUTION: If you enable SSH, set the password for command-line access after the initial configuration either through the Management Client or by logging on to the command line. When the password is not set, anyone with SSH access to the engine can set the password.

6. From the Local Time Zone drop-down list, select the time zone.
   The time zone selection is used only for converting the UTC time that the engines use internally for display on the command line. All internal operations use UTC time, which is synchronized with the Management Server’s time after the engine is configured. For external operations, engines use the time zone of their geographical location.
7. From the Keyboard Layout drop-down list, select the keyboard layout for the engine command line.
8. Select Upload to Installation Server to upload the initial configuration automatically to the Installation Server.
9. Click Close.

You are now ready to configure the Stonesoft NGFW engine software using plug-and-play configuration.

Configure Stonesoft NGFW engine software using plug-and-play configuration

Connect the Stonesoft NGFW to the network to start the plug-and-play configuration.

The Stonesoft NGFW engine’s initial configuration must be uploaded to the Installation Server.

The Stonesoft NGFW appliance uses specific ports in a specific order when it tries to connect to the Installation Server.
Note: Use these default port settings in the properties of the corresponding engine interfaces that you have defined in the Management Client. The initial configuration fails if the port settings on the physical appliance and the interface definitions in the engine element properties are not the same.

Stonesoft NGFW appliances in the Firewall/VPN role first try to contact the Installation Server through the 3G modem if one is connected to a USB port. The 3G modem and the corresponding Modem interface in the Management Client must have the following settings:

- **Access Point Name** — internet
- **Phone number** — *99#
- **PIN Code** — <empty value>

Note: PIN code must also be disabled on the 3G modem.

If attempts to connect to the Installation Server through the 3G modem fail, the appliance tries to connect to the Installation Server through Ethernet port 0. Appliances in the IPS or Layer 2 Firewall role always try to connect to the Installation Server through Ethernet port 0. In the Management Client, the corresponding Physical Interface must have a dynamic IPv4 address.

1. (Optional) If you want to view the progress of the plug-and-play configuration, connect the appliance to a computer using the serial cable supplied with the appliance, and open a terminal with the following settings on the computer: 9600 bps, 8 databits, 1 stopbit, no parity.
2. (Optional) Plug an empty USB drive into one of the USB ports on the appliance if you want to save information about the progress of the plug-and-play configuration on a USB drive.
   Saving the progress information about a USB drive can be useful, for example, for troubleshooting purposes.
3. Connect the network cables to the appliance. On specific Stonesoft NGFW appliance models in the Firewall/VPN role with wireless support, connect the antennas.

Note: The wireless port on Stonesoft NGFW appliances in the Firewall/VPN role cannot be used for connecting to the Installation Server.

The appliance automatically contacts the Installation Server. When the contact succeeds, the appliance downloads the initial configuration from the Installation Server, and contacts the Management Server. The appliance automatically restarts after initial contact with the Management Server.

If plug-and-play configuration fails

If the plug-and-play configuration fails, check for possible causes and solutions.

If you plugged in a USB drive to the appliance, you can check for the reason of the failure in the $\text{sg\_autoconfig.log}$ file on the USB drive.

If you see a “connection refused” error message, make sure that the Management Server IP address is reachable from the engine. Also check the settings that you have defined for the engine’s interfaces in the Management Client. The port numbers and settings must match the interface IDs and other interface settings in the Management Client.

If attempts to connect to the Installation Server through the 3G modem and Ethernet port 0 have failed, the appliance starts the connecting process again. It retries the ports in the same order (3G modem, then Ethernet port 0). If necessary, you can run the command `sg-reconfigure --stop-autocontact` on the engine command line to stop this process.

If plug-and-play configuration continues to fail, save the initial configuration on a USB drive and configure the engine using the automatic configuration method.
Using automatic configuration

In automatic configuration, you configure the engine automatically with a USB drive that contains the initial configuration.

Prepare for automatic configuration

To use automatic configuration, save the initial configuration on a USB drive.

For details about product features, usage, and best practices, click Help or press F1.

1. In the Management Client, select Menu > Configuration > Security Engine.
2. Select Security Engines.
   A list of security engines opens.
3. Right-click the engine for which you want to save the initial configuration and select Configuration > Save Initial Configuration.
   The Save or Upload Initial Configuration dialog box opens.
4. (Optional) If you already have a policy you want to use for the engine, click Select and select a policy as the initial security policy.
   The selected policy is automatically installed on the engine after the engine has contacted the Management Server.
5. From the Local Time Zone drop-down list, select the time zone.
   The time zone selection is used only for converting the UTC time that the engines use internally for display on the command line. All internal operations use UTC time, which is synchronized with the Management Server's time after the engine is configured. For external operations, engines use the time zone of their geographical location.
6. From the Keyboard Layout drop-down list, select the keyboard layout for the engine command line.
7. (Optional) Select Enable SSH Daemon to allow remote access to the engine command line.
   • Enabling SSH in the initial configuration gives you remote command-line access in case the configuration is imported correctly, but the engine fails to establish contact with the Management Server.
   • After the engine is fully configured, SSH access can be set on or off using the Management Client. We recommend that you enable the SSH access in the Management Client when needed and disable the access again when you are finished. Make sure that your access rules allow SSH access to the engines from the administrators’ IP addresses only.

   CAUTION: If you enable SSH, set the password for command-line access after the initial configuration either through the Management Client or by logging on to the command line.
   When the password is not set, anyone with SSH access to the engine can set the password.

8. Click Save As and save the configuration to the root directory of a USB drive, so that the engine can boot from it.

   CAUTION: Handle the configuration files securely. They include the one-time password that allows establishing trust with your Management Server.

9. Click Close.

You are now ready to configure the Stonesoft NGFW engine software using automatic configuration.
Configure Stonesoft NGFW engine software using automatic configuration

Automatic configuration is primarily intended to be used with Stonesoft NGFW appliances, and might not work in all environments when you use your own hardware.

If the automatic configuration does not work, you can still run the NGFW Configuration Wizard as explained in the next section and import or enter the information manually.

When automatic configuration is used, Interface IDs are mapped to network interfaces on the engine in sequential order: Physical Interface ID 0 is mapped to eth0, Physical Interface ID 1 is mapped to eth1, and so forth.

**Note:** The imported configuration does not contain a password for the root account. You must set the password manually in the Management Client before you can log on for command-line access to the engine. See the Stonesoft Next Generation Firewall Product Guide for more information.

1. Make sure that you have a physical connection to the appliance using a monitor and keyboard or a serial cable.
2. Insert the USB drive.
3. Remove the DVD and press Enter at the installation finished prompt.
   The engine restarts, imports the configuration from the USB drive, and makes the initial contact to the Management Server.
   - If the automatic configuration fails, and you do not have a monitor connected, you can check for the reason in the log (sg_autoconfig.log) written on the USB drive.
   - If you see a connection refused error message, make sure that the Management Server IP address is reachable from the node.

The configuration is complete when the appliance successfully contacts the Management Server and restarts.

Configure Stonesoft NGFW engine software with the NGFW Configuration Wizard

You can manually configure the settings for the Stonesoft NGFW engine using the NGFW Configuration Wizard. Settings include network card settings, and the mapping of interface IDs to network interfaces on the engine.

Prepare for NGFW Configuration Wizard configuration

To use the NGFW Configuration Wizard, save the initial configuration on a USB drive or write down the configuration information for manual configuration.

For details about product features, usage, and best practices, click Help or press F1.

1. In the Management Client, select **Menu > Configuration > Security Engine**.
2. Select Security Engines.
3. Right-click the engine for which you want to save the initial configuration and select **Configuration > Save Initial Configuration**.
   The Save or Upload Initial Configuration dialog box opens.
4. If you plan to enter the configuration information manually, click **View Details** and write down or copy the configuration information.
   1. From the One-Time Password field, write down or copy the one-time password for each engine.
Record which password belongs to which engine node.

2. From the Management Sever Addresses field, write down or copy the IP addresses of the Management Server.

3. (Optional) From the Management Server Certificate Fingerprint (MD5) field, write down or copy the MD5 fingerprint of the Management Server's certificate.

4. Click Close.

5. If you plan to import the configuration in the NGFW Configuration Wizard, select the configuration options.
   1. (Optional) If you already have a policy you want to use for the engine, click Select and select a policy. The selected policy is automatically installed on the engine after the engine has contacted the Management Server.
   2. From the Local Time Zone drop-down list, select the time zone.
      The time zone selection is used only for converting the UTC time that the engines use internally for display on the command line. All internal operations use UTC time, which is synchronized with the Management Server's time once the engine is configured. For external operations, engines use the time zone of their geographical location.
   3. From the Keyboard Layout drop-down list, select the keyboard layout for the engine command line.
   4. Select Enable SSH Daemon to allow remote access to the engine command line.
      Enabling SSH in the initial configuration gives you remote command-line access in case the configuration is imported correctly, but the engine fails to establish contact with the Management Server. After the engine is fully configured, you can set SSH access on or off using the Management Client. We recommend that you enable the SSH access in the Management Client when needed and disable the access again when you are finished. Make sure that your Access rules allow SSH access to the engines from the administrators' IP addresses only.

     ⚠️ CAUTION: If you enable SSH, set the password for command-line access after the initial configuration either through the Management Client or by logging on to the command line. When the password is not set, anyone with SSH access to the engine can set the password.

5. Click Save As and save the configuration on a USB drive.

     ⚠️ CAUTION: Handle the configuration files securely. They include the one-time password that allows establishing trust with your Management Server.

6. Click Close.

💡 Tip: Keep the Initial Configuration dialog box open while you configure the Stonesoft NGFW engine software.

You are ready to start the NGFW Configuration Wizard.

**Start the NGFW Configuration Wizard**

Start the NGFW Configuration Wizard to manually configure settings for the Stonesoft NGFW engine.

💡 Tip: You can run the NGFW Configuration Wizard at any time using the `sg-reconfigure` command on the engine command line.

1. If you are configuring a physical device, connect to the Stonesoft NGFW command line.
   1. Connect the Stonesoft NGFW hardware to a computer using a serial cable.
   2. On the computer, open a terminal with the following settings: 9600 bps, 8 databits, 1 stopbit, no parity.
   3. Connect the network cables to the Stonesoft NGFW hardware.
2. Turn on the Stonesoft NGFW hardware.
   The engine startup process is shown in the console.
3. Start the NGFW Configuration Wizard.

Note: On some Stonesoft NGFW appliance models, the NGFW Configuration Wizard starts automatically.

1. Press Enter to activate the console.
2. When you are prompted to start the NGFW Configuration Wizard, type y and press Enter.

4. In the NGFW Configuration Wizard, select the role for the security engine.
   If you have a Security Engine license, you can select any of the Security Engine roles. The role must correspond to the engine element (Firewall, Layer 2 Firewall, or IPS) that you defined in the Management Client. You can later change the engine’s role. If you have a license for a specific type of engine (Firewall/VPN or IPS), select the role that corresponds to the type of license you have.
   1. Highlight Role and press Enter.
   2. Highlight Firewall, IPS, or Layer 2 Firewall, and press Enter.
      The role-specific NGFW Configuration Wizard starts.

5. Select one of the following configuration methods:
   • Highlight Import and press Enter to import a saved configuration.
   • Highlight Next and press Enter to manually configure the engine’s settings.

6. If you have stored the configuration on a USB drive, import the configuration.
   1. Select USB Memory and press Enter.
   2. Select the correct configuration file.
      These files are specific to each engine node.
   3. Highlight Next and press Enter to continue.

Configure operating system settings

Operating system settings include keyboard layout, timezone, and other optional settings.

Some of the settings might be filled in if you imported a configuration as explained earlier (depending on the type of configuration imported).

1. Set the keyboard layout.
   1. Highlight the entry field for Keyboard Layout and press Enter.
   2. Highlight the correct layout and press Enter.
      The keyboard layout setting only applies to hardware that you connect to using a directly connected keyboard and monitor. This setting has no effect if you connect to the hardware only through the serial console port or over the network with SSH.
      If the keyboard layout that you want to use is not listed, use the best-matching available layout, or select US_English.
      Tip: Type the first letter of the keyboard layout to move forward more quickly.

2. Set the engine’s timezone.
   1. Highlight the entry field for Local Timezone and press Enter.
   2. Select the timezone from the list.
      The timezone setting affects only the way the time is displayed on the engine command line. The actual operation always uses UTC time. The engine’s clock is automatically synchronized with the Management Server’s clock.

3. Set the rest of the operating system settings.
   1. Enter the name of the engine.
   2. Enter and confirm the password for the user root.
      This account is the only one with command-line access to the engine.
3. (Optional) Highlight Enable SSH Daemon and press the spacebar to allow remote access to the engine command line using SSH.

   **Note:** Unless you have a specific reason to enable SSH access to the engine command line, we recommend leaving it disabled.

4. (Optional) If you are required to follow the FIPS 140-2 standards, select Restricted FIPS-Compatible Operating Mode.

   **Note:** This option only is for environments that are required to follow the FIPS 140-2 standards. Do not select this option unless you have a specific reason to do so.

5. Highlight Next and press **Enter**. The Configure Network Interfaces page is displayed.

### Configure the network interfaces

The NGFW Configuration Wizard can automatically detect which network cards are in use. You can also add interfaces manually if necessary.

1. **Define the network interface drivers.**
   - If the list is not populated automatically, start the auto-detect.
     1. Highlight Autodetect and press **Enter**.
     2. Check that the autodetected information is correct and that all interfaces have been detected.

   **Tip:** You can use the Sniff option for troubleshooting the network interfaces. Select Sniff on an interface to run network sniffer on that interface.

   If autodetection fails, add network drivers manually.

   1. Highlight Add and press **Enter**.
   2. Select the correct driver for your network card and press **Enter**.

2. **Map interfaces to the IDs you defined.**
   1. Change the IDs as necessary to define how the interfaces are mapped to the Interface IDs you defined for the engine element in the Management Client.
   2. If necessary, highlight the Media column and press **Enter** to change settings to match those used by the device at the other end of the link.

   Make sure that the speed/duplex settings of network cards are identical at both ends of each cable. For IPS and Layer 2 Firewall engines, also make sure that the speed/duplex settings of the inline interfaces match the speed/duplex settings of both links within each inline interface pair.

   3. Highlight the Mgmt column and press the spacebar on your keyboard to select the correct interface for contact with the Management Server.

   **Important:** The Management interface must be the same interface on which the control IP address for the corresponding element is configured in the SMC. Otherwise the engine cannot contact the SMC.

4. (Optional, IPS only) Highlight Initial Bypass and press Enter if you want to set the IPS engine temporarily to the initial bypass state and define one or more soft-bypass interface pairs through which traffic flows.

   Setting the appliance to the initial bypass state can be useful during IPS appliance deployment if bypass network interface pairs on the appliance are in the Normal mode. Initial bypass allows traffic to flow through the IPS appliance until the initial configuration is ready and an IPS policy is installed on the appliance. Do not set the initial bypass state when the bypass network interface pairs are in the Bypass mode.
Contact the Management Server

Provide the necessary information to allow the Stonesoft NGFW engine to establish contact with the Management Server.

Before the engine can make initial contact with the Management Server, you activate an initial configuration on the engine. The initial configuration contains the information that the engine requires to connect to the Management Server for the first time.

If the initial configuration was imported from a USB drive, most of the options on the Prepare for Management Contact page are filled in.

**Important:** If there is a firewall between this engine and the Management Server, make sure that the intermediate firewall’s policy allows the initial contact and all subsequent communications.

1. If the control IP address is dynamic, select DHCPv4, SLAAC (IPv6), or DHCPv6.

   **Note:** The same protocol must be selected in the IP address properties in the Management Client.

2. If the Stonesoft NGFW engine uses PPP for management contact, define PPP settings.
   1. Highlight Settings and press Enter.
   2. On the PPP Settings page, fill in the account details according to the information you have received from your service provider.
   3. Highlight OK and press Enter.

3. If the Stonesoft NGFW engine uses a modem for management contact, define the modem settings.
   1. Highlight Settings and press Enter.
   2. On the Modem Settings page, fill in the account details according to the information you have received from your service provider.
   3. Highlight OK and press Enter.

4. If the control IP address is static, select Enter node IP address manually and define the IP address of the Stonesoft NGFW node.
   1. In the IP Address field, enter the IP address.
   2. In the Netmask/Prefix Length field, enter the netmask (IPv4) or prefix length (IPv6) of the network.
   3. If the Management Server is not in a directly connected network, enter the IP address of the next-hop gateway in the Gateway to management field.

5. If the control IP address is on a VLAN interface, select Use VLAN, Identifier and enter the VLAN ID.

6. Select Contact or Contact at Reboot and press the spacebar.

7. Enter the Management Server IP address and the one-time password.

   **Note:** The one-time password is engine-specific and can be used only for one initial connection to the Management Server. After initial contact has been made, the engine receives a certificate from the SMC for identification. If the certificate is deleted or expires, repeat the initial contact using a new one-time password.

8. (Optional) To use 256-bit encryption for the connection to the Management Server, select 256-bit Security Strength and press the spacebar.

   **Note:** 256-bit encryption must also be enabled for the Management Server.

9. (Optional) Highlight Edit Fingerprint and press Enter. Fill in the Management Server’s certificate fingerprint (also shown when you saved the initial configuration).

   Filling in the certificate fingerprint increases the security of the communications.


    The engine now tries to make initial Management Server contact. The progress is displayed on the command line. If you see a “connection refused” message, make sure that the one-time password
is correct and the Management Server IP address is reachable from the node. Save a new initial configuration if you are unsure about the password.

**Note:** If the initial management contact fails for any reason, you can start the configuration again with the `sg-reconfigure` command.

After you see a notification that Management Server contact has succeeded, the engine installation is complete and the engine is ready to receive a policy. The initial configuration does not contain any working policy. You must install a policy on the engine using the Management Client to make it operational. The engine element’s status changes in the Management Client from **Unknown** to **No Policy Installed**. The connection state is **Connected**, indicating that the Management Server can connect to the node.

**Related information**

- [Default communication ports](#) on page 135
- There are default ports used in connections between SMC components and default ports that SMC components use with external components.
Stonesoft NGFW engine post-installation tasks

After successfully configuring the Stonesoft NGFW engine software and establishing contact between the Stonesoft NGFW engines and the Management Server, the engine is left in the initial configuration state. Now you must define basic routing and policies.

Configuring routing and basic policies

Define basic routing and policies using the Management Client.

Configuring routing

Routes to directly connected networks are automatically added according to the interfaces defined for each engine. You must add some other routes manually.

**Note:** Master Engines proxy all communication between Virtual Security Engines and other SMC components. You do not need to configure routing for Virtual Firewalls, Virtual IPS engines, or Virtual Layer 2 Firewalls.

You must add the following routes for firewalls:

- The default route that packets to any IP addresses not included in the routing configuration take. The default route always leads to the Internet if the site has Internet access.
- Routes through next-hop gateways to networks that are not directly connected to the engine.

**Note:** Interfaces that belong to an aggregated link on a firewall have the same network definitions. Only the first interface selected for the aggregated link is shown in the list of interfaces. For aggregated links in load-balancing mode, make sure that the router supports the Link Aggregation Control Protocol (LACP), and that LACP is configured on the router.

The routing information for IPS engines and Layer 2 Firewalls is only used for system communications. The inspected traffic is not routed. Inline interfaces are always fixed as port pairs: traffic that enters through one port is automatically forwarded to the other port.

Most often only one or two simple tasks are required to define routing information for IPS and Layer 2 Firewall elements:

- Add the default route. This route is the one that packets to any IP addresses that are not included in the routing configuration take.
- Add routes to your internal networks that are not directly connected to the IPS or Layer 2 Firewall if the networks cannot be reached through the default gateway.

Routing is configured using the following elements:

- Network elements represent a group of IP addresses.
- Router elements represent next-hop routers that are used for single-link routing and to represent the ISP routers inside NetLink elements.
- NetLink elements represent next-hop routers that are used for Multi-Link routing on firewalls. In Multi-Link routing, traffic is automatically distributed between two or more (usually Internet) connections.
Add a default route for a single network link

Add a default route using a single network connection.

For Stonesoft NGFW engines in the IPS and Layer 2 Firewall roles, you only need to define a default route if the SMC components are not on a directly connected network.

For details about product features, usage, and best practices, click Help or press F1.

1. In the Management Client, select Home.
2. Expand the Engines branch and browse to the engine element.
3. Right-click the engine element and select Edit <element type>. The Engine Editor opens.
4. In the navigation pane on the left, browse to Routing.
5. Expand the routing tree to view routing information for the interfaces.

   **Tip:** Click the Tools icon and select Expand All if you want to view the full routing information for all interfaces.

6. Add a next-hop router to the interface through which you want to create a default route.
   1. Right-click the Network element and select Add Router.
   2. In the Name field, enter a unique name.
   3. In the IP Address field, enter the IP address of the router.
   4. Click OK.
7. Right-click the Router element and select Set as Default Route. The default element “Any Network” is added to the interface.
8. Click Save to save and validate changes.

Add a default route for firewalls with Multi-Link

Add a default route for firewalls that use Multi-Link for multiple network connections.

For details about product features, usage, and best practices, click Help or press F1.

1. Open the routing configuration for the engine.
   1. In the Management Client, select Home.
   2. Expand the Engines branch and browse to the engine element.
   3. Right-click the Firewall, Master Engine, or Virtual Firewall element and select Edit <element type>. The Engine Editor opens.
   4. In the navigation pane on the left, browse to Routing.
   5. Expand the routing tree to view routing information for the interfaces.

   **Tip:** Click the Tools icon and select Expand All if you want to view the full routing information for all interfaces.

2. To create a NetLink element, right-click the network under an interface that is used as one of the default routes (to the Internet), then select Add Static NetLink or Add Dynamic NetLink.
4. In the Name field, enter a name for the NetLink.
5. (Static NetLink only) From the Gateway drop-down list, select a gateway.
6. (Static NetLink only) Click Select next to the Network list.
7. (Static NetLink only) Select Networks, then select a network.

   To create a network:
   1. Select Tools > New > Network.
   2. In the Name field, enter a name for the network.
   3. In the IPv4 Address or IPv6 Address field, enter the IP address of the network.
   4. In the Netmask or Prefix Length field, enter the netmask or the prefix length (0-128).
5. (Optional) Select Broadcast and network addresses included to include broadcast and network addresses in the network.

6. Click OK.

7. Select the network that you created, then click Select.

8. (Optional) In the Provider Name field, enter the name of the service provider for your own reference.

9. Click OK.

10. To add the default route for Multi-Link, right-click the NetLink and select Set as Default Route. This inserts the default element Any Network.

1. The Internet is behind these interfaces.

In the illustration, internal networks are connected to the Internet using two Internet connections. It makes no difference which interfaces are internal and which are external. The Firewall Policy defines which traffic is allowed.

Note: The configuration outlined is only a part of the Multi-Link configuration. For complete steps required for a fully featured Multi-Link configuration, see the Stonesoft Next Generation Firewall Product Guide.

Add other routes

The networks that are directly connected to the engine are automatically added to the Routing view. However, you might also need to add routes to networks that are not directly connected.

For Stonesoft NGFW engines in the IPS and Layer 2 Firewall roles, you only need to add other routes if one or more SMC components are not directly connected and cannot be reached through the default gateway.

For details about product features, usage, and best practices, click Help or press F1.

1. In the Management Client, select Home.

2. Expand the Engines branch and browse to the engine element.

3. Right-click the engine element and select Edit <element type>. The Engine Editor opens.

4. In the navigation pane on the left, browse to Routing.

5. Expand the routing tree to view routing information for the interfaces.
6. In the Routing Tools pane at the bottom of the Routing pane, click the Add Route tab.
7. In the Destination field, enter an IP address.

   **Tip:** You can also double-click the field, then select a destination device.

8. In the Gateway field, enter an IP address.

   **Tip:** You can also double-click the field, then select a gateway device.

9. Click Add.
   The route is added to the configuration.

10. Click \(\mathbf{\text{Save}}\) to save and validate changes.

### Antispoofing

Spoofing an IP address means that someone uses the IP address of some legitimate (internal) host to gain access to protected resources.

Spoofing can be prevented with antispoofing entries. The antispoofing configuration is automatically generated based on the routing information of engines. By default, connection attempts with a source IP address from a certain internal network are only allowed through if they are coming from the correct interface as defined in the routing tree. As the routing entry is needed for the communications to work, antispoofing rarely needs additional modifications.

You can make exceptions for individual hosts to the automatically generated antispoofing configuration. For more information, see the *Stonesoft Next Generation Firewall Product Guide*.

### Defining basic policies for firewalls

To get your firewall up and running, create rules for inspecting traffic.

In addition to the rules in the policy, the other configuration information is also transferred to the firewall when you install a policy. (This information includes the interface definitions and routing information).

### Create a Firewall Policy

Create a basic policy for firewalls.

For details about product features, usage, and best practices, click Help or press F1.

1. Select \(\mathbf{\text{Configuration}}\).
2. Right-click Policies and select New > Firewall Policy.
3. In the Name field, enter a name for the Policy.
4. Select the Firewall Template as the template.
   Only the Firewall Template is available because you have not created other templates yet.
5. Click OK.
   The policy opens for editing.
6. To add a rule, double-click the green row, or right-click the row and select Rule > Add Rule.

   **Note:** Inherited rules are not editable in the policy that inherits the rules.

7. Click the Save and Install icon to save the policy and transfer the changes to the engine.
8. Select one or more engines, then click Add.
9. Leave Validate Policy Before Upload selected if you want to validate the rules in the policy.
If you validate the rules and the routing configuration at policy installation, the issues found in the policy are displayed in a separate pane in the tab that opens to show the progress of the policy installation.

10. Click OK.

Example: Adding a ping rule

This example shows how to add Access rules and NAT rules to track ping connections.

By default, the engine maintains connection tracking information about connections allowed by a rule. You only have to add rules for allowing the opening of connections. After the connection is opened, reply packets that belong to that connection are allowed through if they are appropriate for the state of that particular connection. A second rule is only needed if connection opening must be allowed from the other end as well.

For the ping rule in this example, the replies to pings made by the Test host are allowed through automatically. However, if someone else tries to ping the Test host through the engine, the connection is blocked.

Note: Multi-Link load balancing requires additional configuration and a specific type of NAT rule. See the Stonesoft Next Generation Firewall Product Guide for information.

1. Open your Firewall Policy for editing.
   2. Click Firewall Policies. A list of Firewall policies opens.
   3. Right-click your Firewall Policy element and select Edit Firewall Policy.
2. On the IPv4 Access tab, right-click the ID cell and select Add Rule Before or Add Rule After. A rule is added to the policy.
3. Create a Host element.
   1. Click the Source cell of the new rule. A list of elements opens in the Resources pane on the left.
   2. Right-click Network Elements and select New > Host. The Host Properties dialog box opens.
   3. In the Name field, enter TEST host.
   4. In the IPv4 Address field, enter the IPv4 address of the Host.
   5. Click OK.
4. Click the Source cell and begin typing TEST host. When the correct element is found, select it from the list.
5. Right-click the Destination cell and select Set to ANY.
6. Click the Service cell and type Ping. When the correct element is found, select it from the list.
7. Right-click the Action cell and select Allow.
8. (Optional) Add a NAT rule for the ping rule.
   1. Right-click the IPv4 Access rule you created and select Copy Rule.
   2. On the IPv4 NAT tab, right-click the green row and select Paste.

Tip: A NAT rule with the same source, destination, and service as the IPv4 Access rule is added.

3. Right-click the NAT cell and select Edit NAT. The Network Address Translation dialog box opens.
4. Select Static as the Translation Type.
5. Click Address and enter the public IP address of the Test host.

Tip: The original IP address is the content of the Source cell in the NAT rule because this rule defines source address translation. There is no need to specify that the destination address in the reply packets must be translated back to the Test host’s private IP address. This return translation is done automatically. The static translation used in this rule is only practical for a few hosts. Dynamic translation is more suitable for many translations, such as for Internet access for the whole office network.

6. Click OK.
9. Save and install the policy.
1. Click the Save and Install icon to save the policy and transfer the changes to the engine.
2. Select the correct engine.
3. Click Add.
4. If you want to validate the rules in the policy, leave Validate Policy Before Upload selected.

**Tip:** If you validate the rules and the routing configuration at policy installation, the issues found in the policy are displayed in a separate pane in the tab that opens to show the progress of the policy installation.

5. Click OK.

### Installing the initial policy for IPS engines and Layer 2 Firewalls

To be able to inspect traffic, the engines must have a policy installed on them.

Installing one of the predefined policies provides an easy way to begin using the system. You can then fine-tune the system as needed. The following table describes the default policy elements for IPS engines and Layer 2 Firewalls.

#### Table 12: Default Policy elements

<table>
<thead>
<tr>
<th>Element type</th>
<th>Default element name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPS Template Policy</td>
<td>High-Security IPS Template</td>
<td>IPS Template Policy that uses Inspection rules from the High-Security Inspection Template.</td>
</tr>
<tr>
<td></td>
<td>A Template Policy containing the predefined Access rules necessary for the IPS engine to communicate with the SMC and some external components.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The High-Security IPS Template Policy provides an easy starting point for determining what kinds of rules your system needs.</td>
<td></td>
</tr>
<tr>
<td>IPS Template Policy</td>
<td>Medium-Security IPS Template</td>
<td>IPS Template Policy that uses Inspection rules from the Medium-Security Inspection Policy.</td>
</tr>
<tr>
<td>IPS Policy</td>
<td>Customized High-Security Inspection IPS Policy</td>
<td>Example of a customized IPS Policy that uses Inspection rules from the Customized High-Security Inspection Template. Used in testing Stonesoft NGFW in the IPS role at ICSA Labs and NSS Labs.</td>
</tr>
<tr>
<td></td>
<td>Default IPS Policy</td>
<td>Basic IPS Policy that uses Inspection rules from the High-Security Inspection Template. Can be used as a starting point for creating a customized IPS Policy.</td>
</tr>
<tr>
<td></td>
<td>The Default IPS Policy does not add any rules to the rules defined in the IPS Template. It allows you to install the predefined rules in the IPS Template on the IPS engine right after installation. (Template Policies cannot be installed on the engines.)</td>
<td></td>
</tr>
<tr>
<td>Layer 2 Firewall Template Policy</td>
<td>Layer 2 Firewall Template</td>
<td>A Template Policy that contains the predefined Access rules necessary for the Layer 2 Firewall to communicate with the SMC and some external components.</td>
</tr>
<tr>
<td>Element type</td>
<td>Default element name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Layer 2 Firewall Inspection Template</td>
<td>Layer 2 Firewall Inspection Template</td>
<td>A Template Policy that is based on the Layer 2 Firewall Template. The Layer 2 Firewall Inspection Template uses Inspection rules from the High-Security Inspection Template. The Layer 2 Firewall Inspection Template enables deep inspection for all traffic.</td>
</tr>
<tr>
<td>Inspection Policy</td>
<td>No Inspection Policy</td>
<td>Suitable for Firewall deployments, in which only packet filtering is needed. Disables deep packet inspection.</td>
</tr>
<tr>
<td>Medium-Security Inspection Template</td>
<td>Medium-Security Inspection Template</td>
<td>For Firewalls, Layer 2 Firewalls, inline IPS deployments in asymmetrically routed networks, and IPS deployments in IDS mode. Terminates reliably identified attacks and logs Situations that have some degree of inaccuracy. Low risk of false positives.</td>
</tr>
<tr>
<td>High-Security Inspection Template</td>
<td>High-Security Inspection Template</td>
<td>For Firewall, Layer 2 Firewall, and inline IPS use. Extended inspection coverage and evasion protection. Not for asymmetrically routed networks. Terminates reliably identified attacks, and Situations that have some inaccuracy. Moderate false positive risk.</td>
</tr>
<tr>
<td>Customized High-Security Inspection Policy</td>
<td>Customized High-Security Inspection Policy</td>
<td>This policy is an example of a highly customized Inspection Policy for network environments in which unconditional inspection coverage and evasion protection are required. The risk of false positives is high in production use.</td>
</tr>
</tbody>
</table>

The default policy elements are introduced when you import and activate a recent dynamic update package (for example, during the installation). The elements might change when you install newer update packages. None of the default policy elements can be changed. However, you can make copies of the default policies if you create an edited version. See the Stonesoft Next Generation Firewall Product Guide for more information about the predefined policies and templates.

Install a ready-made policy for IPS engines and Layer 2 Firewalls

Install a ready-made policy on your IPS engine or Layer 2 Firewall.

For details about product features, usage, and best practices, click ? or Help.

1. Select Configuration.
2. Expand the Policies branch and select IPS Policies or Layer 2 Firewall Policies.
3. Right-click one of the ready-made policies and select Install Policy.
   The Policy Upload Task Properties dialog box opens.
4. Select one or more engines, then click Add.
   The selected engines are added to the Target list.
5. Click OK.
   A new tab opens to show the progress of the policy installation.
6. Check that the policy installation is successful.
When you install a policy, all rules in the policy and all IPS engine’s or Layer 2 Firewall’s other configuration information (including interface definitions and routing information) are transferred to the engines.

Monitor and command Stonesoft NGFW engines

Check system status and give commands to engines.

After a successful policy installation, your system is ready to process traffic. You can control the engines using the right-click menu.

For details about product features, usage, and best practices, click Help or press F1.

1. Click the Home icon in the toolbar.
2. Check the status of the engines and SMC.

**Tip:** You can select an element to view more information about it in the Info pane.

3. Use the Commands right-click menu to command engines.

**Note:** Depending on the selection in the tree, you can give commands individually for each node, for a selected group of nodes, for a whole cluster, or several engines at the same time.

To continue setting up your system, see the Stonesoft Next Generation Firewall Product Guide.
To maximize the benefit of Stonesoft NGFW, upgrade the SMC and Stonesoft NGFW regularly.
Maintaining the SMC

When there is a new version available, upgrade the SMC before upgrading Stonesoft NGFW engines.

Upgrading the SMC

You can upgrade SMC components without uninstalling the previous version. Before upgrading, read the Release Notes.

It is important to upgrade the SMC components before upgrading the engines. An old SMC version might not be able to recognize the new version engines and can generate an invalid configuration for them. The Management Server can control several older versions of engines. See the release notes for version-specific compatibility information.

**CAUTION:** All SMC components (Management Server, Management Client, Log Server, and the optional Web Portal Server) must use the same software version to be able to work together. Plan ahead before upgrading the components. If you have multiple Management Servers and Log Servers, you must upgrade each server separately.

The Stonesoft NGFW engines do not require a continuous connection to the SMC and they continue to operate normally during the SMC upgrade. The engines temporarily store their logs locally if the Log Server is unavailable and then send them to the Log Server as it becomes available again.

For more detailed instructions, see the Stonesoft Next Generation Firewall Product Guide.

Configuration overview

1. Obtain the installation files and check the installation file integrity.
2. (If automatic license upgrades have been disabled) Upgrade the licenses.
3. Upgrade all components that work as parts of the same SMC.
4. Upgrade any locally installed Management Clients by running the Stonesoft Management Center installer and any Web Start distributions that are on an external server.

**Related concepts**
Upgrading licenses for SMC components on page 123
You must upgrade the license if you upgrade a component to a new major release.

**Related tasks**
Upgrade SMC servers on page 125
You can upgrade SMC servers without uninstalling the previous version. A change in the Management platform, such as a new operating system or different hardware, requires reinstalling the SMC.

Upgrading licenses for SMC components

You must upgrade the license if you upgrade a component to a new major release.

A change in the first two digits of the version number indicates a major release (for example, from 1.2.3 to 1.3.0, or from 1.2.3 to 2.0.0). If only the last number changes, the existing license is also valid for the higher software version.

When you installed the SMC for the first time, you installed licenses that work with all versions up to that particular version. Each license indicates the highest version for which the license is valid, but the license is also valid for all lower software versions.
If you do not need to upgrade licenses, upgrade the SMC.

**Related tasks**

**Upgrade SMC servers** on page 125

You can upgrade SMC servers without uninstalling the previous version. A change in the Management platform, such as a new operating system or different hardware, requires reinstalling the SMC.

**Upgrade licenses manually**

If you have not enabled automatic license upgrades in the Management Server properties, upgrade licenses manually through the Management Client.

Licenses are valid for any older software versions in addition to the version indicated on the license. You can upgrade the licenses at any time without affecting the system’s operation.

**Note:** IP-address-bound licenses have been previously available for Firewalls and IPS engines. You can use and update a previously generated IP-address-bound engine license, but you must switch the license binding to the Management Server’s POL code if the engine’s control IP address changes.

For details about product features, usage, and best practices, click Help or press F1.

1. Select **Menu > Configuration > Administration.**
2. Expand the **Licenses** branch, then browse to the type of licenses that you want to upgrade.
3. Select the licenses you want to upgrade.
4. Right-click one of the selected items, then select **Export License Info.**
5. Select where you want to save the license file.
   You are prompted to request a license upgrade.
6. Click **Yes.**
8. In the **License Identification** field, enter the POL or POS code, then click **Submit.**
9. If you have only one license to upgrade: Under the license information, click **Update.** Otherwise, continue to the next step.
10. Click the **Multi-Upgrade Licenses** link on the right.
11. Enter any information needed for the upgrade request, then select or upload the license files to update.
12. To upload the license request, click **Submit.**
   A confirmation page opens, showing the details of your request. The upgraded licenses are emailed to you in a .zip file.

**Install licenses**

After you have upgraded the licenses, install the license in the Management Client.

For details about product features, usage, and best practices, click Help or press F1.

1. In the Management Client, select **Menu > File > System Tools > Install Licenses.**
2. Select the license files and click **Install.**
3. Select **Menu > Configuration > Administration.**
4. Browse to **Licenses > All Licenses.**
5. Check that the licenses have now been correctly upgraded to the new version.

**Tip:** When you only upgrade the software version in the license, old licenses are automatically replaced.
Upgrade SMC servers

You can upgrade SMC servers without uninstalling the previous version. A change in the Management platform, such as a new operating system or different hardware, requires reinstalling the SMC.

⚠️ **CAUTION:** All SMC components (Management Server, Management Client, Log Server, and the optional Web Portal Server) must use the same SMC software version to work together. If you have multiple Management Servers or Log Servers, you must upgrade each server separately.

The same installer works with all SMC components, including locally installed Management Clients. If you have multiple Management Servers or Log Servers, you can upgrade them in any order. Management Servers are automatically isolated from database replication during the upgrade. There is no need to explicitly isolate the Management Servers before upgrading.

If you are upgrading from a very old version of the SMC, you might have to upgrade to an intermediate version first before upgrading to the latest version. See the Release Notes.

For details about product features, usage, and best practices, click Help or press F1.

1. Start the installation in one of the following ways:
   - **From a .zip file** — Unzip the file, then run setup.exe on Windows or setup.sh on Linux.
   - **From a DVD** — Insert the installation DVD, then run the setup executable from the DVD.

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Path to executable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 64-bit</td>
<td>\Forcepoint_SMC_Installer\Windows-x64\setup.exe</td>
</tr>
<tr>
<td>Linux 32-bit</td>
<td>/Forcepoint_SMC_Installer/Linux/setup.sh</td>
</tr>
<tr>
<td>Linux 64-bit</td>
<td>/Forcepoint_SMC_Installer/Linux-x64/setup.sh</td>
</tr>
</tbody>
</table>

   **Note:** If the DVD is not automatically mounted in Linux, mount the DVD with “mount /dev/cdrom /mnt/cdrom”.

2. To continue with the installation, read and accept the License Agreement. The Installation Wizard automatically detects the previous installation directory.
3. To accept the installation directory, click Next. The Installation Wizard displays the components to be upgraded.
4. (Management Server only, optional) To save a copy of the current installation that you can revert to at any time after the upgrade, select Save Current Installation.
5. Click Next.
6. (Management Server only) Select whether to back up the server, then click Next:
   - To create a backup that can be used and viewed without a password, select Yes.
   - To create a password-protected backup, select Yes, encrypt the backup. You are prompted for the password as you confirm the selection.
   - If you already have a recent backup of the Management Server, select No.
7. Check the preinstallation summary, then click Install. The upgrade begins.
8. (Optional) When the upgrade is complete, click the links in the notification to view the reports of changes the installer has made. The report opens in your web browser.
9. To close the installer, click Done.
10. Upgrade any SMC components that run on other computers (for example, additional Management Servers or Log Servers) in the same way.
11. (Multiple Management Servers only) Synchronize the management database between the Management Servers.
Synchronize databases between active Management Server and additional Management Servers

You must synchronize the configuration information manually through the Management Client after upgrading the Management Servers or after restoring a backup.

There must be a route between the Management Client and the Management Servers. If there is no route between the Management Client and the Management Servers, you cannot send a command through the Control Management Servers dialog box.

Manual management database synchronization is primarily meant for resynchronizing the databases after upgrading the SMC. We do not recommend using manual database synchronization unless you have a specific need to do so.

For details about product features, usage, and best practices, click Help or press F1.

1. Connect to the active Management Server using the Management Client.
3. If the Management Client is in a different network than the additional Management Server, select the Location from which to send the command.
   This action ensures that the command is sent to the correct Contact Address for the Management Server.
4. For each additional Management Server that you want to synchronize:
   1. Right-click the Management Server and select Replication > Full Database Replication. You are prompted to confirm the replication.
   2. Click Yes. All existing configurations on the additional Management Server are overwritten.
   3. Click OK to acknowledge the completion of the synchronization and wait for the Management Server to restart.
      After the Management Server has restarted, its Replication Status is updated in the Control Management Servers dialog box.
5. Click Close to close the Control Management Servers dialog box.

Uninstall the SMC

Usually, it is not necessary to uninstall the SMC. You can uninstall the SMC if you have a specific need to do so.

Note: If you have several SMC components installed on the same computer, you cannot uninstall the SMC components one by one.

By default, the SMC is installed in the following directories:

- Windows — C:\Forcepoint\Stonesoft Management Center
- Linux — /usr/local/forcepoint/smcf

There is a .stonegate directory in each user’s home directory in the operating system, which contains the Management Client configuration files. These files are not automatically deleted. You can delete them manually after the uninstallation.

The sgadmin account is deleted during the uninstallation of the SMC.

Tip: Back up the Management Server and the Log Server to an external system before uninstalling the SMC if you want to preserve the stored data.
Uninstall the SMC in Windows

Use this process to uninstall the SMC in a Windows environment.

1. Start the uninstaller in one of the following ways:
   - Open the list of installed programs through the Windows Control Panel, right-click Forcepoint Stonesoft Management Center, and select Uninstall/Change.
   - Alternatively, run the script `<installation directory>/uninstall/uninstall.bat`.

2. When the uninstaller opens, click Uninstall.
   All Stonesoft Management Center components are uninstalled.

Uninstall the SMC in Linux

Use this process to uninstall the SMC in a Linux environment.

You can uninstall the SMC in graphical mode or in non-graphical mode.

1. Stop the Stonesoft Management Center components on the computer.
2. Run the uninstaller script.
   - To uninstall in graphical mode, run the script `<installation directory>/uninstall/uninstall.sh`.
   - To uninstall in non-graphical mode, run the script the script `<installation directory>/uninstall/uninstall.sh -nodisplay`.

3. (Graphical mode only) When the uninstaller starts, click Uninstall.
   All SMC components are uninstalled.
Upgrading Stonesoft NGFW engines

When there is a new version of the Stonesoft NGFW software, upgrade the Stonesoft NGFW engines as soon as possible.

How engine upgrades work

You can remotely upgrade engines using the Management Client or locally on the engine command line.

The upgrade package is imported to the Management Server manually or automatically. Before the import, the Management Server verifies the digital signature of the upgrade package using a valid Trusted Update Certificate. The signature must be valid for the import to succeed. Verification might fail for the following reasons:

- The SMC version is out of date. Upgrade the SMC before upgrading the engines.
- A signature is invalid or missing in the upgrade files. Obtain an official upgrade package.

After the upgrade package has been imported, you can apply it to selected engines through the Management Client. Before the upgrade is installed on the engines, the Management Server again verifies the digital signature of the upgrade package.

The engines have two alternative partitions for the software. When you install a new software version, it is installed on the inactive partition and the current version is preserved. This configuration allows rollback to the previous version in case there are problems with the upgrade. If the engine is not able to return to operation after the upgrade, it automatically switches back to the previous software version at the next restart. You can also switch the active partition manually.

You can upload and activate the new software separately. For example, you can upload the upgrade during office hours but activate it during a service window.

The currently installed working configuration (routing, policies) is stored separately and is not changed in an upgrade or a rollback. Although parts of the configuration can be version-specific (for example, if system communications ports are changed), the new software version can use the existing configuration. Possible version-specific adjustments are made when you refresh the policy after the upgrade.

Limitations

It is not possible to upgrade between a 32-bit version and a 64-bit version of the software. If you are running the software on third-party hardware, you can reinstall the software using the other version. In clusters, 32-bit and 64-bit nodes cannot be online simultaneously. Appliances support only the software architecture version that they are preinstalled with.

You cannot upgrade Virtual Security Engines directly. To upgrade Virtual Security Engines, you must upgrade the Master Engine that hosts the Virtual Security Engines.

What do I need to know before I begin?

The SMC must be up to date before you upgrade the engines. An old SMC version might not be able to recognize the new version engines and can generate an invalid configuration for them. The Management Server can control several older versions of engines. See the Release Notes for version-specific compatibility information.

During a cluster upgrade, it is possible to have the upgraded nodes online and operational side by side with the older version nodes. This way, you can upgrade the nodes one by one while the other nodes handle the traffic. However, you must upgrade all nodes to the same version as soon as possible, as prolonged use with mismatched versions is not supported.

The current engine version is displayed on the General tab in the Info pane when you select the engine. If the Info pane is not shown, select Menu > View > Panels > Info.
Beginning from version 5.9, all Stonesoft Next Generation Firewall licenses include the anti-malware feature by default.

Configuration overview

Follow these general steps to upgrade engines:
1. (Manual download of engine upgrade files) Prepare the installation files.
2. (Manual license updates) Update the licenses.
3. Upgrade the engines.

Obtain Stonesoft NGFW engine upgrade files

If the Management Server is not set up to download engine upgrades automatically or if you want to upgrade engines locally, download the installation files manually.

Check the installation file integrity using the MD5 or SHA-1 file checksums. Windows does not have MD5 or SHA-1 checksum programs by default, but there are several third-party programs available.

2. Select Patches and Downloads.
   The Full Product Downloads and Updates page opens.
3. Select Next Generation Firewall Downloads.
   The License Center page opens.
4. Log on to the License Center.
5. In the License Identification field, enter the Proof-of-License (POL) or Proof-of-Serial (POS) code and click Submit.
   The Security Engine Downloads page opens.
7. Download the installation file.
   There are two types of packages available:
   • The .zip file is used in the remote upgrade on all supported platforms. It can also be used for a local upgrade from a USB drive or a non-bootable DVD.
   • The .iso download allows you to create a bootable installation DVD for a local upgrade on platforms that have an optical drive.
8. Change to the directory that contains the files to be checked.
9. (Linux only) Generate a checksum of the file using the command `md5sum filename` or `sha1sum filename`, where file name is the name of the installation file.
   For Windows, see the documentation for the third-party checksum program.
   Example:
   
   ```
   $ md5sum sg_engine_1.0.0.1000.iso
   869aecd7dc39321aa2e0cfa87af8b8f_sg_engine_1.0.0.1000.iso
   ```
10. Compare the displayed output to the checksum on the website.

   **CAUTION:** Do not use files that have invalid checksums. If downloading the files again does not help, contact Forcepoint support to resolve the issue.

Prepare a downloaded .zip file for a remote upgrade.

1. Log on to the Management Client and select ☰ Menu > File > Import > Import Engine Upgrades.
2. Select the engine upgrade (sg_engine_version_platform.zip) file and click Import.
   The status bar at the bottom of the Management Client window shows the progress of the import.
Note: The Management Server verifies the digital signature of the .zip file before importing it. The signature must be valid for the import to succeed. If the verification fails, an error message is shown. Verification failure can result from an out-of-date SMC version or an invalid or missing signature.

Prepare a downloaded .zip file for a local upgrade.

Copy the file to the root directory of a USB drive or a DVD.

Prepare a downloaded .iso file for a local upgrade.

Create the installation DVD for the engines with a DVD-burning application that can correctly read and burn the DVD-structure stored in the .iso images. If the end result is a DVD file with the original .iso file on it, the DVD cannot be used for installation.

If you are sure that you do not need to upgrade your licenses, upgrade the SMC, firewalls, IPS engines, Layer 2 Firewalls, or Master Engines. Continue in one of the following ways:

• Upgrade the engines remotely through the Management Server.
• Upgrade the engine locally at the engine site.

Otherwise, upgrade or generate licenses.

Related tasks
Upgrade engines remotely on page 132
The Management Server can remotely upgrade engine components that it manages.
Upgrade engines locally on page 133
You can upgrade the engines on the engine command line.

Upgrading or generating licenses for Stonesoft NGFW engines

In some cases, you must upgrade licenses when you are upgrading an engine.

When you installed the engine software for the first time, you installed licenses that work with all versions of the engine up to that particular version. If the first two numbers in the old and the new versions are the same, the upgrade can be done without upgrading licenses (for example, when upgrading from 1.2.3 to 1.2.4). When either of the first two numbers in the old version and the new version are different, you must first upgrade your licenses (for example, when upgrading from 1.2.3 to 1.3.0). By default, licenses are regenerated and installed automatically.

You can view and download your current licenses online at https://ngfwlicenses.mcafee.com/managelicense.do. You can also upgrade the licenses.

If you do not need to upgrade licenses, upgrade the engines.

If you need new licenses and you want to upgrade the licenses one at a time, upgrade licenses under one proof code.

If you need new licenses and you want to upgrade several licenses at the same time, upgrade licenses with multiple proof codes.

Related tasks
Upgrade engines remotely on page 132
The Management Server can remotely upgrade engine components that it manages.
Upgrade engines locally on page 133
You can upgrade the engines on the engine command line.

Upgrade licenses under one proof code

A license generated under one proof-of-license (POL) or proof-of-serial (POS) code can contain the license information for several components.

Tip: You can also use the multi-upgrade form to upgrade the licenses.

2. Enter the POL or POS code in the License Identification field and click Submit.
   The License Center page opens.
3. Click Update.
   The License View page opens.
4. Follow the directions to upgrade the license.

Upgrade licenses with multiple proof codes

If you have several existing licenses with different proof-of-license (POL) or proof-of-serial (POS) codes to upgrade, generate all new licenses at the same time.

For details about product features, usage, and best practices, click Help or press F1.

1. Select  Menu > Configuration > Administration.
2. Browse to Licenses > Firewall, Licenses > Security Engines, or Licenses > IPS depending on the type of licenses you have.
3. Select the licenses you want to upgrade.
4. Right-click one of the selected items and select Export License Info.
   The Save License Upgrade Request dialog box opens.
5. Select the location at which to save the license file in the dialog box that opens.
   You are prompted to request a license upgrade.
6. Click Yes.
   The website opens.
8. Enter the POL or POS code in the License Identification field and click Submit.
   The License Center page opens.
9. Click the Multi-Upgrade Licenses link on the right.
   The Upload Multi-Upgrade Licenses page opens.
10. Enter the information needed for the upgrade request and select or upload the license files to update.
11. Click Submit to upload the license request.
   A confirmation page opens, showing the details of your request. The upgraded licenses are emailed to you in a .zip file.

Install licenses

After you have upgraded the licenses, install the license in the Management Client.

For details about product features, usage, and best practices, click Help or press F1.

1. In the Management Client, select  Menu > File > System Tools > Install Licenses.
2. Select the license files and click Install.
3. Select  Menu > Configuration > Administration.
4. Browse to Licenses > All Licenses.
5. Check that the licenses have now been correctly upgraded to the new version.

Tip: When you only upgrade the software version in the license, old licenses are automatically replaced.

Check licenses

After installing the upgraded licenses, check the license information.

When you upgrade licenses, the old licenses are automatically replaced with the new licenses.

For details about product features, usage, and best practices, click Help or press F1.

1. Select ☐ Menu > Configuration > Administration.
2. Browse to Licenses > Security Engine, Licenses > Firewall, or Licenses > IPS, depending on the type of licenses you have. The licenses and their status are displayed.
3. Verify that all engines are correctly licensed.
4. If any engines are not correctly licensed, you might need to upgrade or generate the licenses again.

Continue the upgrade in one of the following ways:
• Upgrade the engines remotely through the Management Server.
• Upgrade the engines on the engine command line.

Upgrade engines remotely

The Management Server can remotely upgrade engine components that it manages.

Before upgrading remotely, read the Release Notes for the new version, especially the required SMC version and any other version-specific upgrade issues that might be listed. You can locate the release notes as follows. Select ☐ Menu > Configuration > Administration, then select Other Elements > Engine Upgrades. Select the type of engine you are upgrading. A link to the release notes is included in the upgrade file’s information. If the Management Server has no Internet connectivity, you can find the release notes at https://support.mcafee.com

You can upgrade several engines of the same type in the same operation. However, we recommend that you upgrade clusters one node at a time and wait until an upgraded node is back online before you upgrade the other nodes. Clusters operate normally throughout the upgrade when the upgrade is done in stages. However, it is recommended to upgrade all nodes in the cluster to the same version as soon as possible. Prolonged use with mismatched versions is not supported. It is not possible to have 32-bit and 64-bit engines online in the cluster at the same time.

Note: You cannot remotely upgrade Stonesoft NGFW engines in the AWS cloud using the Management Client. You must upgrade these engines using the AWS cloud management infrastructure. For upgrade instructions, see KB85950.

For details about product features, usage, and best practices, click Help or press F1.

1. Select 🏛 Home.
2. Right-click the node you want to upgrade, then select Commands > Go Offline. A confirmation dialog box opens.
3. (Optional) Enter an Audit Comment to be shown in the audit log entry that is generated when you send the command to the engine.
4. Click Yes. The engine is turned offline shortly.
5. Right-click the node you want to upgrade, then select Upgrade Software or Configuration > Upgrade Software depending on your selection.

Note: You cannot upgrade Virtual Security Engines directly. To upgrade Virtual Security Engines, you must upgrade the Master Engine that hosts the Virtual Security Engines.

The Remote Upgrade Task Properties dialog box opens.

6. Select the type of Operation you want to perform:

- Select Remote Upgrade (transfer + activate) to install the new software and reboot the node with the new version of the software.
- Select Remote Upgrade (transfer) to install the new software on the node without an immediate reboot and activation. The node continues to operate with the currently installed version until you choose to activate the new version.
- Select Remote Upgrade (activate) to reboot the node and activate the new version of the software that was installed earlier.

CAUTION: To avoid an outage, do not activate the new configuration simultaneously on all nodes of a cluster. Activate the new configuration one node at a time, and proceed to the next node only after the previous node is back online.

7. If necessary, add or remove Target engines.

All engines in the same Upgrade Task must be of the same type.

8. Select the correct Engine Upgrade file, then click OK.

If you choose to activate the new configuration, you are prompted to acknowledge a warning that the node will be rebooted. A new tab opens showing the progress of the upgrade. The time the upgrade takes varies depending on the performance of your system and the network environment. The engine is automatically rebooted and brought back online.

The upgrade overwrites the inactive partition and then switches the active partition. To undo the upgrade, use the \texttt{sg-toggle-active} command or the engine’s boot menu to switch back to the previous software version on the other partition. This switch can also happen automatically at the next reboot if the engine is not able to successfully return to operation when it boots up after the upgrade.

Note: The Management Server verifies the digital signature of the upgrade package before installing it. The signature must be valid for the upgrade to succeed. If the verification fails, an error message is shown. Verification failure can result from an out-of-date SMC version or an invalid or missing signature.

**Upgrade engines locally**

You can upgrade the engines on the engine command line.

Upgrading locally requires a physical connection to the engine using a monitor and keyboard or a serial cable.

During a Firewall Cluster or Master Engine cluster upgrade, the upgraded nodes can be online and operational side by side with the older version nodes. However, you must upgrade all nodes to the same version as soon as possible, as prolonged use with mismatched versions is not supported.

There are two ways to upgrade engines locally:

- If the hardware has a DVD drive (a USB DVD drive can be used) and you have an installation DVD, you can upgrade from an installation DVD.
- You can upgrade from a .zip file on a USB drive or on a DVD.
Upgrade from an installation DVD

You can upgrade the engines to the latest version from a DVD that was shipped to you, or from a DVD that you have created from an .iso image that you downloaded from the Forcepoint website.

1. Log on to the node as root with the password you set for the engine (you can set the password through the Management Client).
2. Insert the DVD into the engine’s DVD drive.
3. Restart the node from the DVD with the command `reboot` (recommended) or by cycling the power (if you cannot log on).

   You are promoted to select the upgrade type.

4. Enter 1 to upgrade the existing installation and press Enter to continue. The upgrade process starts.
5. When the process is finished, eject the DVD and press Enter to restart.

   If the NGFW Configuration Wizard opens, configure the engine in the same way as after the first installation.
6. When the upgrade is finished, right-click the node in the Management Client and select Commands > Go Online.

   A confirmation dialog box opens.
7. (Optional) Enter an Audit Comment to be shown in the audit log entry that is generated when you send the command to the engine.
8. Click Yes.

   Note: If you are upgrading a cluster, start the upgrade on the next node only when the upgraded node is back online.

Related tasks
Configure Stonesoft NGFW engine software with the NGFW Configuration Wizard on page 108
You can manually configure the settings for the Stonesoft NGFW engine using the NGFW Configuration Wizard.

Upgrade from a .zip file

You can use a .zip file to upgrade the engine software locally on the engine command line.

1. Log on to the node as root with the password set for the engine (you can set the password through the Management Client).
2. Insert the USB drive or the DVD.
3. Run the command `sg-reconfigure`.
   The NGFW Configuration Wizard opens.
4. Select Upgrade and press Enter.
5. Select the source media where the upgrade file is located.
6. Select OK.

   The software is upgraded.

   Note: The Stonesoft NGFW engine verifies the digital signature of the upgrade package before installing it. The verification can take several minutes. The signature must be valid for the upgrade to succeed. If the verification fails, an error message is shown. Verification failure can result from an out-of-date Stonesoft NGFW software version or an invalid or missing signature.

7. When prompted, press Enter.
   The engine restarts with the new version.
Default communication ports

There are default ports used in connections between SMC components and default ports that SMC components use with external components.

Security Management Center ports

The most important default ports used in communications to and from SMC components are presented in the following illustrations.

Figure 9: Destination ports for basic communications within the SMC

Figure 10: Default destination ports for optional SMC components and features
This table lists the default ports SMC uses internally and with external components. Many of these ports can be changed. The names of corresponding default Service elements are also included for your reference.

**Table 13: SMC default ports**

<table>
<thead>
<tr>
<th>Listening host</th>
<th>Port/protocol</th>
<th>Contacting hosts</th>
<th>Service description</th>
<th>Service element name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Management Servers</td>
<td>8902-8913/136 TCP</td>
<td>Management Server</td>
<td>Database replication (push) to the additional Management Server.</td>
<td>SG Control</td>
</tr>
<tr>
<td>DNS server</td>
<td>53/UDP, 53/TCP</td>
<td>Management Client, Management Server, Log Server</td>
<td>DNS queries.</td>
<td>DNS (UDP)</td>
</tr>
<tr>
<td>LDAP server</td>
<td>389/TCP</td>
<td>Management Server</td>
<td>External LDAP queries for display/editing in the Management Client.</td>
<td>LDAP (TCP)</td>
</tr>
<tr>
<td>Log Server</td>
<td>162/UDP, 5162/UDP</td>
<td>Monitored third-party components</td>
<td>SNMPv1 trap reception from third-party components. Port 162 is used if installed on Windows, port 5162 if installed on Linux.</td>
<td>SNMP (UDP)</td>
</tr>
<tr>
<td>Log Server</td>
<td>514/TCP, 514/UDP, 5514/TCP, 5514/UDP</td>
<td>Monitored third-party components</td>
<td>Syslog reception from third-party components. Port 514 is used if installed on Windows, port 5514 if installed on Linux.</td>
<td>Syslog (UDP) [Partial match]</td>
</tr>
<tr>
<td>Log Server</td>
<td>2055/UDP</td>
<td>Monitored third-party components</td>
<td>NetFlow or IPFIX reception from third-party components. Port 2055 is used in both Windows and Linux.</td>
<td>NetFlow (UDP)</td>
</tr>
<tr>
<td>Log Server</td>
<td>8914-8918/8916-8917/TCP</td>
<td>Management Client, Web Portal Server</td>
<td>Log browsing.</td>
<td>SG Data Browsing</td>
</tr>
<tr>
<td>Management Server</td>
<td>3021/TCP</td>
<td>Log Server, Web Portal Server</td>
<td>System communications certificate request/renewal.</td>
<td>SG Log Initial Contact</td>
</tr>
<tr>
<td>Management Server</td>
<td>8902-8913/136 TCP</td>
<td>Management Client, Log Server, Web Portal Server</td>
<td>Monitoring and control connections.</td>
<td>SG Control</td>
</tr>
<tr>
<td>Listening host</td>
<td>Port/protocol</td>
<td>Contacting hosts</td>
<td>Service description</td>
<td>Service element name</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------</td>
<td>------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Management Server</td>
<td>8903, 8907/TCP</td>
<td>Additional Management Servers</td>
<td>Database replication (pull) to the additional Management Server.</td>
<td>SG Control</td>
</tr>
<tr>
<td>Monitored third-party components</td>
<td>161/UDP</td>
<td>Log Server</td>
<td>SNMP status probing to external IP addresses.</td>
<td>SNMP (UDP)</td>
</tr>
<tr>
<td>NTP server</td>
<td>123/TCP or UDP</td>
<td>SMC Appliance</td>
<td>Receiving NTP information.</td>
<td>NTP</td>
</tr>
<tr>
<td>RADIUS server</td>
<td>1812/UDP</td>
<td>Management Server</td>
<td>RADIUS authentication requests for administrator logon. The default ports can be edited in the properties of the RADIUS Server element.</td>
<td>RADIUS (Authentication)</td>
</tr>
<tr>
<td>Stonesoft NGFW update service</td>
<td>443/TCP</td>
<td>SMC servers</td>
<td>Update packages, engine upgrades, and licenses.</td>
<td>HTTPS</td>
</tr>
<tr>
<td>SMC Appliance</td>
<td>161/UDP</td>
<td>Third-party components</td>
<td>Requesting health and other information about the SMC Appliance.</td>
<td>SNMP</td>
</tr>
<tr>
<td>Update servers</td>
<td>443/TCP</td>
<td>SMC Appliance</td>
<td>Receiving appliance patches and updates.</td>
<td>HTTPS</td>
</tr>
<tr>
<td>SMC Appliance</td>
<td>22/TCP</td>
<td>Terminal clients</td>
<td>SSH connections to the command line of the SMC Appliance (disabled in FIPS mode).</td>
<td>SSH</td>
</tr>
<tr>
<td>Syslog server</td>
<td>514/UDP, 5514/UDP</td>
<td>Log Server</td>
<td>Log data forwarding to syslog servers. The default ports can be edited in the LogServerConfiguration.txt file.</td>
<td>Syslog (UDP) [Partial match]</td>
</tr>
<tr>
<td>Terminal Client Firewall, Layer 2 Firewall, IPS, Master Engine</td>
<td>22/TCP</td>
<td>SMC Appliance</td>
<td>Contacting engines and moving SMC Appliance backups off the appliance.</td>
<td>SSH</td>
</tr>
<tr>
<td>Listening host</td>
<td>Port/protocol</td>
<td>Contacting hosts</td>
<td>Service description</td>
<td>Service element name</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------</td>
<td>------------------</td>
<td>--------------------------------------------------------------------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Third-party components</td>
<td>2055/UDP</td>
<td>Log Server</td>
<td>NetFlow or IPFIX forwarding to third-party components. Port 2055 is used in both Windows and Linux.</td>
<td>NetFlow (UDP)</td>
</tr>
<tr>
<td>Third-party components</td>
<td>162/UDP</td>
<td>SMC Appliance</td>
<td>Sending SNMP status probing to external devices.</td>
<td>SNMP</td>
</tr>
<tr>
<td>Third-party components</td>
<td>445/TCP</td>
<td>SMC Appliance</td>
<td>Moving SMC Appliance backups off the appliance.</td>
<td>CIFS</td>
</tr>
</tbody>
</table>

**Note:** SSH is disabled in FIPS mode.

**Note:** CIFS is disabled in FIPS mode.

---

**Stonesoft NGFW engine ports**

The most important default ports used in communications to and from Security Engines and Master Engines are presented in the following illustrations.

See the table for a complete list of default ports for the engines.

**Note:** Master Engines use the same default ports as clustered Security Engines. Virtual Security Engines do not communicate directly with other system components.

---

**Figure 11: Destination ports for basic Security Engine communications**
Figure 12: Default destination ports for Security Engine service communications

This table lists the default ports for Security Engines and Master Engines. Many of these ports can be changed. The names of corresponding default Service elements are also included for your reference.

Table 14: Security Engine and Master Engine default ports

<table>
<thead>
<tr>
<th>Listening host</th>
<th>Port/protocol</th>
<th>Contacting hosts</th>
<th>Service description</th>
<th>Service element name</th>
</tr>
</thead>
<tbody>
<tr>
<td>BrightCloud Server</td>
<td>2316/TCP</td>
<td>Firewall, Layer 2 Firewall, IPS, Master Engine</td>
<td>BrightCloud URL filtering update service.</td>
<td>BrightCloud update</td>
</tr>
<tr>
<td>DHCP server</td>
<td>67/UDP</td>
<td>Firewall</td>
<td>Relayed DHCP requests and requests from a firewall that uses dynamic IP address.</td>
<td>BOOTPS (UDP)</td>
</tr>
<tr>
<td>DHCPv6 server</td>
<td>547/UDP</td>
<td>Firewall</td>
<td>Requests from a firewall that uses dynamic IPv6 address.</td>
<td>N/A</td>
</tr>
<tr>
<td>DNS server</td>
<td>53/UDP, 53/TCP</td>
<td>Firewall, Master Engine</td>
<td>Dynamic DNS updates.</td>
<td>DNS (TCP)</td>
</tr>
<tr>
<td>File reputation server</td>
<td>443/TCP</td>
<td>Firewall, Layer 2 Firewall, IPS, Master Engine</td>
<td>GTI File Reputation Server</td>
<td>HTTPS</td>
</tr>
<tr>
<td>Listening host</td>
<td>Port/protocol</td>
<td>Contacting hosts</td>
<td>Service description</td>
<td>Service element name</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------</td>
<td>------------------</td>
<td>---------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Firewall</td>
<td>67/UDP</td>
<td>Any</td>
<td>DHCP relay on firewall engine.</td>
<td>BOOTPS (UDP)</td>
</tr>
<tr>
<td>Firewall</td>
<td>68/UDP</td>
<td>DHCP server</td>
<td>Replies to DHCP requests.</td>
<td>BOOTPC (UDP)</td>
</tr>
<tr>
<td>Firewall</td>
<td>80/TCP</td>
<td>Clients that need to authenticate to the Firewall</td>
<td>Browser Based User Authentication</td>
<td>HTTP</td>
</tr>
<tr>
<td>Firewall</td>
<td>443/TCP</td>
<td>Clients that need to authenticate to the Firewall</td>
<td>Browser Based User Authentication</td>
<td>HTTPS</td>
</tr>
<tr>
<td>Firewall</td>
<td>443/TCP</td>
<td>VPN clients using SSL tunneling</td>
<td>VPN client SSL tunneling</td>
<td>TLS</td>
</tr>
<tr>
<td>Firewall</td>
<td>443/TCP</td>
<td>SSL Portal users</td>
<td>SSL VPN Portal</td>
<td>HTTPS</td>
</tr>
<tr>
<td>Firewall</td>
<td>546/UDP</td>
<td>DHCPv6 server</td>
<td>Replies to DHCPv6 requests.</td>
<td>N/A</td>
</tr>
<tr>
<td>Firewall, Master Engine</td>
<td>500/UDP</td>
<td>VPN clients, VPN gateways</td>
<td>VPN negotiations, VPN traffic.</td>
<td>ISAKMP (UDP)</td>
</tr>
<tr>
<td>Firewall, Master Engine</td>
<td>636/TCP</td>
<td>Management Server</td>
<td>Internal user database replication.</td>
<td>LDAPS (TCP)</td>
</tr>
<tr>
<td>Firewall, Master Engine</td>
<td>2543/TCP</td>
<td>Any</td>
<td>User authentication (Telnet) for Access rules.</td>
<td>SG User Authentication</td>
</tr>
<tr>
<td>Firewall, Master Engine</td>
<td>4500/UDP</td>
<td>VPN client, VPN gateways</td>
<td>VPN traffic using NAT-traversal.</td>
<td>NAT-T</td>
</tr>
<tr>
<td>Firewall Cluster Node, Master Engine cluster node</td>
<td>3000-3001/UDP</td>
<td>Firewall Cluster Node, Master Engine cluster node</td>
<td>Heartbeat and state synchronization between clustered Firewalls.</td>
<td>SG State Sync (Multicast), SG State Sync (Unicast), SG Data Sync</td>
</tr>
<tr>
<td>Firewall, Layer 2 Firewall, IPS, Master Engine</td>
<td>22/TCP</td>
<td>Terminal clients</td>
<td>SSH connections to the engine command line (disabled in FIPS mode).</td>
<td>SSH</td>
</tr>
<tr>
<td>Firewall, Layer 2 Firewall, IPS, Master Engine</td>
<td>4950/TCP</td>
<td>Management Server</td>
<td>Remote upgrade.</td>
<td>SG Remote Upgrade</td>
</tr>
<tr>
<td>Firewall, Layer 2 Firewall, IPS, Master Engine</td>
<td>4987/TCP</td>
<td>Management Server</td>
<td>Management Server commands and policy upload.</td>
<td>SG Commands</td>
</tr>
<tr>
<td>Firewall, Layer 2 Firewall, IPS, Master Engine</td>
<td>15000/TCP</td>
<td>Management Server, Log Server</td>
<td>Blacklist entries.</td>
<td>SG Blacklisting</td>
</tr>
<tr>
<td>Firewall, Layer 2</td>
<td>161/UDP</td>
<td>SNMP server</td>
<td>SNMP monitoring.</td>
<td>SNMP (UDP)</td>
</tr>
<tr>
<td>Listening host</td>
<td>Port/protocol</td>
<td>Contacting hosts</td>
<td>Service description</td>
<td>Service element name</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>---------------------</td>
<td>-----------------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>Firewall, IPS, Master Engine</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IPS Cluster Node</td>
<td>3000-3001/UDP</td>
<td>IPS Cluster Node</td>
<td>Heartbeat and state synchronization between clustered IPS engines.</td>
<td>SG State Sync (Multicast), SG State Sync (Unicast), SG Data Sync</td>
</tr>
<tr>
<td></td>
<td>3002–3003, 3010/TCP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Heartbeat and state synchronization between clustered Layer 2 Firewalls.</td>
<td>SG State Sync (Multicast), SG State Sync (Unicast), SG Data Sync</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LDAP server</td>
<td>389/TCP</td>
<td>Firewall, Master Engine</td>
<td>External LDAP queries, including StartTLS connections.</td>
<td>LDAP (TCP)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Log Server</td>
<td>3020/TCP</td>
<td>Firewall, Layer 2 Firewall, IPS, Master Engine</td>
<td>Log and alert messages; monitoring of blacklists, connections, status, and statistics.</td>
<td>SG Log</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Malware signature server</td>
<td>80/TCP</td>
<td>Firewall, Layer 2 Firewall, IPS, Master Engine</td>
<td>Malware signature update service.</td>
<td>HTTP</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Management Server</td>
<td>3021/TCP</td>
<td>Firewall, Layer 2 Firewall, IPS, Master Engine</td>
<td>System communications certificate request/renewal (initial contact).</td>
<td>SG Initial Contact</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Management Server</td>
<td>8906/TCP</td>
<td>Firewall, Layer 2 Firewall, IPS</td>
<td>Management connection for single engines with &quot;Node-Initiated Contact to Management Server&quot; selected.</td>
<td>SG Dynamic Control</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RADIUS server</td>
<td>1812, 1645/UDP</td>
<td>Firewall, Master Engine</td>
<td>RADIUS authentication requests.</td>
<td>RADIUS (Authentication), RADIUS (Old)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RPC server</td>
<td>111/UDP, 111/TCP</td>
<td>Firewall, Master Engine</td>
<td>RPC number resolve.</td>
<td>SUNRPC (UDP), Sun RPC (TCP)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Server Pool Monitoring Agents</td>
<td>7777/UDP</td>
<td>Firewall, Master Engine</td>
<td>Polls to the servers' Server Pool Monitoring Agents for availability and load information.</td>
<td>SG Server Pool Monitoring</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNMP server</td>
<td>162/UDP</td>
<td>Firewall, Layer 2 Firewall, IPS, Master Engine</td>
<td>SNMP traps from the engine.</td>
<td>SNMP Trap (UDP)</td>
</tr>
<tr>
<td>Listening host</td>
<td>Port/protocol</td>
<td>Contacting hosts</td>
<td>Service description</td>
<td>Service element name</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------</td>
<td>-------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>TACACS+ server</td>
<td>49/TCP</td>
<td>Firewall, Master Engine</td>
<td>TACACS+ authentication requests.</td>
<td>TACACS (TCP)</td>
</tr>
<tr>
<td>URL category server</td>
<td>2316/TCP</td>
<td>Firewall, Layer 2 Firewall, IPS, Master Engine</td>
<td>BrightCloud URL category server</td>
<td>BrightCloud Service</td>
</tr>
<tr>
<td>VPN gateways</td>
<td>500, 4500/UDP</td>
<td>Firewall, Master Engine</td>
<td>VPN traffic. Ports 443/TCP (or custom port) can also be used, depending on encapsulation options.</td>
<td>ISAKMP (UDP)</td>
</tr>
</tbody>
</table>
Command line tools

There are command line tools for the SMC and the Stonesoft NGFW engines.

Stonesoft Management Center commands

SMC commands include commands for the Management Server, Log Server, and Web Portal Server.

Most of the commands are found in the <installation directory>/bin/ directory. In Windows, the command line tools are *.bat script files. In Linux, the files are *.sh scripts.

Note: If you installed the Management Server in the C:\Program Files\Forcepoint\Stonesoft Management Center directory in Windows, some of the program data is stored in the C:\ProgramData\Forcepoint\Stonesoft Management Center directory. Command line tools can be found in the C:\Program Files\Forcepoint\Stonesoft Management Center\bin directory.

Commands that require parameters must be run through the command line (cmd.exe in Windows). Commands that do not require parameters can alternatively be run through a graphical user interface, and can be added as shortcuts during installation.

CAUTION: login and password parameters are optional. Giving them as command-line parameters can pose a security vulnerability. Do not enter logon and password information unless explicitly prompted to do so by a command line tool.

Table 15: Stonesoft Management Center commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ambr-crl</td>
<td>Fetches the certificate revocation lists (CRLs) for the CA certificates used by the appliance maintenance and bug remediation (AMBR) utilities.</td>
</tr>
<tr>
<td></td>
<td>-a ADD, --add=ADD adds a CRL distribution point URL in the form of http://&lt;url&gt;.</td>
</tr>
<tr>
<td></td>
<td>-d DELETE, --delete=DELETE deletes a CRL distribution point URL.</td>
</tr>
<tr>
<td></td>
<td>-q, --query lists CRL distribution points.</td>
</tr>
<tr>
<td></td>
<td>-i IMPORT_CRL, --import=IMPORT_CRL imports a CRL from a file.</td>
</tr>
<tr>
<td></td>
<td>-c, --clean removes existing CRLs before fetching new CRLs.</td>
</tr>
<tr>
<td></td>
<td>-v increases the verbosity of the command. You can repeat this command up to two times (-vv or -v -v) to further increase the verbosity.</td>
</tr>
<tr>
<td></td>
<td>-l &lt;log file path&gt; specifies the path to a log file.</td>
</tr>
<tr>
<td></td>
<td>-h, --help displays information about the command.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ambr-decrypt</td>
<td>Decrypts an ambr patch; not normally used by administrators. ambr-install automatically decrypts patches.</td>
</tr>
<tr>
<td>ambr-install &lt;patch&gt;</td>
<td>Installs an ambr patch that has been loaded on the system.</td>
</tr>
<tr>
<td></td>
<td>You can install multiple patches with a space between each patch name.</td>
</tr>
<tr>
<td></td>
<td>-F, --force forces the reinstallation of the patch or patches.</td>
</tr>
<tr>
<td></td>
<td>-r, --skip-revocation skips the certificate revocation checks.</td>
</tr>
<tr>
<td></td>
<td>--no-backup does not create a configuration backup.</td>
</tr>
<tr>
<td></td>
<td>--no-snapshot does not create a recovery snapshot.</td>
</tr>
<tr>
<td></td>
<td>-v increases the verbosity of the command. You can repeat this command up to two times to further increase the verbosity.</td>
</tr>
<tr>
<td></td>
<td>-l &lt;log file path&gt; specifies the path to a log file.</td>
</tr>
<tr>
<td></td>
<td>-h, --help displays information about the command.</td>
</tr>
<tr>
<td>ambr-load &lt;patch&gt;</td>
<td>Loads an ambr patch onto the system from either the patch server or from the local file system. A loaded patch means that the file is copied to the local file system, but not installed.</td>
</tr>
<tr>
<td></td>
<td>You can load multiple patches with a space between each patch name.</td>
</tr>
<tr>
<td></td>
<td>-f IN_FILES, --file=IN_FILES specifies the local file to load.</td>
</tr>
<tr>
<td></td>
<td>-r, --skip-revocation skips the certificate revocation checks.</td>
</tr>
<tr>
<td></td>
<td>-v increases the verbosity of the command. You can repeat this command up to two times to further increase the verbosity.</td>
</tr>
<tr>
<td></td>
<td>-l &lt;log file path&gt; specifies the path to a log file.</td>
</tr>
<tr>
<td></td>
<td>-h, --help displays information about the command.</td>
</tr>
<tr>
<td>ambr-query</td>
<td>Displays patch information including:</td>
</tr>
<tr>
<td></td>
<td>- What is loaded or installed on the system</td>
</tr>
<tr>
<td></td>
<td>- A list of available updates from the patch server</td>
</tr>
<tr>
<td></td>
<td>- Detailed information about a specific patch</td>
</tr>
<tr>
<td></td>
<td>-l, --local displays a description of the installed or loaded patches on the SMC appliance. Displays the same information as the default ambr-query command.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>[-v] [-h</td>
<td>--help]</td>
</tr>
</tbody>
</table>
- `-w`, `--web` displays a list of applicable updates that are available on the webserver for the current installation. Patch dependencies and the most direct update path are displayed with this option.  
- `-a`, `--all` displays a list of all updates available on the webserver for the current installation.  
- `-i`, `--info <patch>` displays description information about the patch. You can get information about multiple patches in one command by separating the patch names with a space.  
- `-v` increases the verbosity of the command. You can repeat this command up to two times to further increase the verbosity.  
- `-L <log file path>` specifies the path to the file where log messages are written.  
- `-h`, `--help` displays information about the command. |
| ambr-unload <patch>  
(SMC Appliance only)  
[-a|--all]  
[-v]  
[-l <log file path>]  
[-h|--help] | Unloads an ambr patch from the system. The command deletes the patch file if it has not been installed, but it does not uninstall the patch.  
You can unload multiple patches with a space between each patch name.  
- `-a`, `--all` unloads all loaded patches.  
- `-v` increases the verbosity of the command. You can repeat this command up to two times to further increase the verbosity.  
- `-l <log file path>` specifies the path to a log file.  
- `-h`, `--help` displays information about the command. |
| ambr-verify  
(SMC Appliance only) | Verifies the signature of a patch file; not normally used by administrators. `ambr-install` automatically verifies patches. |
| sgArchiveExport  
[host=<Management Server Address[\Domain>]]  
[login=<login name>]  
[pass=<password>]  
[format=<exporter format: CSV or XML>]]  
i=<input files and/or directories>  
[o=<output file name>]  
[f=<filter file name>]  
[e=<filter expression>]  
[-h|--help|--?] | Displays or exports logs from archive.  
This command is only available on the Log Server. The operation checks permissions for the supplied administrator account from the Management Server to prevent unauthorized access to the logs.  
Enclose details in double quotes if they contain spaces.  
- `Host` specifies the address of the Management Server. If the parameter is not defined, the loopback address (localhost) is used.  
- `login` defines the user name for the account that is used for this operation. If this parameter is not defined, the user name root is used.  
- `pass` defines the password for the user account. |
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[v]</td>
<td>format defines the file format for the output file. If this parameter is not defined, the XML format is used.</td>
</tr>
<tr>
<td></td>
<td>i defines the source from which the logs are exported. Can be a folder or a file. The processing recurses into subfolders.</td>
</tr>
<tr>
<td></td>
<td>o defines the destination file where the logs are exported. If this parameter is not defined, the output is displayed on screen.</td>
</tr>
<tr>
<td></td>
<td>f defines a file that contains the filtering criteria you want to use for filtering the log data. You can export log filters individually in the Management Client through Tools &gt; Save for Command Line Tools in the filter's right-click menu.</td>
</tr>
<tr>
<td></td>
<td>e allows you to enter a filter expression manually (using the same syntax as exported filter files).</td>
</tr>
<tr>
<td></td>
<td>-h, -help, or -? displays information about using the script.</td>
</tr>
<tr>
<td></td>
<td>-v displays verbose output on the command execution.</td>
</tr>
<tr>
<td></td>
<td>Example (exports logs from one full day to a file using a filter): sgArchiveExport login=admin pass=abc123 i=C:\Program Files \Forcepoint\Stonesoft Management Center\data\archive\firewall\year2011\month12\sgB.day01\f=C:\Program Files\Forcepoint\Stonesoft Management Center\export\MyExportedFilter.flp format=CSV o=MyExportedLogs.csv</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sgBackupLogSrv</td>
<td>Creates a backup of Log Server configuration data.</td>
</tr>
<tr>
<td>[pwd=&lt;password&gt;]</td>
<td>The backup file is stored in the &lt;installation directory&gt;/backups/ directory.</td>
</tr>
<tr>
<td>[path=&lt;destpath&gt;]</td>
<td>Twice the size of the log database is required on the destination drive. Otherwise, the operation fails.</td>
</tr>
<tr>
<td>[nodiskcheck]</td>
<td>pwd enables encryption.</td>
</tr>
<tr>
<td>[comment=&lt;comment&gt;]</td>
<td>path defines the destination path.</td>
</tr>
<tr>
<td>[nofsstorage]</td>
<td>nodiskcheck ignores the free disk check before creating the backup.</td>
</tr>
<tr>
<td>[-h</td>
<td>--help]</td>
</tr>
<tr>
<td>[nodiskcheck]</td>
<td>nosststorage creates a backup only of the Log Server configuration without the log data.</td>
</tr>
<tr>
<td>[-h</td>
<td>--help]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sgBackupMgtSrv</td>
<td>Creates a complete backup of the Management Server (including both the local configuration and the stored</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td><code>[path=&lt;destpath&gt;]</code></td>
<td>information in the configuration database. The backup file is stored in the <code>&lt;installation directory&gt;/backups/</code> directory. The twice the size of the Management Server database is required on the destination drive. Otherwise, the operation fails.</td>
</tr>
<tr>
<td><code>[nodiskcheck]</code></td>
<td><code>pwd</code> enables encryption.</td>
</tr>
<tr>
<td><code>[comment=&lt;comment&gt;]</code></td>
<td><code>path</code> defines the destination path.</td>
</tr>
<tr>
<td>`[-h</td>
<td>--help]`</td>
</tr>
<tr>
<td></td>
<td><code>comment</code> allows you to enter a comment for the backup. The maximum length of a comment is 60 characters.</td>
</tr>
<tr>
<td></td>
<td><code>-h</code> or <code>--help</code> displays information about using the script.</td>
</tr>
<tr>
<td></td>
<td><strong>Also see</strong> <code>sgRestoreMgtBackup</code> and <code>sgRecoverMgtDatabase</code>.</td>
</tr>
</tbody>
</table>

| sgCertifyLogSrv | Contacts the Management Server and creates a certificate for the Log Server to allow secure communications with other SMC components. Renewing an existing certificate does not require changing the configuration of any other SMC components. |
| [host=<Management Server Address[\Domain]>] | `host` specifies the address of the Management Server. If the parameter is not defined, the loopback address (localhost) is used. |
| | `Domain` specifies the administrative Domain the Log Server belongs to if the system is divided into administrative Domains. If the Domain is not specified, the Shared Domain is used. |
| | Stop the Log Server before running this command. Restart the server after running this command. |

<p>| sgCertifyMgtSrv | Creates a certificate for the Management Server to allow secure communications between the SMC components. Renewing an existing certificate does not require changes on any other SMC components. |
| [login=&lt;login name&gt;] | In an environment with only one Management Server, or to certify the active Management Server, stop the Management Server before running the <code>sgCertifyMgtSrv</code> command. Run the command without parameters. Restart the Management Server after running this command. |
| [pass=&lt;password&gt;] | To certify an additional Management Server, stop the additional Management Server before running the <code>sgCertifyMgtSrv</code> command. The active Management Server must be running when you run this command. The management database is replicated to the additional Management Server during the certification. The additional Management Server |</p>
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>sgCertifyWebPortalSrv</td>
<td>[host=&lt;Management Server Address[\Domain]&gt;] Contacts the Management Server and creates a certificate for the Web Portal Server to allow secure communications with other SMC components. Renewing an existing certificate does not require changing the configuration of any other SMC components.</td>
</tr>
<tr>
<td></td>
<td>host specifies the address of the Management Server. If the parameter is not defined, the loopback address (localhost) is used.</td>
</tr>
<tr>
<td></td>
<td>Domain specifies the administrative Domain the Web Portal Server belongs to if the system is divided into administrative Domains. If the Domain is not specified, the Shared Domain is used.</td>
</tr>
<tr>
<td></td>
<td>Stop the Web Portal Server before running this command. Restart the server after running this command.</td>
</tr>
<tr>
<td>sgChangeMgtIPOnLogSrv &lt;IP address&gt;</td>
<td>Changes the Management Server's IP address in the Log Server's local configuration to the IP address you give as a parameter.</td>
</tr>
<tr>
<td></td>
<td>Use this command if you change the Management Server's IP address. Restart the Log Server service after running this command.</td>
</tr>
<tr>
<td>sgChangeMgtIPOnMgtSrv &lt;IP address&gt;</td>
<td>Changes the Management Server's IP address in the local configuration to the IP address you give as a parameter.</td>
</tr>
<tr>
<td></td>
<td>Use this command if you change the Management Server's IP address. Restart the Management Server service after running this command.</td>
</tr>
<tr>
<td>sgClient</td>
<td>Starts a locally installed Management Client.</td>
</tr>
<tr>
<td>sgCreateAdmin</td>
<td>Creates an unrestricted (superuser) administrator account.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>sgExport</strong></td>
<td>The Management Server must be stopped before running this command.</td>
</tr>
<tr>
<td>[login=&lt;login name&gt;]</td>
<td>host specifies the address of the Management Server. If the parameter is not defined, the loopback address (localhost) is used.</td>
</tr>
<tr>
<td>[pass=password]</td>
<td>Domain specifies the administrative Domain for this operation if the system is divided into administrative Domains. If the Domain is not specified, the Shared Domain is used.</td>
</tr>
<tr>
<td>file=&lt;file path and name&gt;</td>
<td>login defines the user name for the account that is used for this operation. If this parameter is not defined, the user name root is used.</td>
</tr>
<tr>
<td>[type=&lt;all</td>
<td>nw</td>
</tr>
<tr>
<td>[name=&lt;element name 1, element name 2, ...&gt;]</td>
<td>file defines the name and location of the export .zip file.</td>
</tr>
<tr>
<td>[recursion]</td>
<td>type specifies which types of elements are included in the export file:</td>
</tr>
<tr>
<td>[-system]</td>
<td>• all for all exportable elements</td>
</tr>
<tr>
<td>[-h</td>
<td>-help</td>
</tr>
<tr>
<td></td>
<td>• ips for IPS elements</td>
</tr>
<tr>
<td></td>
<td>• sv for services</td>
</tr>
<tr>
<td></td>
<td>• rb for security policies</td>
</tr>
<tr>
<td></td>
<td>• al for alerts</td>
</tr>
<tr>
<td></td>
<td>• vpn for VPN elements.</td>
</tr>
<tr>
<td><strong>sgHA</strong></td>
<td>name allows you to specify by name the elements that you want to export.</td>
</tr>
<tr>
<td>[host=&lt;Management Server Address[\Domain]&gt;]</td>
<td>recursion includes referenced elements in the export, for example, the network elements used in a policy that you export.</td>
</tr>
<tr>
<td>[login=&lt;login name&gt;]</td>
<td>-system includes any system elements that are referenced by the other elements in the export.</td>
</tr>
<tr>
<td>[pass=&lt;password&gt;]</td>
<td>-h, -help, or -? displays information about using the script.</td>
</tr>
<tr>
<td>[master=&lt;Management Server used as master server for the operation&gt;]</td>
<td><strong>Controls active and standby Management Servers.</strong></td>
</tr>
<tr>
<td>[-set-active]</td>
<td>If you want to perform a full database synchronization, use the sgOnlineReplication command.</td>
</tr>
<tr>
<td></td>
<td>host specifies the address of the Management Server. If the parameter is not defined, the loopback address (localhost) is used.</td>
</tr>
<tr>
<td></td>
<td>Domain specifies the administrative Domain for this operation if the system is divided into administrative</td>
</tr>
</tbody>
</table>

---

Command line tools | 149
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-set-standby]</td>
<td>Domains. If the Domain is not specified, the Shared Domain is used.</td>
</tr>
<tr>
<td>[-check]</td>
<td>login defines the user name for the account that is used for this operation. If this parameter is not defined, the user name root is used.</td>
</tr>
<tr>
<td>[-retry]</td>
<td>pass defines the password for the user account.</td>
</tr>
<tr>
<td>[-force]</td>
<td>master defines the Management Server used as a master Management Server for the operation.</td>
</tr>
<tr>
<td>[-restart]</td>
<td>-set-active activates and locks all administrative Domains.</td>
</tr>
<tr>
<td>[-h</td>
<td>-help</td>
</tr>
<tr>
<td></td>
<td>-check checks that the Management Server’s database is in sync with the master Management Server.</td>
</tr>
<tr>
<td></td>
<td>-retry retries replication if this has been stopped due to a recoverable error.</td>
</tr>
<tr>
<td></td>
<td>-force enforces the operation even if all Management Servers are not in sync.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This option can cause instability if used carelessly.</td>
</tr>
<tr>
<td>sgImport</td>
<td>restart restores the specified Management Server.</td>
</tr>
<tr>
<td>[host=&lt;Management Server Address[\Domain]&gt;]</td>
<td>-h, -help, or -? displays information about using the script.</td>
</tr>
<tr>
<td>[login=&lt;login name&gt;]</td>
<td>Imports Management Server database elements from an XML file.</td>
</tr>
<tr>
<td>[pass=&lt;password&gt;]</td>
<td>When importing, existing (non-default) elements are overwritten if both the name and type match.</td>
</tr>
<tr>
<td>file=&lt;file path and name&gt;</td>
<td>host specifies the address of the Management Server. If the parameter is not defined, the loopback address (localhost) is used.</td>
</tr>
<tr>
<td>[-replace_all]</td>
<td>Domain specifies the administrative Domain for this operation if the system is divided into administrative Domains. If the Domain is not specified, the Shared Domain is used.</td>
</tr>
<tr>
<td>[-h</td>
<td>-help</td>
</tr>
<tr>
<td></td>
<td>pass defines the password for the user account.</td>
</tr>
<tr>
<td></td>
<td>file defines the .zip file whose contents you want to import.</td>
</tr>
<tr>
<td></td>
<td>-replace_all ignores all conflicts by replacing all existing elements with new ones.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>sgImportExportUser</td>
<td>Imports and exports a list of Users and User Groups in an LDIF file from/to a Management Server's internal LDAP database. To import User Groups, all User Groups in the LDIF file must be directly under the stonegate top-level group (dc=stonegate).</td>
</tr>
<tr>
<td><strong>CAUTION:</strong> The user information in the export file is stored as plaintext. Handle the file securely.</td>
<td></td>
</tr>
<tr>
<td>host specifies the address of the Management Server. If the parameter is not defined, the loopback address (localhost) is used.</td>
<td></td>
</tr>
<tr>
<td>Domain specifies the administrative Domain for this operation if the system is divided into administrative Domains. If the Domain is not specified, the Shared Domain is used.</td>
<td></td>
</tr>
<tr>
<td>login defines the user name for the account that is used for this operation. If this parameter is not defined, the user name root is used.</td>
<td></td>
</tr>
<tr>
<td>pass defines the password for the user account.</td>
<td></td>
</tr>
<tr>
<td>action defines whether users are imported or exported.</td>
<td></td>
</tr>
<tr>
<td>file defines the file that is used for the operation.</td>
<td></td>
</tr>
<tr>
<td>Example: sgImportExportUser login=admin pass=abc123 action=export file=c:\temp\exportedusers.ldif</td>
<td></td>
</tr>
<tr>
<td>-h, -help, or -? displays information about using the script.</td>
<td></td>
</tr>
<tr>
<td>sgInfo</td>
<td>Creates a .zip file that contains copies of configuration files and the system trace files. The resulting .zip file is stored in the logged on user's home directory. The file location is displayed on the last line of screen output. Provide the generated file to support for troubleshooting purposes.</td>
</tr>
<tr>
<td>SG_ROOT_DIR</td>
<td>SMC installation directory.</td>
</tr>
<tr>
<td>FILENAME</td>
<td>name of output file.</td>
</tr>
<tr>
<td>[fast=&lt;timestamp&gt;]</td>
<td>fast collects only traces that changed after the specified time stamp. Enter the time stamp in milliseconds or in the format yyyy-MM-dd HH:mm:ss. No other information is collected, except for threaddumps.</td>
</tr>
<tr>
<td>[-nolog]</td>
<td>-nolog extended Log Server information is not collected.</td>
</tr>
<tr>
<td>[-client]</td>
<td>[-h</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **sgOnlineReplication**                     |Replicates the Management Server's database from the active Management Server to an additional Management Server. Stop the Management Server to which the database is replicated before running this command. Restart the Management Server after running this command. Use this script to replicate the database only in the following cases:  
  • The additional Management Server's configuration has been corrupted.  
  • In new SMC installations if the automatic database replication between the Management Servers has not succeeded. Otherwise, synchronize the database through the Management Client.  
  **CAUTION:** This script also has parameters that are for the internal use of the Management Server only. Do not use this script with any parameters other than the ones listed here.  
  `active-server` specifies the IP address of the active Management Server from which the Management database is replicated.  
  `-nodisplay` sets a text-only console.  
  `-h, -help, or -?` displays information about using the script. |
| **sgReinitializeLogServer**                 | Creates a Log Server configuration if the configuration file has been lost.  
  **Note:** This script is located in `<installation directory>/bin/install`. |
| **sgRestoreArchive <ARCHIVE_DIR>**          |Restores logs from archive files to the Log Server. This command is available only on the Log Server.  
  `ARCHIVE_DIR` is the number of the archive directory (0–31) from where the logs will be restored. By default, only archive directory 0 is defined. The archive directories can be defined in the `<installation directory>/data/LogServerConfiguration.txt file: ARCHIVE_DIR_ xx=PATH`. |
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
</table>
| sgRestoreLogBackup       | Restores the Log Server (logs or configuration files) from a backup file in the `<installation directory>/backups/` directory.  
- `pwd` defines a password for encrypted backup.  
- `backup` defines a name for the backup file.  
- `nodiskcheck` ignores the free disk check before backup restoration.  
- `overwrite-syslog-template` overwrites a syslog template file if found in the backup.  
- `h` or `--help` displays information about using the script. |
| sgRestoreMgtBackup       | Restores the Management Server (database or configuration files) from a backup file in the `<installation directory>/backups/` directory.  
- `pwd` defines a password for encrypted backup.  
- `backup` defines a name for the backup file.  
- `nodiskcheck` ignores the free disk check before backup restoration.  
- `h` or `--help` displays information about using the script. |
| sgRevert                 | Reverts to the previous installation saved during the upgrade process.  
The previous installation can be restored at any time, even after a successful upgrade.  
**Note:** This script is located in `<installation directory>/bin/uninstall`. |
| sgShowFingerPrint        | Displays the CA certificate's fingerprint on the Management Server.                                                                                                                                                                                                                                                                         |
| sgStartLogSrv            | Starts the Log Server and its database.                                                                                                                                                                                                                                                                                                    |
| sgStartMgtDatabase       | Starts the Management Server's database.  
There is usually no need to use this script.                                                                                                                                                                                                                                                                                               |
| sgStartMgtSrv            | Starts the Management Server and its database.                                                                                                                                                                                                                                                                                               |
| sgStartWebPortalSrv      | Starts the Web Portal Server.                                                                                                                                                                                                                                                                                                              |
| sgStopLogSrv             | Stops the Log Server.                                                                                                                                                                                                                                                                                                                        |
| sgStopMgtSrv             | Stops the Management Server and its database.                                                                                                                                                                                                                                                                                               |
| sgStopMgtDatabase        | Stops the Management Server's database.  
There is usually no need to use this script.                                                                                                                                                                                                                                                                                               |
<p>| sgStopWebPortalSrv       | Stops the Web Portal Server.                                                                                                                                                                                                                                                                                                                |</p>
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>sgStopRemoteMgtSrv</strong></td>
<td>Starts the Management Server service when run without arguments.</td>
</tr>
<tr>
<td>[host=Management Server address[\Domain&gt;]</td>
<td></td>
</tr>
<tr>
<td>[login=&lt;login name&gt;]</td>
<td></td>
</tr>
<tr>
<td>[pass=&lt;password&gt;]</td>
<td></td>
</tr>
<tr>
<td>[-h</td>
<td>-help</td>
</tr>
<tr>
<td><strong>sgTextBrowser</strong></td>
<td>Displays or exports current or stored logs.</td>
</tr>
<tr>
<td>[host=Management Server address[\Domain&gt;]</td>
<td></td>
</tr>
<tr>
<td>[login=&lt;login name&gt;]</td>
<td></td>
</tr>
<tr>
<td>[pass=&lt;password&gt;]</td>
<td></td>
</tr>
<tr>
<td>[format=&lt;CSV</td>
<td>XML&gt;]</td>
</tr>
<tr>
<td>[o=&lt;output file&gt;]</td>
<td></td>
</tr>
<tr>
<td>[f=&lt;filter file&gt;]</td>
<td></td>
</tr>
<tr>
<td>[e=&lt;filter expression&gt;]</td>
<td></td>
</tr>
<tr>
<td>[m=&lt;current</td>
<td>stored&gt;]</td>
</tr>
<tr>
<td>[limit=&lt;maximum number of unique records to fetch&gt;]</td>
<td></td>
</tr>
<tr>
<td>[-h</td>
<td>-help</td>
</tr>
<tr>
<td><strong>smca-agent</strong></td>
<td>SMC uses it to exchange configuration data between SMC and the operating system; not normally used</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>(SMC Appliance only)</strong></td>
<td>by administrators. The agent configures the NTP and SNMP daemons and sets the logon and SSH banners.</td>
</tr>
<tr>
<td><strong>smca-backup</strong></td>
<td>Creates a configuration backup of the operating system and includes an SMC backup.</td>
</tr>
<tr>
<td>[-pwd &lt;password&gt;]</td>
<td>-pwd &lt;password&gt; enables the encryption of the backup file and sets the password.</td>
</tr>
<tr>
<td>[-comment &lt;comment&gt;]</td>
<td>-comment &lt;comment&gt; adds a comment to the backup file name.</td>
</tr>
<tr>
<td>[-nodiskcheck]</td>
<td>-nodiskcheck turns off the available disk space check.</td>
</tr>
<tr>
<td>[-nofsstorage]</td>
<td>-nofsstorage excludes the log files for the Log Server from the backup.</td>
</tr>
<tr>
<td>[-nomlstorage]</td>
<td>-nomlstorage excludes the McAfee® Linux Operating System (MLOS) log files from the backup.</td>
</tr>
<tr>
<td>[-path &lt;destination&gt;]</td>
<td>-path &lt;destination&gt; specifies a path for backup file storage. The default directory for backups is /usr/local/forcepoint/smc/backups.</td>
</tr>
<tr>
<td>[-h</td>
<td>--help]</td>
</tr>
<tr>
<td><strong>smca-cifs</strong></td>
<td>Configures the mounting of remote CIFS file shares on the SMC Appliance.</td>
</tr>
<tr>
<td>[add]</td>
<td>add adds the CIFS share.</td>
</tr>
<tr>
<td>[remove]</td>
<td>remove removes the CIFS share. Use with the name option.</td>
</tr>
<tr>
<td>[-n &lt;name&gt;]</td>
<td>-n &lt;name&gt; specifies the name of the share.</td>
</tr>
<tr>
<td>[-s //&lt;server&gt;/&lt;share&gt;]</td>
<td>-s //&lt;server&gt;/&lt;share&gt; specifies the server or IP address of the share.</td>
</tr>
<tr>
<td>[-u &lt;username&gt;]</td>
<td>-u &lt;username&gt; specifies the user name to authenticate with the CIFS server to get access to the share.</td>
</tr>
<tr>
<td>[-p &lt;password&gt;]</td>
<td>-p &lt;password&gt; specifies the password on remote system.</td>
</tr>
<tr>
<td>[-d &lt;domain&gt;]</td>
<td>-d &lt;domain&gt; specifies the domain of the share.</td>
</tr>
<tr>
<td><strong>smca-restore</strong></td>
<td>Restores the SMC Appliance to the previous operational state.</td>
</tr>
<tr>
<td>[-pwd &lt;password&gt;]</td>
<td>-pwd &lt;password&gt; specifies the password for decrypting an encrypted backup file.</td>
</tr>
<tr>
<td>[-nodiskcheck]</td>
<td>-nodiskcheck turns off the available disk space check.</td>
</tr>
<tr>
<td>[-backup &lt;filename&gt;]</td>
<td>-backup &lt;filename&gt; specifies the backup file name.</td>
</tr>
<tr>
<td>[-h</td>
<td>--help]</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>smca-rsync</strong></td>
<td><strong>(SMC Appliance only)</strong></td>
</tr>
<tr>
<td></td>
<td>Configures automated backup tasks. Typically used with the <code>smca-cifs</code> command to move backups off the appliance.</td>
</tr>
<tr>
<td></td>
<td><code>add</code> adds a backup task. You can specify an existing source and destination directories. If not specified, the default is <code>/usr/local/forcepoint/smc/backups/</code>.</td>
</tr>
<tr>
<td></td>
<td><code>modify</code> changes an existing backup task by its task ID. All attributes can be changed, except for the task ID. To change an attribute, use the appropriate option with a new value.</td>
</tr>
<tr>
<td></td>
<td><code>remove</code> removes an existing backup task by its task ID.</td>
</tr>
<tr>
<td></td>
<td><code>enable</code> enables an existing backup task by its task ID.</td>
</tr>
<tr>
<td></td>
<td><code>disable</code> disables an existing backup task by its task ID.</td>
</tr>
<tr>
<td></td>
<td><code>list</code> provides a list of all configured backup tasks.</td>
</tr>
<tr>
<td></td>
<td><code>run</code> runs all enabled backup tasks.</td>
</tr>
<tr>
<td></td>
<td><code>--t task_id</code> specifies the task ID. Use the list command to view the task IDs.</td>
</tr>
<tr>
<td></td>
<td><code>--i &lt;source directory&gt;</code> specifies the directory where the backups are stored when they are created. If omitted, the source directory defaults to the SMC backups directory <code>/usr/local/forcepoint/smc/backups/</code>.</td>
</tr>
<tr>
<td></td>
<td><code>--o &lt;destination directory&gt;</code> specifies the remote location to store the backups.</td>
</tr>
<tr>
<td></td>
<td><code>--m &lt;mode&gt;</code> specifies the rsync mode. You can indicate whether rsync appends or mirrors the source directory to the destination directory. Appending the directory means that existing files in the destination directory, that are not in the source directory or are newer than those files in the source directory, are not changed. If omitted, the mode defaults to append.</td>
</tr>
<tr>
<td></td>
<td><code>--h, --help</code> displays information about the command.</td>
</tr>
<tr>
<td><strong>smca-system</strong></td>
<td><strong>(SMC Appliance only)</strong></td>
</tr>
<tr>
<td></td>
<td>Manages recovery snapshots, alternate partition mirroring, and changing system partition boot preference.</td>
</tr>
<tr>
<td></td>
<td><code>toggle</code> restarts the appliance to the alternate partition.</td>
</tr>
<tr>
<td></td>
<td><code>mirror</code> mirrors the active system to the alternate system.</td>
</tr>
<tr>
<td></td>
<td><code>snapshot</code> manages recovery snapshots. Use with the create, restore, or delete options.</td>
</tr>
<tr>
<td></td>
<td><code>--f</code> forces the procedure, does not prompt for any confirmation.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>[-D, --delete]</td>
<td>-n &lt;name&gt; specifies the name of the snapshot, used for mirror or snapshot operations.</td>
</tr>
<tr>
<td>[-h</td>
<td>--help]</td>
</tr>
<tr>
<td></td>
<td>-R, --restore restores the snapshot. Use with the snapshot command.</td>
</tr>
<tr>
<td></td>
<td>-D, --delete deletes the snapshot. Use with the snapshot command.</td>
</tr>
<tr>
<td></td>
<td>-h, --help displays information about the command.</td>
</tr>
</tbody>
</table>

**smca-user**

(SMC Appliance only)

This utility is used by the SMC Appliance to keep user accounts in sync between the SMC and the operating system; not normally used by administrators.

---

**Stonesoft NGFW engine commands**

There are commands that can be run on the command line on Firewall, Layer 2 Firewall, IPS engines, or Master Engines.

**Note:** Using the Management Client is the recommended configuration method, as most of the same tasks can be done through it.

**Note:** All command line tools that are available for single Security Engines are also available for Virtual Security Engines that have the same role. However, there is no direct access to the command line of Virtual Security Engines. Commands to Virtual Security Engines must be sent from the command line of the Master Engine using the `se-virtual-engine` command.

---

**Table 16: Stonesoft NGFW command line tools**

<table>
<thead>
<tr>
<th>Command</th>
<th>Engine role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sg-blacklist show [-v] [-f FILENAME]</td>
<td>Firewall</td>
<td>Used to view, add, or delete active blacklist entries. The blacklist is applied as defined in Access Rules.</td>
</tr>
<tr>
<td>add [-i FILENAME]</td>
<td>Layer 2 Firewall</td>
<td>show displays the current active blacklist entries in format: engine node ID</td>
</tr>
<tr>
<td>[src IP_ADDRESS/MASK]</td>
<td>IPS</td>
<td></td>
</tr>
<tr>
<td>[src6 IPv6_ADDRESS/PREFIX]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[dst IP_ADDRESS/MASK]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[dst6 IPv6_ADDRESS/PREFIX]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[proto {tcp</td>
<td>udp</td>
<td>icmp</td>
</tr>
<tr>
<td>[srcport PORT {-PORT}]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[dstport PORT {-PORT}]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[duration NUM]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Command</td>
<td>Engine role</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>add creates a blacklist entry. Enter the parameters or use the -i option to import parameters from a file.</td>
</tr>
<tr>
<td>del</td>
<td></td>
<td>del deletes the first matching blacklist entry. Enter the parameters or use the -i option to import parameters from a file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>iddel removes one specific blacklist entry on one specific engine. NODE_ID is the engine’s ID, ID is the blacklist entry’s ID (as shown by the show command).</td>
</tr>
<tr>
<td>flush</td>
<td></td>
<td>flush deletes all blacklist entries.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Add/Del Parameters:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Enter at least one parameter. The default value is used for the parameters that you omit. You can also save parameters in a text file; each line in the file is read as one blacklist entry.</td>
</tr>
<tr>
<td>src</td>
<td></td>
<td>src defines the source IP address and netmask to match. Matches any IP address by default.</td>
</tr>
<tr>
<td>src6</td>
<td></td>
<td>src6 defines the source IPv6 and prefix length to match. Matches any IPv6 address by default.</td>
</tr>
<tr>
<td>dst</td>
<td></td>
<td>dst defines the destination IP address and netmask to match. Matches any IP address by default.</td>
</tr>
<tr>
<td>dst6</td>
<td></td>
<td>dst6 defines the destination IPv6 address and prefix length to match. Matches any IPv6 address by default.</td>
</tr>
<tr>
<td>proto</td>
<td></td>
<td>proto defines the protocol to match by name or protocol number. Matches all IP traffic by default.</td>
</tr>
<tr>
<td>srcport</td>
<td></td>
<td>srcport defines the TCP/UDP source port or range to match. Matches any port by default.</td>
</tr>
<tr>
<td>dstport</td>
<td></td>
<td>dstport defines the TCP/UDP destination port or range to match. Matches any port by default.</td>
</tr>
<tr>
<td>duration</td>
<td></td>
<td>duration defines in seconds how long the entry is kept. Default is 0, which cuts current connections, but is not kept.</td>
</tr>
</tbody>
</table>

Examples:
<table>
<thead>
<tr>
<th>Command</th>
<th>Engine role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sg-blacklist add src 192.168.0.2/32 proto tcp dstport 80 duration 60</td>
<td>Firewall Layer 2 Firewall IPS</td>
<td>Used to edit boot command parameters for future bootups. --primary-console defines the terminal settings for the primary console. --secondary-console defines the terminal settings for the secondary console. --flavor defines whether the kernel is uniprocessor or multiprocessor. --initrd defines whether Ramdisk is enabled or disabled. --crashdump defines whether kernel crashdump is enabled or disabled, and how much memory is allocated to the crash dump kernel (Y). The default is 24M. X must always be 16M. --append defines any other boot options to add to the configuration. --help displays usage information. apply applies the specified configuration options.</td>
</tr>
<tr>
<td>sg-bootconfig</td>
<td>Firewall Layer 2 Firewall IPS</td>
<td>This command resets all configuration information from the engine. It does not remove the engine software. After using this command, you must reconfigure the engine using the sg-reconfigure command. Note: Use this command only if you want to clear all configuration information from the engine.</td>
</tr>
<tr>
<td>sg-cluster</td>
<td>Firewall Layer 2 Firewall IPS</td>
<td>Used to display or change the status of the node.</td>
</tr>
<tr>
<td>Command</td>
<td>Engine role</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>[versions]</td>
<td>IPS</td>
<td>–v (Master Engine only) specifies the ID of the Virtual Security Engine on which to execute the command.</td>
</tr>
<tr>
<td>[online]</td>
<td></td>
<td>status displays cluster status. When –c SECONDS is used, the status is shown continuously with the specified number of seconds between updates.</td>
</tr>
<tr>
<td>[offline]</td>
<td></td>
<td>version displays the engine software versions of the nodes in the cluster.</td>
</tr>
<tr>
<td>[lock-online]</td>
<td></td>
<td>online sends the node online.</td>
</tr>
<tr>
<td>[lock-offline]</td>
<td></td>
<td>lock-online sends the node online and keeps it online, even if another process tries to change its state.</td>
</tr>
<tr>
<td>[offline]</td>
<td></td>
<td>offline sends the node offline.</td>
</tr>
<tr>
<td>[lock-offline]</td>
<td></td>
<td>lock-offline sends the node offline and keeps it offline, even if another process tries to change its state.</td>
</tr>
<tr>
<td>[standby]</td>
<td></td>
<td>standby sets an active node to standby.</td>
</tr>
<tr>
<td>[safe-offline]</td>
<td></td>
<td>safe-offline sets the node to offline only if there is another online node.</td>
</tr>
<tr>
<td>[force-offline]</td>
<td></td>
<td>force-offline sets the node online regardless of state or any limitations. Also sets all other nodes offline.</td>
</tr>
</tbody>
</table>

sg-contact-mgmt

<table>
<thead>
<tr>
<th>Command</th>
<th>Engine role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sg-contact-mgmt</td>
<td>Firewall</td>
<td>Used for establishing a trust relationship with the Management Server as part of engine installation or reconfiguration (see sg-reconfigure).</td>
</tr>
<tr>
<td></td>
<td>Layer 2 Firewall</td>
<td>The engine contacts the Management Server using the one-time password created when the engine's initial configuration is saved.</td>
</tr>
<tr>
<td></td>
<td>IPS</td>
<td></td>
</tr>
</tbody>
</table>

sg-dynamic-routing

<table>
<thead>
<tr>
<th>Command</th>
<th>Engine role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sg-dynamic-routing</td>
<td>Firewall</td>
<td>start starts the Quagga routing suite.</td>
</tr>
<tr>
<td>[start]</td>
<td></td>
<td>stop stops the Quagga routing suite and flushes all routes made by zebra.</td>
</tr>
<tr>
<td>[stop]</td>
<td></td>
<td>restart restarts the Quagga routing suite.</td>
</tr>
<tr>
<td>[restart]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[force-reload]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[backup &lt;file&gt;]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[restore &lt;file&gt;]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Command</td>
<td>Engine role</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>[sample-config]</td>
<td></td>
<td>force-reload forces reload of the saved configuration.</td>
</tr>
<tr>
<td>[route-table]</td>
<td></td>
<td>backup backs up the current configuration to a compressed file.</td>
</tr>
<tr>
<td>[info]</td>
<td></td>
<td>restore restores the configuration from the specified file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sample-config creates a basic configuration for Quagga.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>route-table prints the current routing table.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>info displays the help information for the sg-dynamic-routing command, and detailed information about Quagga suite configuration with vtysh.</td>
</tr>
</tbody>
</table>

sg-ipsec -d
[-u <username[@domain]> | -si <session id> | -ck <ike cookie> | -tri <transform id> | -ri <remote ip> | -ci <connection id>]

Firewall
Deletes VPN-related information (use the vpntool command to view the information). Option -d (for delete) is mandatory.
- u deletes the VPN session of the named VPN client user. You can enter the user account in the form <user_name@domain> if there are several user storage locations (LDAP domains).
- si deletes the VPN session of a VPN client user based on session identifier.
- ck deletes the IKE SA (Phase one security association) based on IKE cookie.
- tri deletes the IPSEC SAs (Phase two security associations) for both communication directions based on transform identifier.
- ri deletes all SAs related to a remote IP address in site-to-site VPNs.
- ci deletes all SAs related to a connection identifier in site-to-site VPNs.

sg-logger
-f FACILITY_NUMBER
-t TYPE_NUMBER
[-e EVENT_NUMBER]
[-i "INFO_STRING"]
[-s]

Firewall
Layer 2 Firewall
IPS
Used in scripts to create log messages with the specified properties.
-f defines the facility for the log message.
-t defines the type for the log message.
<table>
<thead>
<tr>
<th>Command</th>
<th>Engine role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[-h]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>sg-raid</td>
<td>Firewall</td>
<td>Configures a new hard drive. This command is only for Stonesoft NGFW appliances that support RAID (Redundant Array of Independent Disks) and have two hard drives.</td>
</tr>
<tr>
<td>[-status]</td>
<td>Layer 2 Firewall</td>
<td>-status displays the status of the hard drive.</td>
</tr>
<tr>
<td>[-add]</td>
<td>IPS</td>
<td>-add adds a new empty hard drive. Use -add -force if you want to add a hard drive that already contains data and you want to overwrite it.</td>
</tr>
<tr>
<td>[-re-add]</td>
<td></td>
<td>-re-add adds a hard drive that is already partitioned. This command prompts for the drive and partition for each degraded array. Use -re-add -force if you want to check all arrays.</td>
</tr>
<tr>
<td>[-force]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[-help]</td>
<td></td>
<td>-help displays usage information.</td>
</tr>
<tr>
<td>sg-reconfigure</td>
<td>Firewall</td>
<td>Used for reconfiguring the node manually. CAUTION: This script also has parameters that are for the internal use of the engine only. Do not use this script with any parameters other than the ones listed here.</td>
</tr>
<tr>
<td>[--maybe-contact]</td>
<td>Layer 2 Firewall</td>
<td>--maybe-contact contacts the Management Server if requested. This option is only available on firewall engines.</td>
</tr>
<tr>
<td>[--no-shutdown]</td>
<td>IPS</td>
<td>--no-shutdown allows you to make limited configuration changes on the node without shutting it down. Some changes might not be applied until the node is rebooted.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Command</td>
<td>Engine role</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>--stop-autocontact</strong></td>
<td></td>
<td>(unconfigured Stonesoft NGFW appliances with valid POS codes only) prevents the engine from contacting the installation server for plug-and-play configuration when it reboots.</td>
</tr>
<tr>
<td><strong>sg-selftest [-d] [-h]</strong></td>
<td>Firewall</td>
<td>Runs cryptography tests on the engine.</td>
</tr>
<tr>
<td><strong>sg-status [-l] [-h]</strong></td>
<td>Firewall</td>
<td>Displays information about the engine's status.</td>
</tr>
<tr>
<td></td>
<td>Layer 2 Firewall</td>
<td>-l displays all available information about engine status.</td>
</tr>
<tr>
<td></td>
<td>IPS</td>
<td>-h displays usage information.</td>
</tr>
<tr>
<td><strong>sg-toggle-active</strong></td>
<td>Firewall</td>
<td>Switches the engine between the active and the inactive partition. This change takes effect when you reboot the engine. You can use this command, for example, if you have upgraded an engine and want to switch back to the earlier engine version. When you upgrade the engine, the active partition is switched. The earlier configuration remains on the inactive partition. To see the currently active (and inactive) partition, see the directory listing of /var/run/stonegate (ls -l /var/run/stonegate). The SHA1 option is used to verify the signature of the inactive partition before changing it to active. If you downgrade the engine, check the checksum and the size of the earlier upgrade package by extracting the signature and size files from the sg_engine_[version.build]_i386.zip file.</td>
</tr>
<tr>
<td></td>
<td>Layer 2 Firewall</td>
<td><strong>--force</strong> switches the active configuration without first verifying the signature of the inactive partition.</td>
</tr>
<tr>
<td></td>
<td>IPS</td>
<td><strong>--force</strong> switches the active configuration without first verifying the signature of the inactive partition.</td>
</tr>
<tr>
<td>Command</td>
<td>Engine role</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><code>sg-upgrade</code></td>
<td>Firewall</td>
<td>Upgrades the node by rebooting from the installation DVD.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Alternatively, the node can be upgraded remotely using the Management Client.</td>
</tr>
<tr>
<td><code>sg-version</code></td>
<td>Firewall Layer 2 Firewall IPS</td>
<td>Displays the software version and build number for the node.</td>
</tr>
<tr>
<td><code>se-virtual-engine</code></td>
<td>Firewall (Master Engine only)</td>
<td>Used to send commands to Virtual Firewalls from the command line of the Master Engine.</td>
</tr>
<tr>
<td>-l</td>
<td>--list</td>
<td>list the active Virtual Security Engines.</td>
</tr>
<tr>
<td>-v &lt;virtual engine ID&gt;</td>
<td></td>
<td>-v specifies the ID of the Virtual Security Engine on which to execute the command.</td>
</tr>
<tr>
<td>-e</td>
<td>--enter</td>
<td>enters the command shell for the Virtual Security Engine specified with the -v option. To exit the command shell, type <code>exit</code>.</td>
</tr>
<tr>
<td>-E &quot;&lt;command [options]&gt;&quot;</td>
<td></td>
<td>-E executes the specified command on the Virtual Security Engine specified with the -v option.</td>
</tr>
<tr>
<td>-h</td>
<td>--help</td>
<td>displays usage information.</td>
</tr>
<tr>
<td><code>sginfo</code></td>
<td>Firewall Layer 2 Firewall IPS</td>
<td>Gathers system information you can send to Forcepoint support.</td>
</tr>
<tr>
<td>[-f] [-d] [-s] [-p] [--] [--help]</td>
<td></td>
<td>Use this command only when instructed to do so by Forcepoint support.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-f forces sgInfo even if the configuration is encrypted.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-d includes core dumps in the sgInfo file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-s includes slapcat output in the sgInfo file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-p includes passwords in the sgInfo file (by default passwords are erased from the output).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-- creates the sgInfo file without displaying the progress.</td>
</tr>
</tbody>
</table>
The following table lists some general Linux operating system commands that can be useful in running your engines. Some commands can be stopped by pressing **Ctrl+C**.

**Table 17: General command line tools on engines**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dmesg</td>
<td>Shows system logs and other information.</td>
</tr>
<tr>
<td></td>
<td>Use the <code>-h</code> option to see usage.</td>
</tr>
<tr>
<td>halt</td>
<td>Shuts down the system.</td>
</tr>
<tr>
<td>ip</td>
<td>Displays IP address information.</td>
</tr>
<tr>
<td></td>
<td>Type the command without options to see usage.</td>
</tr>
<tr>
<td></td>
<td>Example: type <code>ip addr</code> for basic information about all interfaces.</td>
</tr>
<tr>
<td>ping</td>
<td>Tests connectivity with ICMP echo requests.</td>
</tr>
<tr>
<td></td>
<td>Type the command without options to see usage.</td>
</tr>
<tr>
<td>ps</td>
<td>Reports the status of running processes.</td>
</tr>
<tr>
<td>reboot</td>
<td>Reboots the system.</td>
</tr>
<tr>
<td>scp</td>
<td>Secure copy.</td>
</tr>
<tr>
<td></td>
<td>Type the command without options to see usage.</td>
</tr>
<tr>
<td>sftp</td>
<td>Secure FTP.</td>
</tr>
<tr>
<td></td>
<td>Type the command without options to see usage.</td>
</tr>
<tr>
<td>ssh</td>
<td>SSH client (for opening a terminal connection to other hosts).</td>
</tr>
<tr>
<td></td>
<td>Type the command without options to see usage.</td>
</tr>
<tr>
<td>tcpdump</td>
<td>Gives information about network traffic.</td>
</tr>
<tr>
<td></td>
<td>Use the <code>-h</code> option to see usage.</td>
</tr>
<tr>
<td></td>
<td>You can also analyze network traffic by creating tcpdump files from the Management Client with the Traffic Capture feature.</td>
</tr>
<tr>
<td>top</td>
<td>Displays the top CPU processes taking most processor time.</td>
</tr>
<tr>
<td></td>
<td>Use the <code>-h</code> option to see usage.</td>
</tr>
<tr>
<td>traceroute</td>
<td>Traces the route packets take to the specified destination.</td>
</tr>
<tr>
<td></td>
<td>Type the command without options to see usage.</td>
</tr>
<tr>
<td>vpntool</td>
<td>Displays VPN information and allows you to issue some basic commands.</td>
</tr>
</tbody>
</table>
## Server Pool Monitoring Agent commands

You can test and monitor the Server Pool Monitoring Agents on the command line.

**Table 18: Server Pool Monitoring Agent commands**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>agent</strong></td>
<td>(Windows only) Allows you to test different configurations before activating them.</td>
</tr>
<tr>
<td>[-v level]</td>
<td>-v sets the verbosity level. The default level is 5. Levels 6–8 are for debugging where available.</td>
</tr>
<tr>
<td>[-c path]</td>
<td>-c uses the specified path as the first search directory for the configuration.</td>
</tr>
<tr>
<td>[test [files]]</td>
<td>test runs in the test mode - status queries do not receive a response. If you specify the files, they are used for reading the configuration instead of the default files.</td>
</tr>
<tr>
<td>[syntax [files]]</td>
<td>syntax checks the syntax in the configuration file. If no files are specified, the default configuration files are checked.</td>
</tr>
<tr>
<td><strong>sgagentd</strong> [-d]</td>
<td>(Linux only) Allows you to test different configurations before activating them.</td>
</tr>
<tr>
<td>[-v level]</td>
<td>-d means Don’t Fork as a daemon. All log messages are printed to stdout or stderr only.</td>
</tr>
<tr>
<td>[-c path]</td>
<td>-v sets the verbosity level. The default level is 5. Levels 6–8 are for debugging where available.</td>
</tr>
<tr>
<td>[test [files]]</td>
<td>-c uses the specified path as the first search directory for the configuration.</td>
</tr>
<tr>
<td>[syntax [files]]</td>
<td>test runs in the test mode - status queries do not receive a response. If you specify the files, they are used for reading the configuration instead of the default files. The output is directed to syslog or eventlog instead of the console where the command was run unless you use the –d option.</td>
</tr>
<tr>
<td><strong>sgmon</strong></td>
<td>Sends a UDP query to the specified host and waits for a response until received, or until the timeout limit is reached.</td>
</tr>
<tr>
<td>[status/info/proto]</td>
<td></td>
</tr>
<tr>
<td>[-p port]</td>
<td></td>
</tr>
<tr>
<td>[-t timeout]</td>
<td></td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>[-a id]</td>
<td>The request type can be defined as a parameter. If no parameter is given, status is requested. The commands are: status queries the status. info queries the agent version. proto queries the highest supported protocol version. -p connects to the specified port instead of the default port. -t sets the timeout (in seconds) to wait for a response. -a acknowledge the received log messages up to the specified id. Each response message has an id, and you can acknowledge more than one message at a given time by using the id parameter. Messages acknowledged by sgmon will no longer appear in the firewall logs. host is the IP address of the host to connect to. To get the status locally, you can give localhost as the host argument. This parameter is mandatory.</td>
</tr>
<tr>
<td>host</td>
<td></td>
</tr>
</tbody>
</table>
Installing Stonesoft NGFW engines on a virtualization platform

You can install the Stonesoft NGFW engine software as a virtual machine on virtualization platforms such as VMware ESX, OpenStack, KVM, Oracle VM server, and Windriver Titanium.

The same Stonesoft NGFW engine software can be used in the Firewall/VPN role, IPS role, or Layer 2 Firewall role. The engine role is selected during the initial configuration of the engine.

Installation on VMware NSX is supported only with Intel® Security Controller integration. For information about deploying firewalls with Intel Security Controller on a virtualization platform, see the Deploy engines using Intel Security Controller chapter in the Stonesoft Next Generation Firewall Product Guide.

Hardware requirements for installing Stonesoft NGFW engines on a virtualization platform

There are some hardware and software requirements, and configuration limitations when you run Stonesoft NGFW engines on a virtualization platform.

The following requirements apply when you run Stonesoft NGFW engines on a virtualization platform:

- (Recommended for new deployments) Intel® Xeon®-based hardware from the E5-16xx product family or higher
  
  Note: Legacy deployments with Intel® Core™2 are supported.

- One of the following hypervisors:
  
  - VMware ESXi versions 5.5 and 6.0
  - VMware NSX Manager version 6.1.3
  - OpenStack Juno (tested with Ubuntu 14.04 LTS)
  - KVM (KVM is tested as shipped with Red Hat Enterprise Linux Server 7.1)
  - Oracle VM server version 3.3 (tested with Oracle VM server version 3.3.1)
  - Windriver Titanium Server version 14
  - 8 GB virtual disk
  - 4 GB RAM minimum
  - A minimum of one virtual network interface for the Firewall/VPN role, three for IPS or Layer 2 Firewall roles

- The following network interface card drivers are recommended:
  
  - VMware ESXi platform — vmxnet3.
  - KVM platform — virtio_net.
  - Oracle VM platform — xen_netfront.

When a Stonesoft NGFW engine in the Firewall/VPN role is run on a virtualization platform, these limitations apply:

- Only Packet Dispatching CVI mode is supported.
- Only Standby clustering mode is supported.
- Heartbeat requires a dedicated non-VLAN-tagged interface.

When a Stonesoft NGFW engine in the IPS or Layer 2 Firewall role is run on a virtualization platform, clustering is not supported.
Install Stonesoft NGFW engine using an .iso file

Use an .iso file of the Stonesoft NGFW software to install Stonesoft NGFW on VMware ESX, KVM, or Oracle virtualization platforms.

1. Create the virtual machine and configure it according to your requirements.
2. (IPS and Layer 2 Firewall only) Configure the virtual switches to which the IPS or Layer 2 Firewall inline interfaces are connected:
   1. Create a port group and assign All (4095) as the VLAN ID.
   2. Enable the use of Promiscuous Mode.
4. Connect the DVD drive of the virtual machine to the .iso file.
5. Restart the virtual machine.
   The License Agreement appears.
6. Type YES and press Enter to accept the license agreement and continue with the configuration.
7. Select the type of installation:
   • Type 1 for the normal Full Install.
   • Type 2 for the Full Install in expert mode if you want to partition the hard disk manually.
8. Enter the number of processors:
   • For a uniprocessor system, type 1 and press Enter.
   • For a multiprocessor system, type 2 and press Enter.
9. Continue in one of the following ways:
   • If you selected Full Install, type YES and press Enter to accept automatic hard disk partitioning.
   • If you selected Full Install in expert mode, install the engine in expert mode.

The installation process starts.

Install Stonesoft NGFW engine using a VMDK image

Use a VMDK image to install Stonesoft NGFW on OpenStack and Windriver virtualization platforms.

**Note:** For platform-specific instructions, see the product documentation for the virtualization platform.

1. Create the virtual machine and configure it according to your requirements.
2. Download the license and the VMDK image at https://ngfwlicenses.mcafee.com/managelicense.do.
3. Convert the VMDK image for use as a hard disk.
4. Assign the converted hard disk to the virtual machine.
Installing Stonesoft NGFW engines on third-party hardware

You can install the Stonesoft NGFW engine software on third-party hardware that meets the hardware requirements.

Hardware requirements for installing Stonesoft NGFW engines on third-party hardware

There are some basic hardware requirements when you run Stonesoft NGFW engines on third-party hardware.

⚠️ CAUTION: Check that the Automatic Power Management (APM) and Advanced Configuration and Power Interface (ACPI) settings are disabled in BIOS. Otherwise, the engine might not start after installation or can shut down unexpectedly.

⚠️ CAUTION: The engines must be dedicated to the Stonesoft NGFW. No other software can be installed on them.

The following basic hardware requirements apply:

- (Recommended for new deployments) Intel® Xeon®-based hardware from the E5-16xx product family or higher
  
  Note: Legacy deployments with Intel® Core™ 2 are supported.

- IDE hard disk and CD drive
  
  Note: IDE RAID controllers are not supported.

- Memory:
  - 4 GB RAM minimum for x86-64-small installation
  - 8 GB RAM minimum for x86-64 installation

- VGA-compatible monitor and keyboard
- One or more certified network interfaces for the Firewall/VPN role
- Two or more certified network interfaces for IPS with IDS configuration
- Three or more certified network interfaces for Inline IPS or Layer 2 Firewall

Network interface cards

Stonesoft NGFW supports Ethernet, Fast Ethernet, Gigabit, and 10-Gigabit Ethernet interfaces on the Intel platform.

We strongly recommend using network interface cards (NIC) that Forcepoint has certified. For information about certified network interface cards, see KB78844.
Hardware drivers

We recommend using the listed approved drivers supported by Stonesoft NGFW.

Tested network interface card drivers included in the kernel of Stonesoft NGFW are listed in the following table. These drivers have been tested for use in Stonesoft NGFW.

Table 19: Tested network interface card drivers

<table>
<thead>
<tr>
<th>Driver</th>
<th>Version</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>e1000e.ko</td>
<td>2.3.2-k</td>
<td>Intel® PRO/1000 Network Driver</td>
</tr>
<tr>
<td>e1000x.ko</td>
<td>7.3.21-k8-NAPI</td>
<td>Intel® PRO/1000 Network Driver</td>
</tr>
<tr>
<td>i40e.ko</td>
<td>1.2.37+sg2</td>
<td>Intel® Ethernet Connection XL710 Network Driver</td>
</tr>
<tr>
<td>igb.ko</td>
<td>5.1.2+sg7+s1</td>
<td>Intel® Gigabit Ethernet Network Driver</td>
</tr>
<tr>
<td>ixgbe.ko</td>
<td>3.14.5+sg10</td>
<td>Intel® 10 Gigabit PCI Express Network Driver</td>
</tr>
<tr>
<td>virtio_net.ko</td>
<td>No version</td>
<td>Virtio network driver</td>
</tr>
<tr>
<td>vmxnet3.ko</td>
<td>1.2.0.0-k</td>
<td>VMware vmxnet3 virtual NIC driver</td>
</tr>
<tr>
<td>xen-netfront.ko</td>
<td>No version</td>
<td>Xen virtual network device frontend</td>
</tr>
</tbody>
</table>

Other network interface card drivers included in the kernel of Stonesoft NGFW are listed in the following table. All drivers are the driver version that is included in the standard Linux 3.16.7 kernel.

Note: These drivers have not been tested for use in Stonesoft NGFW.

Table 20: Other network interface card drivers

<table>
<thead>
<tr>
<th>Driver</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3c59x.ko</td>
<td>3Com 3c59x/3c9xx Ethernet driver</td>
</tr>
<tr>
<td>8139cp.ko</td>
<td>RealTek RTL-8139C+ series 10/100 PCI Ethernet Driver</td>
</tr>
<tr>
<td>8139too.ko</td>
<td>RealTek RTL-8139 Fast Ethernet Driver</td>
</tr>
<tr>
<td>8390.ko</td>
<td>No description</td>
</tr>
<tr>
<td>acenic.ko</td>
<td>AceNIC/3C985/GA620 Gigabit Ethernet Driver</td>
</tr>
<tr>
<td>amd8111e.ko</td>
<td>AMD8111 based 10/100 Ethernet Controller. Driver Version 3.0.7</td>
</tr>
<tr>
<td>atl1.ko</td>
<td>Atheros L1 Gigabit Ethernet Driver</td>
</tr>
<tr>
<td>atl1e.ko</td>
<td>Atheros 1000M Ethernet Network Driver</td>
</tr>
<tr>
<td>b44.ko</td>
<td>Broadcom 44xx/47xx 10/100 PCI Ethernet Driver</td>
</tr>
<tr>
<td>be2net.ko</td>
<td>Emulex OneConnect NIC Driver 10.2u</td>
</tr>
<tr>
<td>bnx2.ko</td>
<td>Broadcom NetXtreme II BCM5706/5708/5709/5716 Driver</td>
</tr>
<tr>
<td>Driver</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>bnx2x.ko</td>
<td>Broadcom NetXtreme II BCM57710/57711/57711E/57712/57712_MF/57800/57800_MF/57810/57810_MF/57840/57840_MF Driver</td>
</tr>
<tr>
<td>tg3.ko</td>
<td>Broadcom Tigon3 Ethernet Driver</td>
</tr>
<tr>
<td>cxgb.ko</td>
<td>Chelsio 10 Gb Ethernet Driver</td>
</tr>
<tr>
<td>cxgb3.ko</td>
<td>Chelsio T3 Network Driver</td>
</tr>
<tr>
<td>cxgb4.ko</td>
<td>Chelsio T4/T5 Network Driver</td>
</tr>
<tr>
<td>dl2k.ko</td>
<td>D-Link DL2000-based Gigabit Ethernet Adapter</td>
</tr>
<tr>
<td>dmfe.ko</td>
<td>Davicom DM910X fast Ethernet Driver</td>
</tr>
<tr>
<td>e100.ko</td>
<td>Intel® PRO/100 Network Driver</td>
</tr>
<tr>
<td>epic100.ko</td>
<td>SMC 83c170 EPIC series Ethernet Driver</td>
</tr>
<tr>
<td>fealnx.ko</td>
<td>Myson MTD-8xx 100/10M Ethernet PCI Adapter Driver</td>
</tr>
<tr>
<td>forcedeth.ko</td>
<td>Reverse Engineered nForce Ethernet Driver</td>
</tr>
<tr>
<td>hamachi.ko</td>
<td>Packet Engines ‘Hamachi’ GNIC-II Gigabit Ethernet Driver</td>
</tr>
<tr>
<td>hp100.ko</td>
<td>HP CASCADE Architecture Driver for 100VG-AnyLan Network Adapters</td>
</tr>
<tr>
<td>i40e_ik.ko</td>
<td>Intel® Ethernet Connection XL710 Network Driver</td>
</tr>
<tr>
<td>igb_ik.ko</td>
<td>Intel® Gigabit Ethernet Network Driver</td>
</tr>
<tr>
<td>ipg.ko</td>
<td>IC Plus IP1000 Gigabit Ethernet Adapter Linux Driver</td>
</tr>
<tr>
<td>ixgb.ko</td>
<td>Intel® PRO/10Gbe Network Driver</td>
</tr>
<tr>
<td>ixgbe_ik.ko</td>
<td>Intel® 10 gigabit PCI Express Network Driver</td>
</tr>
<tr>
<td>mdio.ko</td>
<td>Generic support for MDIO-compatible transceivers</td>
</tr>
<tr>
<td>mii.ko</td>
<td>MI1 hardware support library</td>
</tr>
<tr>
<td>mlx4_core.ko</td>
<td>Mellanox ConnectX HCA low-level driver</td>
</tr>
<tr>
<td>mlx4_en.ko</td>
<td>Mellanox ConnectX HCA Ethernet Driver</td>
</tr>
<tr>
<td>myri10ge.ko</td>
<td>Myricom 10G driver (10GbE)</td>
</tr>
<tr>
<td>natsemi.ko</td>
<td>National Semiconductor DP8381x series PCI Ethernet Driver</td>
</tr>
<tr>
<td>ne2k-pci.ko</td>
<td>PCI NE2000 clone driver</td>
</tr>
<tr>
<td>netxen_nic.ko</td>
<td>QLogic/NetXen (1/10) GbE Intelligent Ethernet Driver</td>
</tr>
<tr>
<td>niu.ko</td>
<td>NIU Ethernet Driver</td>
</tr>
<tr>
<td>ns83820.ko</td>
<td>National Semiconductor DP83820 10/100/1000 driver</td>
</tr>
<tr>
<td>pcnet32.ko</td>
<td>Driver for PCnet32 and PCnetPCI based ether cards</td>
</tr>
<tr>
<td>qla3xxx.ko</td>
<td>QLogic ISP3XXX Network Driver v2.03.00-k5</td>
</tr>
<tr>
<td>r6040.ko</td>
<td>RDC R6040 NAPI PCI Fast Ethernet Driver</td>
</tr>
<tr>
<td>r8169.ko</td>
<td>RealTek RTL-8169 Gigabit Ethernet Driver</td>
</tr>
</tbody>
</table>
### Driver Description

<table>
<thead>
<tr>
<th>Driver</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>s2io.ko</td>
<td>No description</td>
</tr>
<tr>
<td>sc92031.ko</td>
<td>Silan SC92031 PCI Fast Ethernet Adapter Driver</td>
</tr>
<tr>
<td>sis190.ko</td>
<td>SiS sis190/191 Gigabit Ethernet Driver</td>
</tr>
<tr>
<td>sis900.ko</td>
<td>SiS 900 PCI Fast Ethernet Driver</td>
</tr>
<tr>
<td>skge.ko</td>
<td>SysKonnect Gigabit Ethernet Driver</td>
</tr>
<tr>
<td>sky2.ko</td>
<td>Marvell Yukon 2-Gigabit Ethernet Driver</td>
</tr>
<tr>
<td>starfire.ko</td>
<td>Adaptec Starfire Ethernet Driver</td>
</tr>
<tr>
<td>sundance.ko</td>
<td>Sundance Alta Ethernet driver</td>
</tr>
<tr>
<td>sungem.ko</td>
<td>Sun GEM Gbit Ethernet Driver</td>
</tr>
<tr>
<td>sunhme.ko</td>
<td>Sun HappyMealEthernet(HME) 10/100baseT Ethernet Driver</td>
</tr>
<tr>
<td>tehuti.ko</td>
<td>Tehuti Networks® Network Driver</td>
</tr>
<tr>
<td>tg3.ko</td>
<td>Broadcom Tigon3 ethernet driver</td>
</tr>
<tr>
<td>tulip.ko</td>
<td>Digital 21<em>4</em> Tulip Ethernet Driver</td>
</tr>
<tr>
<td>typhoon.ko</td>
<td>3Com Typhoon Family (3C990, 3CR990, and variants)</td>
</tr>
<tr>
<td>uli526x.ko</td>
<td>ULI M5261/M5263 fast Ethernet Driver</td>
</tr>
<tr>
<td>via-rhine.ko</td>
<td>VIA Rhine PCI Fast Ethernet driver</td>
</tr>
<tr>
<td>via-velocity.ko</td>
<td>VIA Networking Velocity Family Gigabit Ethernet Adapter Driver</td>
</tr>
<tr>
<td>winbond-840.ko</td>
<td>Winbond W89c840 Ethernet driver</td>
</tr>
<tr>
<td>yellowfin.ko</td>
<td>Packet Engines Yellowfin G-NIC Gigabit Ethernet Driver</td>
</tr>
</tbody>
</table>

SCSI drivers included in the kernel of Stonesoft NGFW are listed in the following table. All drivers are the driver version that is included in the standard Linux 3.16.7 kernel.

**Note:** Not all included drivers have been tested for use in Stonesoft NGFW.

### Table 21: SCSI drivers

<table>
<thead>
<tr>
<th>Driver</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3Ware 9xxx SATA_RAID</td>
<td>[CONFIG_SCSI_3W_9XXX]</td>
</tr>
<tr>
<td>Adaptec / IBM ServeRAID</td>
<td>[CONFIG_SCSI_IPS]</td>
</tr>
<tr>
<td>Adaptec AACRAID</td>
<td>[CONFIG_SCSI_AACRAID]</td>
</tr>
<tr>
<td>Adaptec I2O RAID</td>
<td>[CONFIG_SCSI_DPT_I2O]</td>
</tr>
<tr>
<td>Adaptec SAS/SATA 3Gb/s</td>
<td>[CONFIG_SCSI_AIC94X]</td>
</tr>
<tr>
<td>Adaptec Ultra160</td>
<td>[CONFIG_SCSI_AIC7XXX]</td>
</tr>
<tr>
<td>BusLogic MultiMaster and FlashPoint SCSI</td>
<td>[CONFIG_SCSI_BUSLOGIC]</td>
</tr>
<tr>
<td>Domex DMX3191D SCSI</td>
<td>[CONFIG_SCSI_DMX3191D]</td>
</tr>
<tr>
<td>Driver</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>Fusion MPT ScsiHost for FC/SPI/SAS</td>
<td>[CONFIG_FUSION_FC/SPI/SAS]</td>
</tr>
<tr>
<td>Initio INIA100 SCSI</td>
<td>[CONFIG_SCSI_INIA100]</td>
</tr>
<tr>
<td>Intel PIIX/ICH PATA/SATA</td>
<td>[CONFIG_ATA_PIIX]</td>
</tr>
<tr>
<td>LSI Logic MegaRAID (Legacy)</td>
<td>[CONFIG_MEGARAID_LEGACY]</td>
</tr>
<tr>
<td>LSI Logic MegaRAID (NEWGEN)</td>
<td>[CONFIG_MEGARAID_NEWGEN]</td>
</tr>
<tr>
<td>LSI Logic MegaRAID (SAS)</td>
<td>[CONFIG_MEGARAID_SAS]</td>
</tr>
<tr>
<td>NVIDIA nForce SATA</td>
<td>[CONFIG_SATA_NV]</td>
</tr>
<tr>
<td>Pacific Digital ADMA</td>
<td>[CONFIG_PDC_ADMA]</td>
</tr>
<tr>
<td>Promise SATA</td>
<td>[CONFIG_SATA_SX4]</td>
</tr>
<tr>
<td>Promise SATA TX2/TX4</td>
<td>[CONFIG_SATA_PROMISE]</td>
</tr>
<tr>
<td>QLogic IPS2x00</td>
<td>[CONFIG_SCSI_QLA2XXX]</td>
</tr>
<tr>
<td>QLogic ISP1240/1x80/1x160/1020/1040 SCSI</td>
<td>[CONFIG_SCSI_QLOGIC_1280]</td>
</tr>
<tr>
<td>ServerWorks / Apple K2 SATA</td>
<td>[CONFIG_SATA_SVW]</td>
</tr>
<tr>
<td>Silicon Image 3124/3132 SATA</td>
<td>[CONFIG_SATA_SIL24]</td>
</tr>
<tr>
<td>Silicon Image SATA</td>
<td>[CONFIG_SATA_SIL]</td>
</tr>
<tr>
<td>Silicon Integrated Systems SATA</td>
<td>[CONFIG_SATA_SIS]</td>
</tr>
<tr>
<td>Symbios/LSI logic 53C8XX/53C101</td>
<td>[CONFIG_SCSI_SYM53C8XX_2]</td>
</tr>
<tr>
<td>Tekram DC390(T) PCI SCSI</td>
<td>[CONFIG_SCSI_DC390T]</td>
</tr>
<tr>
<td>ULi Electronics SATA</td>
<td>[CONFIG_SATA_ULI]</td>
</tr>
<tr>
<td>VIA SATA</td>
<td>[CONFIG_SATA_VIA]</td>
</tr>
<tr>
<td>Vitesse VSC7174 SATA</td>
<td>[CONFIG_SATA_VITESSE]</td>
</tr>
<tr>
<td>Vortex GDT Disk Array / Intel Storage RAID</td>
<td>[CONFIG_SCSI_GDTH]</td>
</tr>
</tbody>
</table>

Block device drivers included in the kernel of Stonesoft NGFW are listed in the following table. All drivers are the driver version that is included in the standard Linux 3.16.7 kernel.

**Note:** Not all included drivers have been tested for use in Stonesoft NGFW.

### Table 22: Block device drivers

<table>
<thead>
<tr>
<th>Driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>3ware Storage controller</td>
</tr>
<tr>
<td>AMD / NS 5535 IDE</td>
</tr>
<tr>
<td>CMD-Technologies CMD640 IDE</td>
</tr>
<tr>
<td>CMD-Technologies CMD64x IDE</td>
</tr>
<tr>
<td>Compaq Smart Array 5xxx</td>
</tr>
<tr>
<td>Compaq SMART2 Array</td>
</tr>
<tr>
<td>Cyrix / NS 5530 IDE</td>
</tr>
</tbody>
</table>
Start the Stonesoft NGFW engine installation on third-party hardware

After configuring the engine elements in the SMC, begin installing the Stonesoft NGFW engine software on your own hardware.

Before you start installing the Stonesoft NGFW engine, make sure that you have the initial configuration and a one-time password for management contact for each engine. These items are generated in the SMC.

⚠️ **CAUTION:** Installing the Stonesoft NGFW engine software deletes all existing data on the hard disk.

Depending on your order, you might have received ready-made SMC and Stonesoft NGFW engine DVDs. If the DVDs are not included in the order, you must first create them.

1. Insert the engine installation DVD into the drive and restart the system.
   The License Agreement appears.
2. Type **YES** and press **Enter** to accept the license agreement and continue with the configuration.
3. Select the type of installation:
   - Type **1** for the normal **Full Install**.
   - Type **2** for the **Full Install in expert mode** if you want to partition the hard disk manually.
4. Enter the number of processors:
   - For a uniprocessor system, type **1** and press **Enter**.
   - For a multiprocessor system, type **2** and press **Enter**.
5. Continue in one of the following ways:
   - If you selected Full Install, type **YES** and press **Enter** to accept automatic hard disk partitioning.
   - If you selected Full Install in expert mode, install the engine in expert mode.

The installation process starts.
Install Stonesoft NGFW in expert mode

You can install Stonesoft NGFW in expert mode if you want to partition the hard disk manually. If you are unfamiliar with partitioning hard disks in Linux, use the normal installation process.

⚠️ CAUTION: When using the command prompt, use the `reboot` command to reboot and `halt` command to shut down the node. Do not use the `init` command. You can also reboot the node using the Management Client.

Partition the hard disk in expert mode

Typically, you need five partitions for an engine.

⚠️ CAUTION: Partitioning deletes all existing data on the hard disk.

1. If you are asked whether you want to create an empty partition table, type `y` to continue.
2. When prompted, press `Enter` to continue.
3. The partition table is displayed.
4. Create the partitions for the engine as follows:
   - **Partition** | **Flags** | **Partition type** | **File system type** | **Size** | **Description**
   - Engine root A | bootable | Primary | Linux | 1000 MB | The bootable root partition for the engine element.
   - Engine root B | | Primary | Linux | 1000 MB | Alternative root partition for the engine element. Used for the engine upgrade.
   - Swap | | Logical | Linux swap | Twice the size of physical memory. | Swap partition for the engine element.
   - Data | | Logical | Linux | 500 MB or more | Used for the boot configuration files and the root user’s home directory.
   - Spool | | Logical | Linux | All remaining free disk space. | Used for spooling.
5. Check that the partition table information is correct.
6. Select `Write` to commit the changes and confirm by typing `yes`.
7. Select `Quit` and press `Enter`.

Allocate partitions in expert mode

After partitioning the hard disk, assign the partitions for the engine.

1. Check that the partition table is correct. Type `yes` to continue.
2. Using the partition numbers of the partition table, assign the partitions. For example:
   - For the engine root A partition, type 1.
   - For the engine root B partition, type 2.
   - For the swap partition, type 5.
• For the data partition, type 6.
• For the spool partition, type 7.

3. Check the partition allocation and type yes to continue.
The engine installation starts.

4. When installation is complete, remove the DVD from the system and press Enter to reboot.

Related tasks
Configure Stonesoft NGFW engine software using automatic configuration on page 108
Automatic configuration is primarily intended to be used with Stonesoft NGFW appliances, and might not work in all environments when you use your own hardware.

Configure Stonesoft NGFW engine software with the NGFW Configuration Wizard on page 108
You can manually configure the settings for the Stonesoft NGFW engine using the NGFW Configuration Wizard.
Example network (Firewall/VPN)

This example gives you a better understanding of how Stonesoft NGFW in the Firewall/VPN role fits into a network.

The example outlines a network with two firewalls: a Single Firewall at a branch office and a Firewall Cluster at headquarters.

Example Firewall Cluster

This example shows Firewall Cluster interfaces in the example network.

In the example network, the HQ Firewall Cluster is located in the Headquarters network. The cluster consists of two cluster nodes: Node 1 and Node 2.

<table>
<thead>
<tr>
<th>Network</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heartbeat network</td>
<td>The heartbeat and cluster synchronization goes through the heartbeat network.</td>
</tr>
<tr>
<td></td>
<td>CVI: no CVI defined.</td>
</tr>
<tr>
<td>Network</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Management network (DMZ)</td>
<td>The management network interface is used for the control connections from the Management Server and for connecting to the HQ Log Server. CVI: 192.168.10.1. NDI: 192.168.10.21 (Node 1) and 192.168.10.22 (Node 2).</td>
</tr>
<tr>
<td>ISP A external network</td>
<td>This connection is one of the 2 Internet connections from the Headquarters site. It is provided by ISP A. CVI: 212.20.1.254. NDI: 212.20.1.21 (Node 1) and 212.20.1.22 (Node 2). Next hop router: 212.20.1.1.</td>
</tr>
<tr>
<td>ISP B external network</td>
<td>This connection is the other of the 2 Internet connections from the Headquarters site. It is provided by ISP B. CVI: 129.40.1.254. NDI: 129.40.1.21 (Node 1) and 129.40.1.22 (Node 2). Next hop router: 129.40.1.1.</td>
</tr>
<tr>
<td>HQ intranet</td>
<td>This VLAN (VLAN ID 16) is connected to the same network interface on the firewall with the HQ Accounting VLAN. CVI: 172.16.1.1. NDI: 172.16.1.21 (Node 1) and 172.16.1.22 (Node 2).</td>
</tr>
<tr>
<td>HQ Accounting network</td>
<td>This VLAN (VLAN ID 17) is connected to the same network interface on the firewall with the HQ intranet VLAN. CVI: 172.17.1.1. NDI: 172.17.1.21 (Node 1) and 172.17.1.22 (Node 2).</td>
</tr>
</tbody>
</table>

The Management Server and the HQ Log Server are at the headquarters site, in the DMZ network.

<table>
<thead>
<tr>
<th>Stonesoft Management Center (SMC) component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Management Server</td>
<td>This Management Server manages all firewalls and Log Servers of the example network. The Management Server in the Headquarters’ Management Network (DMZ) with the IP address 192.168.1.101.</td>
</tr>
<tr>
<td>HQ Log Server</td>
<td>This Log Server receives log data from the firewalls. The server is located in the Headquarters’ Management Network (DMZ) with the IP address 192.168.1.102.</td>
</tr>
</tbody>
</table>
Example Single Firewall

The Branch Office firewall is a Single Firewall located in the Branch Office network.

![Example Single Firewall](image)

**Figure 14: Example Single Firewall**

Example headquarters management network

This example shows a sample management network.

![Example HQ management network](image)

**Figure 15: Example HQ management network**

1. Internet
2. HQ firewall
<table>
<thead>
<tr>
<th>SMC Server</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Management Server</td>
<td>The Management Server is located in the headquarters' management network with the IP address 192.168.10.200. This Management Server manages all IPS engines, Firewalls, and Log Servers of the example network.</td>
</tr>
<tr>
<td>HQ Log Server</td>
<td>This server is located in the headquarters' management network with the IP address 192.168.10.201. This Log Server receives alerts, log data, and event data from the DMZ IPS and from the HQ IPS Cluster</td>
</tr>
</tbody>
</table>

**SMC Servers**

The example network includes a Management Server and a Log Server.

The following SMC Servers are included in the example network.

**HQ firewall**

The HQ firewall provides NAT for the headquarters management network.

The HQ Firewall uses the following IP addresses with the headquarters management network:

- Internal: 192.168.10.1
- External: 212.20.1.254
Example network (IPS)

To give you a better understanding of how Stonesoft NGFW in the IPS role fits into a network, this example outlines a network with IPS engines.

Example network overview (IPS)

This example network environment is used in all IPS examples.

There are two example IPS installations:
- An IPS Cluster in the Headquarters intranet network.
- A Single IPS in the Headquarters DMZ network.

Figure 16: Example network

1. HQ firewall
2. Branch office firewall
3. HQ DMZ 192.168.1.0/24
4. Internet
5. HQ intranet 172.16.1.0/24
6. HQ Management 192.168.10.0/24
7. Branch Office intranet 172.16.1.0/24
Example headquarters intranet network

This example shows a sample headquarters intranet network.

Figure 17: Example headquarters intranet network.

HQ IPS Cluster

In this example, the HQ IPS Cluster is an inline serial cluster located in the Headquarters network.

The cluster consists of two IPS engine nodes: Node 1 and Node 2.

<table>
<thead>
<tr>
<th>Network interface</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capture Interfaces</td>
<td>The HQ IPS Cluster’s capture interface on each node is connected to a SPAN port in the headquarters intranet switch. All traffic in this network segment is forwarded to the SPAN ports for inspection.</td>
</tr>
<tr>
<td>Inline Interfaces</td>
<td>The cluster is deployed in the path of traffic between the firewall and the headquarters intranet switch. All traffic flows through each node’s Inline Interface pair.</td>
</tr>
<tr>
<td>Normal Interfaces</td>
<td>The normal interface on each node is connected to the headquarters intranet switch. Node 1’s IP address is 172.16.1.41 and Node 2’s address is 172.16.1.42. This normal interface is used for control connections from the Management Server, sending events to the HQ Log Server, and for sending TCP resets.</td>
</tr>
<tr>
<td>Heartbeat Interfaces</td>
<td>The nodes have dedicated Heartbeat Interfaces. Node 1 uses the IP address 10.42.1.41 and Node 2 uses the IP address 10.42.1.42.</td>
</tr>
</tbody>
</table>
Example headquarters DMZ network

This example shows a sample DMZ network.

![Diagram of example headquarters DMZ network]

**Figure 18: Example headquarters DMZ network**

1. DMZ servers  
2. 192.168.1.41  
3. HQ Firewall 192.168.1.1

DMZ IPS

In this example, the DMZ IPS in the headquarters DMZ network is a single inline IPS engine.

<table>
<thead>
<tr>
<th>Network interface</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inline Interfaces</td>
<td>The DMZ IPS is deployed in the path of traffic between the firewall and the DMZ network switch. All traffic flows through the IPS engine’s inline interface pair.</td>
</tr>
<tr>
<td>Normal Interfaces</td>
<td>The normal interface is connected to the DMZ network using the IP address 192.168.1.41. This normal interface is used for control connections from the Management Server, sending event information to the HQ Log Server, and for TCP connection termination.</td>
</tr>
</tbody>
</table>
Cluster installation worksheet instructions

For planning the configuration of network interfaces for the engine nodes, use the worksheet.

- Interface ID — Write the Interface ID (and the VLAN ID, if VLAN tagging is used).
- CVI — Write the Interface ID’s CVI information (if any) and on the NDI line, write the interfaces NDI information (if any). Use multiple lines for an Interface ID if it has multiple CVIs/NDIs defined.
- Mode — Select all modes that apply for this Interface ID.
- IP Address and Netmask — Define the CVI or NDI network address.
- MAC/IGMP IP Address — Define the MAC address used. If the interface’s CVI Mode is Multicast with IGMP, define the multicast IP address used for generating automatically the multicast MAC address.
- Comments — Define, for example, a name of the connected network. Show how the NDI addresses differ between the nodes. Define a management interface’s contact address if different from the interface’s IP address.

Interface modes are explained in the following table. These same character codes are displayed in the firewall element interface properties of the Management Client.

Cluster installation worksheet

The following modes apply in the worksheet.

- **CVI mode** — U=Unicast MAC, M=Multicast MAC, I=Multicast with IGMP, K=Packet Dispatch, A=Interface’s IP address used as the identity for authentication requests
- **NDI modes** — H=Primary heartbeat, h=Backup heartbeat, C=Primary control IP address, c=Backup control IP address, D=Default IP address for outgoing connection

<table>
<thead>
<tr>
<th>Interface ID</th>
<th>Type</th>
<th>Mode</th>
<th>IP Address</th>
<th>Netmask</th>
<th>MAC / IGMP IP Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>NDI</td>
<td>H h C c D</td>
<td></td>
<td>___ . ___ . ___ . ___</td>
<td>___ . ___ . ___ . ___</td>
<td>MAC: ___ : ___ : ___ : ___ : ___ : ___</td>
</tr>
</tbody>
</table>

**Comments**

<table>
<thead>
<tr>
<th>Interface ID</th>
<th>Type</th>
<th>Mode</th>
<th>IP Address</th>
<th>Netmask</th>
<th>MAC / IGMP IP Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>NDI</td>
<td>H h C c D</td>
<td></td>
<td>___ . ___ . ___ . ___</td>
<td>___ . ___ . ___ . ___</td>
<td>MAC: ___ : ___ : ___ : ___ : ___ : ___</td>
</tr>
</tbody>
</table>

**Comments**

<table>
<thead>
<tr>
<th>Interface ID</th>
<th>Type</th>
<th>Mode</th>
<th>IP Address</th>
<th>Netmask</th>
<th>MAC / IGMP IP Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>NDI</td>
<td>H h C c D</td>
<td></td>
<td>___ . ___ . ___ . ___</td>
<td>___ . ___ . ___ . ___</td>
<td>MAC: ___ : ___ : ___ : ___ : ___ : ___</td>
</tr>
<tr>
<td>Interface ID</td>
<td>Type</td>
<td>Mode</td>
<td>IP Address</td>
<td>Netmask</td>
<td>MAC / IGMP IP Address</td>
</tr>
<tr>
<td>-------------</td>
<td>-------</td>
<td>----------</td>
<td>------------</td>
<td>---------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>CVI</td>
<td>U M I K A</td>
<td>___ . ___ . ___</td>
<td>___ . ___ . ___</td>
<td>MAC: ___ : ___ : ___ : ___ : ___ or IGMP IP: ___ . ___ . ___ . ___</td>
<td></td>
</tr>
<tr>
<td>NDI</td>
<td>H h C c D</td>
<td>___ . ___ . ___</td>
<td>___ . ___ . ___</td>
<td>MAC: ___ : ___ : ___ : ___ : ___</td>
<td></td>
</tr>
<tr>
<td>Comments</td>
<td>CVI</td>
<td>U M I K A</td>
<td>___ . ___ . ___</td>
<td>MAC: ___ : ___ : ___ : ___ : ___ or IGMP IP: ___ . ___ . ___ . ___</td>
<td></td>
</tr>
<tr>
<td>NDI</td>
<td>H h C c D</td>
<td>___ . ___ . ___</td>
<td>___ . ___ . ___</td>
<td>MAC: ___ : ___ : ___ : ___ : ___</td>
<td></td>
</tr>
<tr>
<td>Comments</td>
<td>CVI</td>
<td>U M I K A</td>
<td>___ . ___ . ___</td>
<td>MAC: ___ : ___ : ___ : ___ : ___ or IGMP IP: ___ . ___ . ___ . ___</td>
<td></td>
</tr>
<tr>
<td>NDI</td>
<td>H h C c D</td>
<td>___ . ___ . ___</td>
<td>___ . ___ . ___</td>
<td>MAC: ___ : ___ : ___ : ___ : ___</td>
<td></td>
</tr>
<tr>
<td>Comments</td>
<td>CVI</td>
<td>U M I K A</td>
<td>___ . ___ . ___</td>
<td>MAC: ___ : ___ : ___ : ___ : ___ or IGMP IP: ___ . ___ . ___ . ___</td>
<td></td>
</tr>
<tr>
<td>NDI</td>
<td>H h C c D</td>
<td>___ . ___ . ___</td>
<td>___ . ___ . ___</td>
<td>MAC: ___ : ___ : ___ : ___ : ___</td>
<td></td>
</tr>
</tbody>
</table>
Index

A
Antispoofing 117

B
Bypassing traffic 79

C
Capture interfaces
  SPAN ports 15
Certificate
  management server 38
Certificates
  generating 40
  server 40
Cluster interfaces
  configuring IP addresses 65
command line 143
commands
  SMC 143
  SMC Appliance 143
Configuration
  from the command line 34, 35, 36
  log server 35
  management server 34
  web portal server 36
conventions and icons used in this guide 5

D
Default route
  adding
    multi-link 115
documentation
  audience for this guide 5
  product-specific, finding 6
  typographical conventions and icons 5
Dynamic IP address
  defining contact addresses 58
Dynamic IP addresses
  configuring
    setting up PPP 58

E
Engine element
  Layer 2 firewalls 82

F
Firewall cluster
  adding elements 63
  adding physical interfaces 63
  global interface options 67
Firewall clusters
  adding an IPv4 address 65
  adding nodes 63
  add VLAN 64
  binding licenses to elements 68
  creating cluster elements 63
  global interfaces
    ARP entries 68
    heartbeat connection 14
    interface numbers 62
    IP addresses 62
    IPv6 address 66
    modes 62
    synchronization 14
Firewall engine
  installing
    expert mode 176
Firewall engines
  updating
    from a .zip file 134
    upgrading
      from a DVD 134
      locally 133
Firewall licenses
  installing 49, 70, 81, 91
Firewalls
  cabling 16
  installing
    third-party hardware 170
Firewall system
  components 10

G
Global interface options
  firewall cluster 67

H
Hard disk
  allocating partitions 176
  partitioning 176

I
Initial configuration
  saving
    automatic configuration 107
    plug and play 105
    with NGFW Configuration Wizard 108
Initial policy
  installing 119
Installation
  additional servers
    management server 44
  Demo mode 32
  finishing 31
  from the command line 33, 33
  SMC 25, 33, 33
  SMC components 28, 28
Installation files
  downloading 20
  obtaining 129
Installation process 22
interfaces
  system communication 72, 83
Interfaces
  configuring
    dynamic IP addresses 58
  IP addresses
    static IPv4 57
    static IPv6 58
  mapping IDs 111
  VLAN
    defining 72
IP address
  single IPS engine 73
IPS
  binding licenses to elements 79
IPS cluster
  IP address
    defining 74
IPS engines
  defining 70
  engine element
    create 71
  interface options 75
  physical interfaces 72
  single
  IP address 73
  system communication interfaces 72
  traffic inspection interfaces
    capture interface 77
    inline interface 78
    logical interface 76
    reset interface 77
  VLAN interface 72
IPS network
  example 182

L
Layer 2 firewall cluster
  IP addresses 85
layer 2 firewalls
  binding licenses to elements 90
  system communication interfaces 83
Layer 2 firewalls
  defining 81
  engine element
    creating 82
  interface options 86
  IP address 84
  physical interface 83
  traffic inspection interfaces
    capture interface 88
    inline interface 89
    logical interface 87
    reset interface 88
  VLAN interface 83
License files
  obtaining 22
Licenses
  binding 39
  checking 132
  firewall 21
  generating 130
  installing 38, 124, 131
  updating
    one proof code 131
  upgrading
    multiple proof codes 131
Log server
  installing 30

M
Maintaining the SMC 123
Management Client
  distribution
    from a separate server 47
    from SMC servers 46
  setting location 44
  starting 37
  web start distribution 46
Management server
  after contact 112
  contacting 112
  starting 37
Master engine
  add a physical interface 93
  add node 92
Master engine clusters
  heartbeat connection 14
  synchronization 14
Master engines
  add master engine elements 92
  configuring 91

N
NAT addresses
  configuring 42
  defining locations 43
Network drivers
  defining 111
Network interfaces
  configuring 111
Network TAPs 15
NGFW engine
  configuring operating system settings 110
  installing
    starting 175
  virtualization platform 169, 169
NGFW firewall
  configuring
    Configuration wizard 108
  installation
    using USB drive 108
NGFW roles
  licensing 21

P
Policies
  creating 117
  defining basic 117
  ping rule 118
  ready-made 120
Post-installation tasks 41
Pre-installation
  file integrity 20
R

Routing
- add default route
  - single network 115
- antispoofing 117
- defining
  - other routes 116

S

Security engines
- command online 121
Security Management Center
- installing components 28, 28
- uninstalling 126
- upgrading 125
Servers
- starting 39
- starting manually 39
ServicePortal, accessing 6
ServicePortal, finding product documentation 6
Settings
- duplex 19
- speed 19
Single firewall
- binding licenses to elements 61
- configuring
  - adding a single firewall element 50
  - add single firewall element 51
  - modem interfaces 59
- setting global interface options 60
Single firewall element
- ADSL interface 53
- creating 51
- physical interface 52
- selecting interface numbers 50
- SSID interface 55
- VLAN interface 53
- wireless interface 54
Single firewalls
- configuring 49
SMC
- commands 143
- logging on 38
- supported platforms 12
- uninstalling
  - Linux 127
  - Windows 127
- upgrading 123, 125
SMC Appliance
- administrator logon 38
- commands 143
SMC components
- configuring NAT addresses 42
- installing
  - log server 30
  - management server 29
  - web portal server 31
SMC installation 25
SMC Installation
- on Linux 27
SMC server
- contact addresses 44

SMC servers
- start failures 39
- troubleshooting 39
Starting
- management Client 37
- management server 37

T

technical support, finding product information 6
Traffic
- bypassing 79
Traffic inspection interfaces
  - Layer 2 firewall 87

U

Uninstalling SMC 126
Upgrading SMC
- synchronizing databases 126
- upgrading licenses 123

V

Virtual firewall
- binding licenses to elements 96
- physical interfaces 97
Virtual firewalls
- configuring 91
Virtual IPS
- configuring 91
Virtual IPS engines
- physical interfaces 100
Virtual layer 2 firewalls
- configuring 91
Virtual Layer 2 firewalls
- physical interfaces 102